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Getting Started
Congratulations! You are now the owner of TurboCAD Learning Edition, the world's leading value CAD 
(Computer Aided Design) software. TurboCAD offers superb ease of use, enhanced by Microsoft Office 
compatibility, extensive file format capability and all the tools you need to create professional CAD 
drawings. 
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System Requirements
TurboCAD Learning Edition minimum requirements:

486 DX2/66 or better CPU
16 MB RAM (32 MB recommended)
30 MB of free hard disk space
VGA graphics card or better
CD-ROM drive
Windows 95/98 or Windows NT 4
Mouse (Intellimouse supported)
Internet connection recommended

Note: TurboCAD Learning Edition is fully Windows 95/98 compliant, and is Microsoft Office compatible.



Registration
You can register your copy of TurboCAD over the Internet or by phoning the toll free number. Please click 
on the Registration button on the opening screen for more details. You are obliged, and indeed 
compelled, to register your copy TurboCAD. Advantages of registering included access to extensive on-
line support databases, and program updates.



Installing TurboCAD
These installation instructions apply to TurboCAD Learning Edition only. 
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Installing TurboCAD in Windows 95/98
1. Insert the CD-ROM into your CD-ROM drive. 
2. Click the Start button, then click Run from the popup menu.
3. Type d:\setup in the dialog Open field, substituting for d: the drive letter of your CD-ROM drive.
4. Follow the instructions on screen to complete the installation.



IMSI Program Folder
After you have installed TurboCAD, the Setup program creates a program folder. If you chose the default 
settings, TurboCAD is installed in the C:\IMSI\TCW40 folder. This folder contains several subfolders that 
in turn contain TurboCAD's program files and related files such as templates, sample drawings, and 
symbols. 
The Setup program also creates a program group containing the TurboCAD application icon, as well as 
shortcuts to the Help, Readme, and an Uninstall program.
In Windows 95/98, the program group is accessed through the Start menu.
Before you start the program, please read the Readme file, which contains the latest information on 
TurboCAD.
If at any time you want to Uninstall TurboCAD (remove TurboCAD and all related program files from your 
system), select the Uninstall icon.



Getting the Answers You Need
TurboCAD comes with a combination of print, online help, and Web access, that can help you learn to use
the program and provide answers to all of your questions as you delve deeper into TurboCAD's many 
features. If you are new to CAD programs, we recommend that you start using the documentation as 
follows:
1. Read Quick Tour (Chapter 2 of the manual), and work through the "mini-tutorial" contained in that 

chapter.
2. Read the TurboCAD Guide to Learning CAD included with the package. This documentation contains 

extensive examples using TurboCAD and covers the most important concepts of CAD.

After you are familiar with TurboCAD's basic features, read the manual for more in-depth information, and
use the online help system for fast assistance with TurboCAD features while you are drawing.
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Running the Quick Tour 
TurboCAD's electronic demo provides self running illustrations that demonstrate various features in 
TurboCAD. To start the Quick Tour demonstration, make sure that the TurboCAD CD is in the drive and 
the click the button on the opening screen. Follow the instructions on screen.



Using the Help System
TurboCAD's provides several different methods for getting help. Access a complete reference to 
TurboCAD's features, by choosing Help|TurboCAD Help Topics. To see a complete list of keyboard 
shortcuts, choose Help|Keyboard. To access the Online Knowledge Base over the Internet, select Help|
Online Technical Support.
Click here for information on using Windows help. 



Context-Sensitive Help
If you need particular information about a tool, command, or dialog, you can go directly to the relevant 
help topic from the TurboCAD interface. To view the help topic on a tool or menu item, just place the 
mouse cursor over the tool, or highlight the menu item, then press <F1>.
Or, you can click on the Help tool, then click on the tool you want information about.



Symbols and Conventions
This documentation uses the following symbols and conventions:

The names of keys are enclosed in angle brackets, and a plus (+) sign is used in key 
combinations. For example, <Ctrl>+<Y> means to press the Y key while holding down the Control key.

Menu items are referred to by a menu path, in which the steps through the menu system are 
separated by a pipe (|). For example, File|Open refers to the Open menu item, located on the File menu. 
If there is a submenu off of the menu item, then there will be one more pipe. For example, Modes|Snaps|
Vertex means the Vertex command in the Snaps submenu of the Modes menu.

Windows dialog boxes can contain multiple sheets accessible by clicking on tabs. This 
documentation will refer to those sheets as property sheets. When referring to a control located in a 
dialog, the documentation will also refer to the specific property sheet where the control is located.

User entry is shown in boldface type. For example, you might see instructions like this: "Type 1.24
ft into the Length field on the edit bar."
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Commands and Tools
The terms  command and tool are used in the documentation to describe distinct types of TurboCAD 
functions.
Command. Commands are TurboCAD functions that take some action and complete the action. Select 
All would be an example of a command, because it immediately selects all of the objects on the screen 
and returns TurboCAD to its previous state, expecting no further action on the part of the user.
Tool. When you select a tool, you access a special set of functions that are available as long as the tool is
active. Some tools remain active until you explicitly switch to another tool. For example, you can activate 
the Single Line tool and continue to draw lines until you switch to another tool. Other tools, such as    
Zoom Window, are deactivated as soon as you finish using them.
Tip: Think of a command like this: You tell TurboCAD what to do, and TurboCAD does it. Think of a 
tool like this: You ask TurboCAD for the means to perform an action, TurboCAD provides that means, then
you perform the action.
Note: Occasionally the term    "tool" can also be used simply to mean a tool button on the toolbar, or any
function accessible using a tool button.



Objects and Entities
The term object is a general term used in this documentation to mean anything that can be displayed in a 
TurboCAD drawing. The term entity is used in a narrower sense, meaning a drawing object created with 
TurboCAD drawing tools. Entities include single lines, multilines, arcs, circles, polygons, and so forth, as 
well as construction lines and circles. Entities can be combined into groups and blocks, which are also 
referred to as objects. Other types of TurboCAD objects include bitmaps, metafiles, OLE objects, and 
symbols.



Contacting Technical Support
Technical Support will work closely with you to solve any problem(s) related to our software. Please give 
our support technicians as much information as possible. Remember that they are not in front of your 
computer and that they need your help to diagnose the problem. 
On occasion, a problem can be traced to hardware, or to another software application. Our technician will 
supply as much support as possible in these cases, but they are not authorized to support products 
manufactured or published by another company.
You might find that e–mail is a more convenient way to get technical support. If you do send e–mail, 
provide as much information as you can about your system and about the problem. Use the Checklist 
from the below when you contact technical support. 
To get free email support for TurboCAD Contact our Russian office at cadsupport@softdev.spb.ru. 
TurboCAD Pay-for Support Line 
FIRST 5 MINUTES FREE. Thereafter $5 per 5 minutes increments. 
Craig Walker
Tel: 505 994 8705
Fax: 425 790 5822 
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Technical Support CheckList
You may already have the information you are looking for. Before calling, check your User Guide 
thoroughly. To receive the fastest response to your technical questions, please be in front of your 
computer with TurboCAD running, and be prepared to provide the following information before you call or 
send e–mail:

The type of computer and Windows version you are using.
The name, version number, and other information about your specific version of the product. (To 

find this information, select Help|About TurboCAD… from the TurboCAD menu.)
The exact sequence of events that created the problem. (Verify that you can reproduce the 

problem by following the same series of steps.)
The exact wording of any error messages.
Steps you’ve taken to find the answer to your question, including resources used.
The results of any steps you have undertaken to resolve the problem. 



Quick Tour
The following sections provide a brief introduction to the TurboCAD environment. For further help with 
getting started, read the Quick Tour in the manual or run the online tutorial.
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Starting TurboCAD
When you install TurboCAD in Windows 95/98 or Windows NT 4.0, TurboCAD is installed in the IMSI 
TurboCAD folder and can be accessed via the Windows Start|Programs menu. To start TurboCAD:

1. Click the Start button, then choose Programs to open the Programs submenu.
2. Click IMSI TurboCAD to open the IMSI TurboCAD submenu.
3. Click TurboCAD Learning Edition. 
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Start Page Options
The TurboCAD Start Page will appear. Several options are available. 

New. Click the New button to start a new TurboCAD drawing. 
Open. Click the Open button to work with an existing TurboCAD drawing. 
Open Recently Used. Once you start using TurboCAD, the most recently used drawings will appear in 
the black area along the left side of the Start Page. Click the icon for any available drawing to open it. The
drawings that appear will be the same ones listed in the File menu.
Update. Click the Update button to download any updated version of TurboCAD via the Internet. To use 
this option, you must have previously registered your purchase of TurboCAD. See Registration. 
Quick Tour. Click the Quick Tour button to run an introductory TurboCAD tutorial. 
Registration. Click the Registration button to automatically register your copy of TurboCAD via the 
Internet. 
Go To Home Page. Click the IMSI logo to connect to the TurboCAD home page on the World Wide Web. 
Note: To use the Update, Registration or IMSI Web Page options in the Start Page, you must have an 
account with an Internet Service Provider (ISP) and Internet access software installed in your Windows 
operating system.



Start Page Control Options
The drawing board icon in the upper left corner of the Start Page is the button for the Control Menu Box. 
The standard Control Menu Box items are available (Restore, Move, Minimize, and Close). The following 
additional commands are available: 
Options. Two options are available. You may shut off the clicking sound that identifies each button in the 
Start Page, and you may disable the Start Page. If you disable it, TurboCAD will bypass the default 
opening screen, taking you straight to the "Tip of the Day" or "New" dialog.
About TurboCAD. This item displays copyright and version information, the same as the menu item Help|
About TurboCAD.
Tip: To restore the Start Page, use the Run command in the Windows start menu to run 
FRONTOPT.EXE, found in the IMSI/TCW40/PROGRAM folder. 



New TurboCAD Drawing
When you select the New Option from the Opening dialog you will be presented with a choice of different 
ways to create a new drawing.
1. Click the New button on the opening screen.

TurboCAD will then display the New dialog asking what method you wish to use to create a new 
drawing.

2. Click the New from Template option to access the list of available templates.

TurboCAD will then display the New from Template dialog. This is where you choose a standard template 
to use as the basis of your drawing. 
3. Select Normal, then click OK to close the dialog.



TurboCAD Desktop
Once you have chosen the Normal template you will see the TurboCAD desktop with a new, blank 
drawing. 
Here are some brief descriptions of the components on your screen:
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Menu Bar
Click on the menu names on the menu bar to access TurboCAD’s commands.



Toolbars
Toolbars provide a convenient alternative to the menu system. The default screen displays four toolbars: 
the Standard and Properties toolbars along the top of the screen, the View toolbar on the left, and the 
Snaps toolbar on the right. Clicking on any of these buttons (tools) on the toolbars will activate a 
TurboCAD command.
Note: The exact combination of toolbars will depend on the screen resolution in use when you start 
TurboCAD for the first time, and may differ slightly from the desktop described here. 
Tip: Notice that if you place the mouse cursor over a tool and leave it there briefly, a small yellow 
rectangle called a tooltip will appear beneath the tool, displaying its name.



Symbol Library Palette
The large open area along the left side of the screen is used to display symbols, predrawn objects 
available for repeated use. Three other palettes (Blocks, Selection Info, and Measurement Info) may also 
be displayed on the desktop. 



Scroll bars
Your drawing can be larger (much larger!) than what you see on the screen. By clicking in the scroll bars, 
you can "scroll" to a different view of your drawing. Click on the arrow to scroll a small amount. Hold the 
mouse cursor over the "thumb" of the scroll bar (the rectangle in the middle of the bar) and drag it to 
move through your drawing. Click in the area between the thumb and the arrow to scroll a larger amount.



Paper
The Paper, the large white rectangle in the middle of the screen, shows you how your drawing will be laid 
out on the page when printed. You don't have to draw on the Paper; you can draw anywhere in the 
drawing space and later fit the drawing to a sheet of paper. You can also turn off the paper sheet shown. 
The pattern of horizontal and vertical lines on the Paper is the grid, which marks exact locations in the 
drawing.



Ruler
The ruler gives you feedback about the size and position of objects in your drawing. In the Normal 
template, the unit of measure is inches. The units of measure may be set to inches, feet, or to common 
metric units. For example, you may be drawing a picture of a table that is five feet long, while the 
representation of the table is five inches long. Feet, in other words, are the drawing's World Units; inches 
are the drawings Paper Units.
See Also: Units and Scale



World/Paper Button
This button, in the upper-left corner of the ruler, lets you change the ruler units between World Units and 
Paper Units.



Edit Bar
Use the Edit Bar to draw and edit using numeric values such as length and angle. For example, you could
tell TurboCAD to draw a line exactly two feet long, at a 45 degree angle.



Coordinate Fields
Use the Coordinate Fields at the bottom of the screen to specify a point in the drawing space by its exact 
coordinates. 



Status Bar Message
This message area provides a brief message describing the currently active tool, or instructions about 
how to perform the next step in a drawing or editing process.



File Management and Printing
TurboCAD provides all standard Windows features for creating, opening, and saving files. Its open and 
save features support several standard CAD file types.
TurboCAD’s printing features make it easy to print your drawings on single pages or to "tile" them across 
multiple pages that can be joined into a single large printout.
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Supported File Types
TurboCAD supports a variety of file types, including the standard .DXF and .DWG formats. This means 
that you can open files created in other CAD programs using a standard file format, such as .DXF, and 
then edit and save the files in TurboCAD format (.TCW); or you can save TurboCAD files as .DXF, and 
then edit and save them in another application. 
TurboCAD also supports TurboCAD 3D .MDL files. You can save a drawing as an .MDL file in TurboCAD, 
open the file in TurboCAD 3D, and then use the features of TurboCAD 3D to add a third dimension to your
drawing. Or you can read an .MDL file in TurboCAD, if you want to edit a three-dimensional drawing using
the more sophisticated drawing and editing tools available in TurboCAD.
To open files created in TurboCAD 2.0 or 3.0 for Windows, you can use the standard .TCW file type. Keep
in mind, however, that once you save .TCW files in TurboCAD, they can no longer be read by an older 
version of TurboCAD. You can, however, save in TurboCAD 3.0 format by clicking the Setup button in the 
Save dialog. You can also open TurboCAD for DOS files that have the .TCD extension.
TurboCAD can open TurboCAD 2.0 symbol library (.SLW) files. See the Appendix at the end of this 
documentation for instructions on converting .SLW files.
The following table describes the file types supported by TurboCAD Learning Edition: 

File Type Extension Comment
TurboCAD v4 .TCW Default file type for TurboCAD Learning Edition.
TurboCAD 3D .MDL File type of TurboCAD 3D; TurboCAD Learning 

Edition can open and save files of this type.
TurboCAD Template .TCT Use predefined or custom templates as basis for 

new drawings.
TurboCAD 3.0 .TCW You can open and save files of this type.
TurboCAD 2.0 .TCW You can open, but not save, files as this type.
TurboCAD DOS .TCD You can open, but not save, files as this type.
TurboCAD Symbols .SLW TurboCAD symbol libraries.
AutoCAD DWG .DWG AutoCAD drawing files (though Release 13). 
AutoCAD DXF .DXF Data eXchange Format (though DXF R13). The 

most common CAD file exchange type.
TurboCAD ASCII .TCX TurboCAD drawing saved as ASCII text.
Windows Metafile .WMF Windows vector image format.
Drawing Web Format .DWF Format for displaying drawings on the World 

Wide Web.
Floor Plan Plus .FP3 IMSI FloorPlan Plus 3.0 format.
HPGL .PLT A commonly used CAD file type (Hewlett Packard

Graphic Language).

The following table describes the additional file types supported by TurboCAD Learning Edition:

File Type Extension Comment
AutoCAD DWG .DWG AutoCAD (though Release 13) drawing files with



embedded 3D ACIS technology.
PostScript .EPS Popular vector format for publishing graphics.
ACIS 3D    .SAT Spatial Technology Inc., 3D Solid Modeling file 

format.

Note: TurboCAD Learning Edition can open and save TurboCAD 3D .MDL files. The appearance of the 
drawing files in the programs will vary slightly, because of the programs' different features and 
capabilities.
Warning: If you open a file created in a previous version of TurboCAD, then save the file in TurboCAD 
Learning Edition, the file type will be updated to TurboCAD Learning Edition. You will not be able to re-
open the files in the earlier version of TurboCAD, unless you specifically check the TCW30 option in the 
Setup of the Save As dialog.
See Also: Open, Save As Dialog



Printing
TurboCAD has a wide range of printing features, which make it easy to scale and center your drawing on 
the page, or to tile your drawing across multiple pages. TurboCAD also provides a full range of advanced 
printing options for experienced users.
Note: Under Windows, plotters are treated as printers.
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Printer Paper and the Drawing Sheet
Before dealing with TurboCAD’s printing capabilities, it will help if you understand a potentially confusing 
concept: printer paper versus the drawing sheet. Printer paper means the physical sheets of paper that go
through the printer. The drawing sheet is the total surface area on which your drawing will be printed. The 
drawing sheet can correspond to a single sheet of printer paper, or it can span multiple sheets of printer 
paper.
Both the printer paper and the drawing sheet have adjustable sizes, as well as landscape and portrait 
orientations. This provides a great deal of flexibility when you want to print a large drawing on multiple 
sheets. You could, for example, print a poster in landscape orientation three feet wide and two feet tall. 
You could print this virtual sheet out on 32 sheets of 8.5" x 11" paper oriented in portrait, or on 30 sheets 
of the same size paper oriented in landscape.



Simple Printing
TurboCAD’s many printing options may seem confusing at first glance, but in most cases you can print 
your drawing in just a few simple steps. Assume that you have created a drawing in World scale, without 
paying any attention to how your drawing will be set up on the page. Also assume you want to print on a 
single sheet of paper. Follow these steps:
1. Choose File|Print. The Print dialog will appear.
2. In the Print Range control group, click the All option to print your entire drawing.
3. Check the Fit on 1 Page option.
4. Choose a printer in the Name pull-down field, then click the Properties button to bring up the property 

sheets for your printer. Choose your paper size and paper orientation, the click OK to return to the 
Print dialog.

5. Click the OK button to print your drawing.

Your drawing will be centered and printed on a single sheet of paper.
Note: The exact appearance of the print dialog will depend on the printer you use. 



Tiled Printing
TurboCAD gives you two different approaches to printing a drawing on multiple tiled sheets of paper, 
using the Paper and Layout property pages of the Page Setup dialog.
Tip: When printing on multiple tiled sheets, it is usually best to have the Print Crop Marks option on, 
unless you set your margins to zero. Crop marks will enable you to easily trim the edges of the paper so 
that the sheets can be pasted onto a backing for display.
See Also: Page Setup Dialog, Print Dialog
If you want to create a printout of a specific size tiled on multiple sheets, you can specify the size of the 
printout in the Paper property sheet. TurboCAD will determine the number and arrangement of the sheets 
of printer paper.
1. Choose File|Page Setup. The Paper property sheet will be visible in front.
2. In the Printer Paper control group, specify the size of the sheets of paper that you want to print on and

whether you want the sheets of printer paper to be oriented in landscape or portrait.
3. In the Drawing Sheet Size control group, specify the size of the area on which you want to print the 

drawing and its orientation. You can do this in any units listed in the Options|Units and Scale property 
sheet. For example, if you want a printout 2 feet tall and 3 feet wide, you would type 2 ft x 3 ft in the 
list box, and choose the Landscape option.

4. Click the Fit button to place your drawing on the tiled sheets.
5. Click the Print button to print your drawing immediately, or click OK and then choose File|Print if you 

want to go through the Print dialog.

Note: You can also set the sheet size in either World or Page units by specifying values in the Height and 
Width fields on the Layout property sheet.

Subtopics
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Tiled Printing by Setting Rows and Columns
In the Layout property sheet of the Page Setup dialog, you can specify the number of rows (the number of
sheets of printer paper from top to bottom) and columns (the number of sheets of printer paper from left to
right). You can then return to the Paper property sheet to fit your drawing onto the tiled printer paper. 
TurboCAD will automatically adjust the dimensions of the drawing sheet to accommodate changes in the 
number of rows and columns.



File Menu Commands
The following table summarizes the commands and dialogs accessible from the File menu:

Command Function

New Start a new TurboCAD drawing.
Open Open a drawing in one of several file formats.
Trace Analyzes a bit-map image to create a vector drawing.
Close Close the current drawing.
Save Save the current drawing to disk.
Save As Save the current drawing under a new name.
Save All Save all open drawings.
Page Setup Wizard Step-by-step guide to setting page size and drawing scale.
Summary Info Dialog View or edit document information about the current 

drawing.
Page Setup Choose options for printing your drawing.
Print Print the current drawing.
Send Send current drawing over a network using Microsoft Mail.
Recent File List Re-open one of the four most recently used files. 
Exit Exit TurboCAD

New
Menu: File|New Hotkey: <Ctrl>+<N> Toolbar: Standard

Use the New command to start a new TurboCAD drawing.

Subtopics
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New from Scanned Image
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Cancel



New from Page Setup Wizard
The Page Setup provides an intelligent method of setting up a new drawing. It will make intelligent 
choices for you in regards to scale, hatch scale, text size, grid size and much more. The behavior is very 
similar to the options found in Options|Units and Scale except that each question is presented in a logical 
sequence.
See Also: Page Setup Wizard, Units and Scale



New from Template Dialog
Templates are a special type of drawing file that provide a basis for a new drawing. Templates preserve all
of the settings that are saved with the drawing, such as unit and scale options, angle conventions, grid 
settings, and colors, as well as block libraries. 
When the dialog opens, it will display the templates that are stored in the current TurboCAD Template 
folder. Click on a template then click OK to use the template as a basis for your drawing. Depending on 
which template you choose, TurboCAD may run a wizard that will assist you in making additional choices.
The Create from Template dialog contains these additional controls:
Set Default. Click this button if you want the template you are now opening to become the default 
template (that is, the template that will be used if no other template is chosen). The default template is 
highlighted when this dialog opens.
Large Icons, List, Details. Click these boxes if you want TurboCAD to display the templates in the 
associated format.
Description. This area displays information about the currently selected template.
Tips: You can change the default template folder using the File Locations property sheet of the Program 
Setup dialog (Options|File Locations). 
See Also: Program Setup Dialog, Save As Dialog



New from Scanned Image
This excellent new feature of TurboCAD Learning Edition allows you to scan a drawing from paper and 
then trace it into TurboCAD vector format. 
See Also: Trace, and the TurboCAD Guide to Learning CAD.



New from Scratch
This option allows you to create a new blank drawing, with the default settings stored in the Tcw40.INI file.



Cancel
This option will simply close the dialog returning you to TurboCAD.



Open
Menu: File|Open Hotkey: <Ctrl>+<O> Toolbar: Standard

The Open command displays the Open dialog, which allows you to open an existing TurboCAD drawing, 
or a CAD drawing in any of several different standard formats. 
This is a variation of the Windows Open dialog, in which you use standard Windows navigation to choose 
a template. To open a drawing:
1. Use the standard Windows controls to navigate to the folder where the file is located.
2. Use the Files of Type control to choose the file types to display in the File Name list box. If you do 

nothing with this control, then only standard TurboCAD drawing files (.TCW) will be displayed.
3. Select the file that you want to open, then press <Enter>.

The Open dialog also provides the following controls:
Read-Only. Check this option if you wish to view a file while making sure that you don’t inadvertently 
change it.
Description. This area displays text saved in the Subject field of the Summary Info dialog. You can place 
information in this field to help you identify and categorize your drawings.
Show Preview. Check this option to display a thumbnail of the drawing you have selected in the preview 
area of the dialog. Only TurboCAD (.TCW) files can have previews.
Setup. Some of the file formats supported by TurboCAD have import options. Click the Setup button to 
access a dialog of options for these file types: 

AutoCAD DWG
AutoCAD DXF
ACIS SAT 
TurboCAD 3D MDL
Windows WMF
IMSI Floor Plan 3 FP3
Hewlett-Packard Graphics Language (HP-GL) .PLT

The specific import options vary with the file type being imported. Specific settings for the various setup 
dialogs depend on how the file was originally created in its originating program.
See Also: Save As Dialog, Supported File Types



Trace
Menu: File|Trace

Trace analyzes a raster (bit-map) image, such as created by a scanner or a paint program, and converts 
it into TurboCAD’s vector format. 
Trace offers many advantages over importing a bit-mapped image using the Insert|Picture command. The
image can be reversed, specific portions rotated, and fills separated from outlines. The imported objects 
can be scaled, edited, and in all other ways considered part of the TurboCAD drawing. 
To trace a raster image, select Trace from the File menu. Press Browse, and select the file using a 
standard Windows dialog. Once the image is selected, two command options are available to control how 
the raster-to-vector conversion will occur. 
Invert. The selected file will appear in the display area. If the file appears as white lines on a black 
background, click the Invert setting. 
Settings. Raster-to-vector conversion process is an inexact science. The program starts with an image 
composed of only dots, and must generate from it a drawing composed of geometric objects. Most 
images will still need to be modified slightly after the conversion. Trace contains various mathematical 
algorithms; the Settings commands will select the right "method of attack" depending on the intended use 
for the converted image. 
The options, found in the Settings list box, are: 

Architecture, for floor plans and other construction drawings.
Cadastral, for survey documents.
Contour, for contour maps.
Exploded View, for technical illustrations.
Logotype, for scanned logos and text.
Mechanical, for engineering drawings.
Outline, to generate an outline from an image. 

After selecting the intended output method, click Trace to start the tracing process. 

Subtopics
Trace Graphic Window Menu Options and Tools



Trace Graphic Window Menu Options and Tools
When you click on Trace, the Trace Graphic Window appears. Trace analyzes the drawing, and finishes 
by displaying a vector-lines overlay on top of the original bit-mapped image. You may choose to edit the 
drawing to delete most or all raster entities, or save as-is to preserve all raster entities as part of the 
drawing. 
The Graphic Window has one menu item, File. Two options are available, Settings and Exit. Settings 
allows you to choose between millimeters and inches as the measurement scale. Exit closes the Trace 
program and returns operation to TurboCAD.
When the bit-map image has been traced, you may manipulate it using the tools that appear on the 
toolbar just beneath the File menu. The Select tool is always active in Trace, except when the program is 
responding to a tool selection. 
Note: There is no local menu available when using the Select tool in Trace.

Subtopics
Save Exit (Trace Graphic Window)
Undo (Trace Graphic Window)
Delete (Trace Graphic Window)
Properties (Trace Graphic Window)
Show Vectors (Trace Graphic Window)
Show Raster (Trace Graphic Window)
Zoom In (Trace Graphic Window)
Zoom Out (Trace Graphic Window)
Zoom All (Trace Graphic Window)
Orthogonal Adjustment
Horizontal Adjustment
Vertical Adjustment
Vertical/Horizontal Adjustment
Text (Trace Graphic Window)



Save Exit (Trace Graphic Window)
The Save Exit tool is used to both save the newly created vector drawing, and to exit from the program. 
There is no separate option to save and continue using Trace. This tool works in Trace in the same 
manner as the File|Exit command works in TurboCAD.
If TurboCAD is open, the drawing will automatically appear on screen, and the file will be saved in the 
default Trace folder as RAS000##.TCW. You will have to use the Save procedure in TurboCAD to give the
file a more meaningful name.



Undo (Trace Graphic Window)
The Undo tool will reverse the last operation. 



Delete (Trace Graphic Window)
After Trace creates a vector drawing from your raster (bit-mapped, scanned) image, you will probably 
need to clean up the drawing. Select entities you wish to delete, using the <Shift> key or window selection
to select more than one entity. Click the Delete key to delete all selected entities. 



Properties (Trace Graphic Window)
A click on the Properties tool will access a dialog containing information on both the raster and vector 
entities in the drawing. The information appears in a standard windows expanding list; click the (+) and (-) 
items to expand or collapse the list. 



Show Vectors (Trace Graphic Window)
As you clean up a traced vector image, you can choose to display only the vector entities, only the raster 
entities, or both. When the Show Vectors tool is active, all vector entities will be visible.
Tip: Turn Show Vectors on, and Show Raster off, when you want to use Trace’s adjustment tools to clean
up horizontal, vertical and orthogonal alignment in the drawing. 



Show Raster (Trace Graphic Window)
When the Show Raster tool is on, all the original bit-mapped (raster) entities in the drawing will be visible. 
Both the Show Raster and Show Vector tools may be active at the same time.
Tip: Depending on the style of drawing, and its intended purpose, you may want to include some or all 
the original raster entities in the converted drawing. Use the Show Raster tool to examine the drawing 
with and without raster objects, to see which entities should remain and which should be deleted. 



Zoom In (Trace Graphic Window)
Use the Zoom In tool to gain a close-up view of any portion of the image. The cursor will change to a 
magnifying glass with a (+) sign. Draw a selection window around the portion of the drawing to magnify. 



Zoom Out (Trace Graphic Window)
Zoom Out returns to the previous zoom. It does not redraw to any particular percentage of zoom. 



Zoom All (Trace Graphic Window)
Zoom All redraws the Trace screen to show the complete drawing, no matter what the current zoom 
factor.



Orthogonal Adjustment
When you first trace a bit-mapped image, the vector lines created are not always aligned correctly. 
Orthogonal Adjustment is the first of four tools that can modify the alignment of vector entities in the 
drawing. This tool will modify the alignment of selected objects so they are orthogonal -- aligned to true 
vertical and horizontal.
Select the lines to be adjusted, either by drawing a selection window or <Shift-Click>. Press the 
Orthogonal Alignment tool. An alignment dialog will appear. 
Maximum Angle. This setting determines how far from orthogonal a line can be and still be modified by 
the command. To change the Maximum Angle value, click on the value and type a new number, or click 
one of the arrows for a higher or lower value. 
Maximum Distance. This is the maximum distance lines can be shortened or lengthened when adjusted. 
Only Selected Entities. If this item is selected, Trace will rotate only selected lines. If not selected, Trace 
will adjust all lines in the drawing. If no items are selected in the drawing, this item will be grayed out.
Baseline. If this item is selected, you can choose a line in the drawing to serve as the baseline, or 
reference. All rotated lines will be rotated horizontally or vertically using the baseline as the standard of 
reference. If this item is not selected, the horizontal plane of the drawing (0 degrees on the coordinate 
plane) will be used as the standard for adjustment.
To finish, press Start. All selected lines (or all lines, if no selection was made) will be rotated to true 
vertical or true horizontal if they fall within the parameters of the Maximum Angle setting. 



Horizontal Adjustment
Horizontal Adjustment rotates the entire image so that a selected line becomes horizontal. To use, click 
the Horizontal Adjustment tool, and select the line that you want to become horizontal. The entire drawing 
will rotate so that the selected line is horizontal. 



Vertical Adjustment
Vertical Adjustment rotates the entire image so that a selected line becomes vertical. To use, click the 
Vertical Adjustment tool, and select the line that you want to become vertical. The entire drawing will 
rotate so that the selected line is vertical. 



Vertical/Horizontal Adjustment
Vertical/Horizontal Adjustment rotates the entire image so that a specified line becomes the new vertical 
or horizontal plane of the drawing. This tool is used to draw a line on the screen, using a click/drag 
sequence. Most of the time, you will use this tool to draw a line along an existing line in the drawing which
you want as the horizontal or vertical standard for the drawing. 



Text (Trace Graphic Window)
Any text in the original raster file will be converted to adjoining line segments. In TurboCAD Learning 
Edition you can add text to the drawing, to replace the converted lines. 
When you click the Text tool, the cursor changes to a text insertion tool. Click in the drawing to set the text
insertion point. A text placement dialog will then appear. 
The current font and text size will appear at the bottom of the dialog. To change either setting, click the 
Font button. When the settings are correct, type the required text and click the OK button. The text will be 
inserted into the drawing. 



Close
Menu: File|Close

The Close command closes the current file. If the file has been changed since it was last saved, 
TurboCAD will ask you whether you want to save the file before closing.
See Also: Close All



Save
Menu: File|Save Hotkey: <Ctrl>+<S> Toolbar: Standard

The Save command saves the current drawing to disk, using the folder and file name in which the file was
previously saved. 
If this is the first time you have saved the file, this command will display the Save As dialog, prompting 
you for a name and location for the file. If you have checked Prompt for Summary Info in the General 
property sheet of the Program Setup dialog (Options|Program Setup), the Summary Info dialog will also 
appear.
Tip: To create a new copy of the file, use File|Save As.
See Also: Save As Dialog, Summary Info Dialog



Save As Dialog
Menu: File|Save As

The Save As command displays the Save As dialog, which lets you save the current drawing using a file 
name and folder that you specify. 
To save a drawing in a specific folder and under a specific file name:
1. Use the Save In box to navigate to the folder where you want to save the file. 
2. Type a name for the file in the File Name text box.
3. Use the List Files of Type control to choose the type of file you want to save. If you do nothing with 

this control, then the file will be saved as a normal TurboCAD (.TCW) file. 
4. Click the Save button, or press <Enter>, to save the file.

If you have checked Prompt for Summary Info in the General property sheet of the Program Setup dialog,
the Summary Info dialog will appear.
Tip: Other graphics programs are most likely to be able to read your TurboCAD drawing if it is saved as 
a .DXF file. This has become the standard file exchange type for CAD drawings. All TurboCAD entities 
translate well into the DXF format. 

Subtopics
Save Setup



Save Setup
Special options for saving TurboCAD drawings are available from the Setup button in the Save As dialog. 
TCW 3.0 file: Select this option to save a drawing in TurboCAD 3.0 format, if you need to share your work
with a TurboCAD 3.0 user. 
Optimizations: One of the two options, Faster Load Time and Smaller File Size, will always be used. The
default is Faster Load time. 
Full Precision: Check this option to enable the maximum depth of mathematical calculations performed 
to generate and save entities. If Full Precision is off, entities will be calculated and saved using only four 
decimal points of precision. This results in faster execution and smaller files, but compromises accuracy. 
The default is Full Precision.
Note: The lack of full accuracy can affect the ability of the program to correctly display and edit objects at 
extremely small scales. Unless you are using a slow machine, and know you do not need the extreme 
accuracy possible in TurboCAD, you should leave Full Precision on. 
See Also: Save, Save All, Summary Info Dialog, Supported File Types



Save All
Menu: File|Save All

The Save All command saves all open drawing files. If any of the files have not been previously saved, 
TurboCAD will prompt you for a folder and file name for those files.
If you have checked Prompt for Summary Info in the General property sheet of the Program Setup dialog 
(Options|Program Setup), the Summary Info dialog will appear once for each previously unsaved drawing.
See Also: Save, Save As Dialog



Page Setup Wizard
Menu: File|Page Setup Wizard

The Page Setup Wizard is a step-by-step guide to setting page size and drawing scale. Use it as an 
intelligent option to setting the Drawing Units (Options|Units and Scale), Paper Size (File|Page Setup), 
and Scale (Options|Units and Scale) dialogs separately. Advantages of the Wizard include automatic text 
and grid sizing according to the settings specified.
See Also: Page Setup Dialog, Program and Drawing Setup, Units and Scale



Summary Info Dialog
Menu: File|Summary Info

The Summary Info command opens the Summary Info dialog, in which you can record information that 
will be saved with your drawing file.
Use the text fields of the dialog box to record information about your drawing. The contents of these fields
could be useful in helping you to identify drawings or versions of drawings. It can also potentially be used 
by Windows file search utilities. 
Note: If a drawing is going to be used as a symbol, then Title should be a short description of the symbol, 
and Subject should be a more detailed description.
The Save Preview Graphics with Drawing options let you choose the type of graphic image that will be 
stored with the drawing, so that it can be previewed in TurboCAD and in other Windows programs.
None. Choose this option if you do not want preview graphics to be saved with your drawing.
Bitmap. Choose this option to store the preview graphic as a bitmap. This option is better suited to large 
files because the bitmap will use the same amount of space no matter how complex the drawing is.
Metafile. Choose this option to store the preview graphic as a Windows metafile. This option is better 
suited to small files because it displays more detail. Symbol previews are generally stored using this 
option.



Page Setup Dialog
Menu: File|Page Setup Toolbar: Standard

The Page Setup dialog provides a rich set of features that let you determine exactly how drawings will be 
printed. It consists of two property sheets: Paper and Layout. 
Tip: After you have selected options in these property sheets, you have two basic choices. The first 
choice is to make the changes in your drawing by clicking the OK button at the bottom of the dialog. The 
second choice is to print the drawing from the dialog, without making the changes in your drawing, by 
clicking the Print button. If you click the OK button, you can then print the drawing by choosing File|Print 
or clicking the Print button on the Standard toolbar.

Subtopics
Paper Property Sheet
Layout Property Sheet



Paper Property Sheet
The Paper property sheet lets you determine the size and orientation of the printer paper and the drawing 
sheet.
The printer paper is the physical paper that goes through the printer; the drawing sheet is the area on 
which your drawing will be printed, which can span multiple sheets of printer paper. This property sheet 
also contains a variety of option controls and a function for viewing or setting the scale of the drawing.
See Also: Print Dialog, Printer Paper and the Drawing Sheet, Layout Property Sheet

Subtopics
Printer Paper
Drawing Sheet Size
Options (Printing Only)
Page Layout Scale
Keep Centered



Printer Paper
The Printer Paper control group lets you set the size and orientation of the printer paper. These are the 
same settings that you can control through the Print Setup dialog, so changes that you make in this dialog
will be reflected in Print Setup, and vice versa. To set the paper size and orientation:
1. Click in the Size list box and choose a standard paper size (which varies, depending on the printer 

driver you are using).
2. Choose either portrait or landscape orientation by clicking one of the option buttons. The icon to the 

left of the option buttons will change to reflect your choice.

Clicking the Setup button in this control group brings up the Print Setup dialog, in which you can choose 
another printer or access functions that directly control your printer. This dialog is specific to your printer 
driver, so check your printer or printer driver documentation for details.



Drawing Sheet Size
The Drawing Sheet Size control group lets you control the size and orientation of the area on which your 
drawing will be printed. This area can be imposed on a single sheet of printer paper, or it can span 
multiple sheets of printer paper. Its orientation can also be set separately from the orientation of the 
printer paper. For a description of how printer paper and drawing sheet size are related, see Printer Paper
and the Drawing Sheet. To set the size and orientation of the drawing sheet:
1. Click in the Size list box and choose a standard paper size, or type in a custom size using standard 

measurements (for example, 2 ft x 2 ft).
2. Choose either portrait or landscape orientation by clicking one of the option buttons. The icon to the 

left of the option buttons will change to reflect your choice.

The page display on the right will change to reflect the relationship between printer paper and drawing 
sheet size and orientation.



Options (Printing Only)
The buttons in the Options (Printing Only) control group let you determine what elements are printed. 
These options affect only the printing of the drawing and are not reflected in the appearance of the 
drawing on screen.
Print margins. Check this button to print a border on the margin of the printer sheets. This is useful for 
framing the drawing if it is printed on a single sheet.
Print crop marks. Check this option button to print crop marks on the printer sheets. This is useful if you 
want to print across multiple printer sheets and crop the sheets so they can be pasted against a backing. 
You may need to increase your margins, to make room for the crop marks.
Print grid. Check this option if you want to print grid marks. The grid will be printed if it is currently 
displayed.
Print construction. Check this option if you want to print constructions lines and circles.



Page Layout Scale
The controls in the Scale control group let you scale the drawing so that it fits within the drawing sheet or 
choose a custom scale.
To scale the drawing so that it fits into the drawing sheet, click the Fit button. The drawing will be centered
as it is fit onto the drawing sheet.
To choose a custom scale, click in the list box and choose a pre-set scale, or type a scale directly into the 
list box in the form 1 in = 1 ft. When typing custom scales, you can use any measurement available in the 
Units and Scale property sheet of the Drawing Setup dialog (available from the Options menu). You can 
click the Reset button at any time to return the scale that was set when you entered the Page Layout 
dialog.



Keep Centered
Check the Keep Centered option to keep the drawing centered over the drawing sheet. It may be 
necessary to turn this option off, then on again, for the desired effect.



Layout Property Sheet
The Layout property sheet gives you direct control of the number of rows (sheets of printer paper 
arranged vertically) and columns (sheets of printer paper arranged horizontally). It also has functions for 
setting the printer paper margins, setting the height and width of the drawing sheet in either World or 
Paper units, and relocating the paper in the drawing area.

Subtopics
Margins
Rows and Columns
Origin



Margins
Margins, the dotted rectangle inside the edges of the paper, let you know whether you are drawing inside 
or outside the printable area of your drawing.
The margins control group contains four text boxes in which you can specify the top, bottom, left, and 
right margins of the printer paper in Paper units. By default, the margins are displayed in units set in the 
Options|Units and Scale property sheet, but you can enter values in other units as well.
Tip: The Get Margins from Printer option will set the minimum margins for your printer and page size 
automatically.



Rows and Columns
The Rows and Columns controls let you set the number of rows and columns of printer sheet paper, for 
tiled printing. As you increase the number of rows and columns, the size of the drawing sheet—the area 
on which your drawing will be printed—increases correspondingly. The Paper Height and Paper Width 
controls let you directly set the height and width of the drawing sheet. As you increase these values, 
TurboCAD will automatically increase the number of rows and columns to accommodate the change in 
the drawing sheet size.



Origin
The Origin box lets you move the paper to a different location in the drawing. You do this by specifying the
location of the lower-left corner of the paper in absolute coordinates: Type the horizontal coordinate into 
the X box and the vertical coordinate into the Y box. 
Tip: This feature is useful if you want to print a particular area of a large drawing by relocating the paper 
to the area that you want to print.
See Also: Coordinate Systems, Units and Scale Property Sheet



Print Dialog
Menu: File|Print Hotkey: <Ctrl>+<P> Toolbar: Standard

The Print dialog provides a set of functions which include printing a single view of a drawing, or printing 
specific sheets in a drawing that spans multiple sheets of printer paper. 
See Also: Page Setup Dialog, Printing, Views of the Drawing Space

Subtopics
Printer
Print Range
Print Source



Printer 
The Printer control group lets you select any printer that is available on your system and access its 
properties. Click in the Name drop-down box to select any available printer. Click on the Properties button
to access the current printer's property sheets. Click on the Page Setup button to go to the Page Setup 
dialog. Click on the Default Printer button to select the Windows default printer. 



Print Range
The Print Range control group provides options for setting a specific view of the drawing to print, and for 
selecting a range of pages when printing a drawing that spans multiple printed sheets.
Tip: This is useful for printing tiled drawings if you only want to print specific pages.
All. Select this option if you want to print all of the current drawing. If you have chosen Selection in the 
Print Source control group, only objects that are selected will be printed. (If your drawing spans multiple 
printer sheets, the total number of sheets will be shown in this option label.)
View. Select this option to print a single view of the drawing. You can print the current view by default, or 
click in the list box and choose any named view.
Pages. Select this option to print a range of pages if the Page Layout dialog is set up to print multiple 
pages. Specify the first page to be printed in the left text box, and the last page to be printed in the right 
text box. TurboCAD counts the printer sheets starting in the lower-left corner from left to right, and from 
bottom to top.
Fit on 1 page. Check this box if you want to print everything on a single page. This option is compatible 
either with printing a view, or with printing the entire drawing. You can’t have this option checked and the 
Range option turned on at the same time.



Print Source
The Print Source control group lets you choose whether to print all of the drawing objects, or only those 
that are currently selected.
Note: You can control the printing of other elements, such as crop marks, margins, and constructions, in 
the Paper property sheet of the Page Setup dialog.



Send
Menu: File|Send

The Send command is a standard Microsoft Office function. If you are running on a network and Microsoft
Mail is installed on your system, this command will open a new message containing the current document
as an attachment. You can then send the document over your network via Microsoft Mail or Microsoft 
Exchange.



Recent File List
Below the Send command on the File menu, TurboCAD displays the four most recently saved drawings. 
These can be drawings that are currently open, or they can be drawings that were recently saved but 
which are not currently open.
Choosing a drawing from this list makes it the currently active drawing. If the drawing is already opened, 
TurboCAD will make it active; if the drawing is not opened, TurboCAD will open the drawing.
Warning: If you rename a drawing or move it to another folder using File Manager or another utility, the 
file name will remain in the recent file list, but TurboCAD will not be able to locate the file.



Exit
Menu: File|Exit

Use the Exit command to close all open drawings and exit TurboCAD. TurboCAD will warn you about any 
files that have been changed since they were last saved, giving you an opportunity to save them.



Editing Objects
The Edit menu contains commands and tools for selecting, editing, and copying objects. These features 
enable you to:

Undo a previous operation, or redo what was previously undone.
Perform standard Windows clipboard operations: Cut, Copy, and Paste.
Clear (delete) objects using several options.
Select objects with the Select tool, or categorically by type, layer, or several other criteria.
Create multiple copies of entities along lines, around arcs, and in two-dimensional arrays.
Edit OLE objects using the source application and make changes to how OLE objects are linked 

to your TurboCAD drawing.
In addition to the features available from the Edit menu and toolbars, TurboCAD has two separate modes 
for mouse-based editing:

Select Edit, in which you scale, rotate, or move objects.
Node Edit, in which you reshape entities by editing special points called nodes.

Subtopics
Editing with the Mouse and Local Menu
Edit Menu Commands



Editing with the Mouse and Local Menu
TurboCAD offers powerful capabilities for editing directly with the mouse and local menu (which you 
access by right-clicking in the drawing area). There are two distinct editing modes that you can use for 
this purpose: Select Edit and Node Edit.

Subtopics
Select Edit
Node Edit
Manipulating Text



Select Edit
Select Edit is the editing mode an object is in when you first select it with the Select Edit tool. In this 
mode, the selected objects are bounded by a selection rectangle that has handles on each corner and at 
the midpoint of each side. At the center of the selection rectangle is the reference point, which is 
connected to the rotation handle, located just outside of the selection rectangle.
See Also: Geometric and Cosmetic Select Modes
Tip: You can get information about selected objects by choosing View|Selection Info.

Subtopics
Geometric and Cosmetic Select Modes
Advantages of Geometric Select Mode
Moving the Selection's Reference Point and Rotation Handle
Moving a Selection
Scaling a Selection
Copying While Moving or Scaling
Rubber Stamp
Rotating a Selection



Geometric and Cosmetic Select Modes
TurboCAD offers two distinct selection modes: Geometric Select mode and Cosmetic Select mode. You 
can switch between the two modes by clicking the Geometric Select Edit mode check box, located in the 
General property sheet of the Options|Program Setup dialog. 
In order to understand the difference between these selection modes, you must first realize that every 
TurboCAD entity has two separate sets of extents: geometric extents and cosmetic extents. Geometric 
extents are calculated based on the distance between the specific vertices that define the entity 
geometrically (for example, the three corners of a triangle, or the two endpoints of a line segment). 
Cosmetic extents are calculated based on distances between the outermost points on the object that will 
be drawn on the screen or on the printer. In many cases, the geometric and cosmetic extents will be 
exactly the same. This is true, for example, if you measure the extents of a single line segment drawn 
with the minimum (default) pen width. If, however, you are working with a double-line entity, or with an 
entity that is drawn with a pen that has greater than the default width, the geometric and cosmetic extents 
will differ.



Advantages of Geometric Select Mode
Other drawing packages use cosmetic selection only. What is the advantage of geometrically accurate 
selection? There are two main advantages:

When you scale using geometric extents, it is easy to see exactly what is going to be scaled. If, 
for example, you scale a double-line entity, TurboCAD does not scale the width of the double line, just as 
it does not re-scale the width of the pen. Geometric Select mode makes it visually obvious that this is the 
case.

When you scale an orthogonally oriented linear entity using geometric extents, you get accurate 
results. If, for example, you scale a 1-inch horizontal line segment 200 percent along the X axis, the line 
segment will always be 2 inches long. If you were to use cosmetic extents, the results would vary, 
depending on the width of the pen.
The disadvantage of geometric selection is that if you snap the endpoint of a wide line to another object, 
the cosmetic end of the line will overlap the object. You can work around this problem by selecting a line 
using cosmetic extents and using a snap mode to position the cosmetic end of the line.
Tips: If you want to scale the width of a double line as you scale an entity, you need to first turn the 
double line into two single lines. To do this, select the entity, then choose Explode from the Format menu. 
If the double line is contained within a group or within a block insert, you will have to choose Explode 
more than once, because the Explode command breaks an object down into its constituent parts one step
at a time. 
Another way to adjust the width of a double line, or to change the width of the pen, is to select the entity 
and double-click on it, bringing up its properties sheets. You can change the width of a double line in the 
Double Line property sheet, or the width of the pen in the Pen property sheet.
See Also: Explode, Properties Dialog



Moving the Selection's Reference Point and Rotation Handle
There are two ways to move the reference point of a selection to any position in the drawing area. The 
first way is to hold down the <Ctrl> key while clicking on the reference point. The cursor will change to a 
hand grasping the point. You can now move the reference point to any position by defining a point. You 
can do this with the mouse using any snap mode, or you can type the coordinates of the point into the 
Coordinate Fields and press <Enter>. 
The second way is to press <D> on the keyboard when an object is selected. This temporarily places the 
reference point in the cursor. Click at the desired new location, or use a snap mode, or type the 
coordinates of the point into the Coordinate Fields and press <Enter>. 
It is possible to move the rotation handle in a similar fashion, by pressing <Ctrl> and then clicking the 
rotation handle. You can then place it using snaps or coordinate entry. 
To restore the reference point to its original location at the center of the selection, press the <Ctrl> key 
while clicking on the reference point, then right click and chose Default Reference Point. 
Tip: When you rotate an object, you do so in relation to its reference point. This means that you can 
rotate the object not only around its own center, but around any arbitrary point or object in the drawing 
space. For example, you can use Snap to Arc Center mode to move the reference point of the selection to
the geometric center of a circle or arc, then "orbit" the selection around that point. 



Moving a Selection
There are three ways to move a selection in Select Edit mode: "picking it up" by its reference point; 
dragging it by its reference point (OLE drag and drop); and "simple dragging" (that is, dragging by any 
point within the selection rectangle other than the reference point).

Subtopics
"Picking" the Reference Point
OLE Drag and Drop
Simple Dragging



Picking the Reference Point
In most cases the most convenient and accurate way to move an object is to click on its reference point, 
then define a new location for the reference point. The object moves with the reference point:
1. Select the object or objects that you want to move.
2. If desired, move the selection’s reference point relative to the selection. For example, if in moving a 

rectangle you wish to precisely place its lower-left corner, rather than its center, first move the 
reference point to the lower-left corner of the rectangle. You can use snap modes for precise 
placement of the reference point.

3. Click on the selection’s reference point. The cursor changes to a four-directional pointer (crossed 
arrows).

4. Define the point where you want to place the selection. You can do this by clicking the mouse, using 
any snap mode. Alternatively you can press <Shift-Tab> to activate the Coordinate Fields, then type 
the coordinates of the desired location in the Coordinate Fields and press <Enter>.

Tip: When you move a selection by picking its reference point, you can use Ortho mode when you place 
the selection. You can turn on Ortho mode in the menu, toolbar, or local menu before or during the 
placement of the selection; you can also toggle Ortho mode during placement by holding down the 
<Shift> key.
See Also: Moving the Selection's Reference Point and Rotation Handle



OLE Drag and Drop
You are using OLE drag and drop whenever you drag an object by its reference point.
1. If you're going to use a snap mode, set it before starting the move. You may also want to move the 

reference point relative to the selection before beginning the move.
2. Place the mouse cursor directly over the reference point. You will know it is there when the mouse 

cursor turns into a four-directional pointer.
3. Hold the mouse button down while "dragging" the object to the new location, then release the mouse.

The main advantage of OLE drag and drop is that it lets you copy the selection from one drawing into 
another, or even from a TurboCAD drawing into another application. You may also use this method to 
create symbols or blocks by dragging into the symbol or block palette. 
Warning: The behavior of snap modes is slightly unusual when you are moving an object using OLE drag
and drop. If TurboCAD finds a snap point based on the location of the mouse at the point of release, then 
the reference point will snap to the snap point. If TurboCAD cannot    find a snap point, then the object will 
simply be dropped at the point of release.
See Also: Snap Modes



Simple Dragging
If you place the mouse pointer anywhere inside a selection other than on the reference point, you can 
simply drag the selection to another location within the drawing. Simple dragging does not allow you to 
use snap modes or the Coordinate Fields for accurate placement, but it is convenient if you don't need 
accurate placement.



Scaling a Selection
You can scale a selection either by dragging its handles, or by entering values for its X and Y scale in the 
Edit Bar. 
Drag the handles on the corners to freely resize the selection both horizontally and vertically. To scale the 
selection only horizontally or only vertically, drag the handles on the sides, top, or bottom of the selection 
rectangle. To scale the selection while keeping the same proportions of height and width, hold down the 
<Shift> key while dragging the handles.
To scale a selection using the Edit Bar, type values into the XScale and YScale Edit Bar fields, then press 
<Enter>. For example, if you want to double the width of the selection while increasing its height by 50 
percent, press <Tab> to move to the Edit Bar, and then type 2 into the XScale field. Press <Tab> again 
and type 1.5 into the YScale field. Press <Enter> to finish.
Note: If the object you are scaling contains double lines or lines drawn with a pen width greater than 0, 
the results of scaling a selection will vary, depending on whether you are using geometric or cosmetic 
selection. For geometrically accurate results, use the default Geometric Select mode.
See Also: Geometric and Cosmetic Select Modes



Copying While Moving or Scaling
The Make a Copy option in the local menu lets you make a copy of the selection at the same time that 
you move or resize the object. To use this option:
1. Select the object or objects that you want to copy.
2. Right-click in the drawing area to open the local menu, then choose Make a Copy, if it isn’t already 

checked. (This is a toggle, so if it already has a check mark next to it, choosing it will turn it off.)
3. Move or scale the selection by either picking the reference point or dragging by the selection handles.

When you move or scale the selection, the original will remain at its original location and size, while a 
copy is created at the new location and size.
Tip: You can turn on the Make a Copy option temporarily by holding down the <Ctrl> key after you start to
copy or scale the selection.



Rubber Stamp
Turning on the Rubber Stamp option allows you to place multiple copies of selected objects in your 
drawing. To use this option:
1. Select the object or objects that you want to copy.
2. Right-click in the drawing area to open the local menu, then choose Rubber Stamp. The cursor will 

change into a rubber stamp symbol.
3. Click anywhere in the drawing to place a copy of the selection.

You can continue clicking to place as many copies of the selection as you like. To turn Rubber Stamp off, 
right-click in the drawing area to open the local menu and choose Cancel, or press <Esc>.
Note: Rubber Stamp placement does not respond to snap modes.



Rotating a Selection
To rotate a selection either move its rotation handle, or type a value into the Rotation Field on the Edit 
Bar. 
To move the rotation handle of the selection, click on the handle, then define a point by clicking the 
mouse, using any snap mode. To rotate the selection using the Edit Bar, press <Tab> to switch 
TurboCAD’s focus to the Edit Bar, type a value for the degrees of rotation into the Edit Bar’s Rotation 
field, then press <Enter>. The value you enter in the Edit Bar is the number of degrees that the selection 
will be rotated in the positive direction of rotation. To rotate the object in the opposite direction, enter a 
negative value in the Rotation field.
Note: The positive direction of rotation is counterclockwise by default. You can reverse the direction in the
Angle property sheet of the Drawing Setup dialog (Options|Angle).
Tip: When you rotate a selection you can use Ortho mode to constrain the angle of rotation. You can turn 
on Ortho mode in the menu, toolbar, or local menu before or during the placement of the selection; you 
can also toggle Ortho mode during placement by holding down the <Shift> key.
Tip: The rotation handle can be moved by pressing <Ctrl> and clicking on the handle.
See Also: Ortho



Node Edit
In Node Edit mode you can reshape entities by directly manipulating particular points called nodes. 

Add, delete, and move nodes on entities composed of line segments (including lines, double 
lines, polygons, and sketches).

Divide line segments into any number of subsegments of equal length.
Break polygons, converting them into multilines.
Delete segments of multilines.
Close multilines, converting them into polygons.
Close the endpoints of double lines.
Reshape Bezier and spline curves by adding, deleting, and moving nodes and their tangent 

points on the line segments that form the curves’ frame.
Change the radius of circles and circular arcs.
Change the major and minor axes of ellipses and elliptical arcs.
Change the start and end angles of circles, ellipses, and arcs.
Close arcs, converting them into circles.
Divide circles, arcs, and ellipses into arc segments of equal angular length.

There are three ways to activate Node Edit mode. You may first select the entity that you wish to edit, 
then click the right mouse button in the drawing area to display the local menu. From the local menu, 
choose Node Edit. The appearance of the selection will change. Instead of a selection box with handles, 
you will see highlighted objects with nodes displayed as blue squares. The number and placement of the 
nodes depends on the type of object selected.
You may also select the Node Edit tool from the Standard toolbar; it is on a fly-out toolbar with the Select 
Edit tool.(Or use Menu: Edit|Node Edit.) The tool looks just like the Select tool, except for a dot inside the 
arrow. Click on the intended object, and it will be in Node Edit mode.
The third way to active Node Edit is to press the <Ctrl> key before clicking on an object with the Select 
Edit tool. 
To deselect an entity in Node Edit mode, click anywhere in the drawing area other than on the selected 
object.
Note: You can only edit one entity at a time in Node Edit mode. You cannot use this mode to work with 
multiple selected entities or with groups. To edit the nodes of an entity that is in a group, first select the 
group, then break it into its component entities using the Format|Explode command. Because groups and 
block inserts can be nested, you may need to explode the selection more than once in order to isolate a 
single entity.

Subtopics
Node Edit with Linear Entities
Node Edit with Curves and Sketched Lines
Node Edit with Circles, Ellipses, and Arcs
Node Edit of Dimensions



Node Edit with Linear Entities
There are several editing actions you can perform on entities composed of line segments. These actions 
include adding a node, deleting a node, moving a node, and dividing or deleting a line or double-line 
segment.

Subtopics
Adding a Node to a Line or Double Line Segment
Deleting a Node from a Line Segment
Moving a Node
Dividing a Line or Double Line Segment
Deleting a Line or Double Line Segment
Breaking Polygons
Closing Multilines
Closing Endpoints of Double Lines
Editing Double Line Cut Lines and Gaps



Adding a Node to a Line or Double Line Segment
To add a node to a single or double line segment on a line, multiline, or polygon:
1. Select the entity that you want to edit. Click the right mouse button in the drawing area to open the 

local menu, then choose Node Edit.
2. Hold down the <Ctrl> key while placing the mouse cursor over a part of a line or double-line segment 

where there is no node. When you are in the correct position, the cursor will show a node being 
placed at the center of a cross.

3. Click to place the node on the line segment.

A node will appear on the line or double-line segment at the location of the mouse cursor. You can now 
drag the node to reshape the line segment into a multiline.
Note: As an alternative to holding down the <Ctrl> key while clicking on the line segment, you can place 
the mouse cursor at the position where you want to add the node, then right-click and choose Add Node 
from the local menu.



Deleting a Node from a Line Segment
To delete a node from a line or double line segment on a line, multiline, or polygon:
1. Select the entity that you want to edit. Click the right mouse button in drawing area to open the local 

menu, then choose Node Edit.
2. Hold down the <Ctrl> key while placing the mouse cursor over the node that you want to delete. 

When you are in the correct position, the cursor will change to an icon showing a node being thrown 
into a trash can.

3. Click to delete the node.

If you remove a node from a polygon, TurboCAD will keep the polygon closed by connecting the opposite 
endpoints of the line segments that were connected at the deleted node.
Note: You cannot delete a node that is necessary to define an entity as a line segment or polygon. This 
means that you cannot delete the endpoint of a single line segment, and you cannot delete any node of a 
triangle. If you delete the endpoint of a multiline, you will delete the entire line segment that terminates at 
that point. 
See Also: Closing Multilines, Breaking Polygons



Moving a Node
You can reshape a single line or double line segment on a line, multiline, or polygon, by defining a point 
for the location of any node. To do this:
1. Select the entity that you want to edit.
2. Click the right mouse button to open the local menu and choose Node Edit.
3. Click on the node that you want to move.
4. Define the point to which you want to move the node. You can do this by either using the mouse and 

any snap mode, or by typing the coordinates of the point in the Coordinate Fields and pressing 
<Enter>.

Note: You can also simply drag the node to any position you want.



Dividing a Line or Double Line Segment
The Segment Divide command from the local menu lets you add nodes to a line segment, breaking the 
line segment into a multiline composed of segments of equal length. To do this:
1. Select the entity that you want to edit.
2. Click the right mouse button to open the local menu and choose Node Edit.
3. Place the mouse cursor over the line segment that you want to divide.
4. Click the right mouse button to open the local menu and choose Segment Divide. TurboCAD displays 

the Divide Segment By dialog.
5. Enter the number of parts into which you want to divide the line into the dialog, and then press 

<Enter> or click the OK button.



Deleting a Line or Double Line Segment
The Segment Delete command from the local menu lets you delete a line segment. To do this:
1. Select the entity that you want to edit.
2. Click the right mouse button to open the local menu and choose Node Edit.
3. Place the mouse cursor over the line segment that you want to delete.
4. Click the right mouse button to open the local menu and choose Segment Delete. The segment is 

deleted.

Note: If you delete a line segment that is part of a closed figure, the figure will no longer be closed.



Breaking Polygons
Node Edit allows you to break a polygon at any node, turning it into a multiline. To break a polygon:
1. Select Node Edit from the Standard toolbar.
2. Click on the polygon.
3. Position the cursor over the node where you want to break the polygon.
4. Click the right mouse button to open the local menu and choose Break.

The polygon is now an open multiline, and there are two nodes located at the point where you broke the 
polygon. You can open the polygon visually by moving these nodes apart.
Note: You can also use this technique to break a closed Bezier or Spline curve.



Closing Multilines
Node Edit allows you to close a multiline, changing it into a polygon. To close a multiline:
1. Select the multiline entity that you want to close.
2. Click the right mouse button to open the local menu and choose Node Edit.
3. Position the cursor over either endpoint of the multiline.
4. Click the right mouse button to open the local menu and choose Close.

TurboCAD will draw a line between the two endpoints of the multiline (assuming that these two nodes 
don’t share the same location), forming a geometrically closed polygon. If the two endpoints of the 
multiline share the same location, TurboCAD will simply close the polygon geometrically, since it is 
unnecessary to draw a line between the two points.
Note: You can also close a Bezier or Spline curve using this technique.
Warning: If you simply snap the endpoints of a multiline together you have something that looks exactly 
like a polygon; however, TurboCAD still considers it a multiline. This means that you won't be able to use 
a fill by setting the entity's brush color and pattern in its Properties sheet. In order to turn a multiline into a 
true polygon, you must close the multiline.



Closing Endpoints of Double Lines
Node Edit allows you to close the endpoints of double lines. To do this:
1. Select the double-line entity.
2. Click the right mouse button to open the local menu and choose Node Edit.
3. Position the cursor over either endpoint of the double line.
4. Click the right mouse button to open the local menu and choose Close Double End.

TurboCAD will close the double line with a flat end.



Editing Double Line Cut Lines and Gaps
Cut lines and gaps occur at the intersections of double lines. For example, if you form a clean T 
intersection of two double lines at an angle other than 90 degrees, the end of one of the double lines will 
be "cut" at an angle; the other double line will have a "gap" to accommodate the first double line. Node 
Edit mode allows you to drop the cut lines in the first line, to even out the end of the line; it also allows you
to fill in the gap in the second line.



Node Edit with Curves and Sketched Lines
Sketches (entities created with the Sketch tool) are actually multilines composed of very small line 
segments, so they can be edited in Node Edit mode as multilines that have a very large number of nodes.
Bezier and Spline curves are both drawn in reference to a sequence of node points (spline curves 
gravitate toward the points, while Bezier curves pass through the node points, and gravitate toward 
separate control points). 
In Node Edit mode, you can move or delete any of the nodes that define a curve, and you can add new 
nodes that you can move to reshape the curve. You can move and delete the nodes on a curve the same 
way that you move and delete nodes on a line segment, multiline, or polygon. 
You can also close a Bezier or Spline curve, or break a closed Bezier or Spline curve at any node, using 
the same technique that you would use to close a multiline or break a polygon.
See Also: Adding a Node to a Line or Double-Line Segment, Breaking Polygons, Closing Multilines, 
Deleting a Node from a Line Segment, Moving a Node

Subtopics
Adding a Node to a Curve



Adding a Node to a Curve
To add a node to a Bezier or spline curve:
1. Select the curve that you want to edit. Click the right mouse button in drawing area to open the local 

menu, and choose Node Edit.
2. Hold down the <Ctrl> key while placing the mouse cursor over a part of the curve where there is no 

node. When you are in the correct position, the cursor will change to an icon showing a node being 
placed at the center of a cross.

3. Click to place the node on the line segment.

A node will appear on the line segment at the location of the mouse cursor. You can now drag the node to 
reshape the curve.
Note: As an alternative to holding down the <Ctrl> key while clicking on the line segment, you can place 
the mouse cursor at the position where you want to add the node, then right-click and choose Add Node 
from the local menu.



Node Edit with Circles, Ellipses, and Arcs
In Node Edit mode you can change the radius of a circle or circular arc, the major and minor axes of an 
ellipse or elliptical arc, and the starting or ending angles of any arc, circle, or ellipse. You can also divide 
any circular or elliptical entity into any number of equal arcs.
To edit a circle, ellipse, or arc in Node Edit mode, first select the entity that you want to edit, then click the 
right mouse button in the drawing area to open the local menu and choose Node Edit. The entity that you 
selected will be highlighted with its nodes displayed. In the case of a circle or circular arc, you will see 
three nodes: two for manipulating its starting and ending angles, and one for manipulating its radius. In 
the case of an ellipse, you will see four nodes: two for manipulating its starting and ending angles, and 
two for manipulating its major and minor axes.
Tip: If you are confused by the notion of editing the starting and ending angles of a circle or ellipse, try 
thinking of circles and ellipses as arcs that have their starting and ending angles at zero and 360 degrees.

Subtopics
Changing the Radius of a Circle or Circular Arc
Editing the Major and Minor Axes of Ellipses and Elliptical Arcs
Changing the Starting and Ending Angle of an Arc
Dividing an Arc



Changing the Radius of a Circle or Circular Arc
To alter the radius of a circle or circular arc:
1. Select the circular entity that you want to edit. Click the right mouse button to open the local menu, 

then choose Node Edit. You will see three nodes, one of which is a blue square. You can manipulate 
this radius node to change the circle’s radius.

2. You can now either define a point for the radius node, or directly enter the radius of the circle in the 
Edit Bar. 

To define a point, click on the radius node, then define a point by clicking the mouse, using any 
snap mode; or type values for the point’s coordinates in the Coordinate Fields, then press <Enter>.

To specify the radius in the Edit Bar, press <Tab> to leave the drawing area, type a value for the 
radius into the Radius field of the Edit Bar, then press <Enter>.
You can also simply drag the radius point to another position, but in doing this you lose the precision of 
using snap modes, the Coordinate Fields, or the Edit Bar.



Editing the Major and Minor Axes of Ellipses and Elliptical Arcs
To scale an ellipse or elliptical arc:
1. Select the elliptical entity that you want to edit. Click the right mouse button to open the local menu 

and choose Node Edit. You will see four nodes, two of which are blue rectangles on the perimeter of 
the ellipse: You can manipulate these nodes to scale the ellipse.

2. You can now either define points for the two nodes or directly enter values for the lengths of the major
and minor axes of the ellipse in the Edit Bar:

To define points for the nodes, first click on one of the nodes, then define a point either by clicking
the mouse using any snap mode, or by typing values for the point’s coordinates in the Coordinate Fields 
and pressing <Enter>. Repeat this procedure for the other node.

To specify the lengths of the axes in the Edit Bar, press <Tab> to leave the drawing area, type a 
value for the axes in the Major and Minor fields of the Edit Bar, then press <Enter>.
You can also simply drag the nodes to another position, using any snap mode.
Tip: While changing the length of an ellipse's axis, you can hold down the <Shift> key, constraining the 
proportions of the ellipse and changing the length of both axes simultaneously.



Changing the Starting and Ending Angle of an Arc
To alter the starting and ending angles of a circle, circular arc, ellipse, or elliptical arc:
1. Select the entity that you want to edit. Click the right mouse button to open the local menu and 

choose Node Edit. You will see three nodes for circular entities and four nodes for elliptical entities. 
Two of the nodes are represented as a red and a green square at the ends of dotted lines. You can 
manipulate these nodes to change the starting and ending angles of the entity.

2. You can either move the nodes to specify starting and ending angles or enter values for the starting 
and ending angles in the Edit Bar:

To move the nodes, first click on one of the nodes, then define a point by clicking the mouse, 
using any snap mode. Repeat this procedure for the other node.

To specify the starting and ending angles in the Edit Bar, press <Tab> to leave the drawing area, 
type a value for the axes in the Start Ang and End Ang fields of the Edit Bar, then press <Enter>.



Dividing an Arc
The Divide command from the local menu lets you divide an arc or circle into subarcs of equal angular 
length. To do this:
1. Select the entity that you want to edit. Click the right mouse button to open the local menu and 

choose Node Edit.
2. Click the right mouse button to open the local menu, and choose Arc Divide. TurboCAD will display 

the Divide Arc By dialog.
3. Enter the number of parts into which you want to divide the arc, then press <Enter>.



Node Edit of Dimensions
Dimensions have nodes that let you manipulate the position of the dimension line, extension lines, and 
dimension text. You can also move the associative nodes of dimensions. These are the nodes that are 
associated with the dimension text, so that changing the position of the nodes will cause automatic 
dimension text to be updated. 
Note: If a dimension is associated with an entity, then moving the node attached to the entity will break 
the association between the entity and the dimension.



Manipulating Text
TurboCAD has a rich set of features for manipulating text, based on the principle that you can edit the text
either as:

TrueType font
a group of polygons
individual polygons (each character becomes one polygon)

When you first create text, it is a TrueType font. You can select the text, stretch it, and rotate it. When text 
is in this state you can edit it by changing the Attribute field of the General property sheet of the Properties
dialog. Double-click on the text with the Select tool to bring up this dialog. You can reformat the text 
(changing its font, size, attributes, and justification) using the Text Format toolbar or the Text property 
sheet of the Properties dialog.
New in TurboCAD Learning Edition is the ability to set the status of the text as Scalable, Standard, or 
Flexible. 
If you want more freedom to manipulate the text graphically, you need to turn the text into an irregular 
polygon. To do this, select the text object using the Select tool, then choose Format|Explode. The first 
time you do this, you will turn the text object into a group of polygons. You can now stretch, rotate, or flip 
the graphic text using handle-based editing, producing a variety of effects.
If you explode the text a second time, it will ungroup so that each individual character can be manipulated
as a polygon. You can resize, stretch, move, flip, or rotate each individual character in Select Edit mode. 
You can change the pen, brush pattern, or other properties of the multiline by double-clicking on the 
selection and changing the settings in the Properties dialog.
If you select an individual polygon (character), and then right-click and choose Node Edit from the local 
menu, you can edit individual nodes. You can move, delete, and add nodes; and you can also break the 
polygon into a multiline.
If you explode an individual polygon character, it will be broken into individual line segments.
See Also: Node Edit with Linear Entities, Select Edit, Text Property Sheet



Edit Menu Commands
The following table summarizes the commands accessible from the Edit menu:

Command Function(s)
Undo Reverse previous action.
Redo Reverses the effect of the previous Undo command.
Cut Remove selected objects and place them on the 

Windows clipboard.
Copy Copy selected objects to the clipboard.
Paste Paste objects into the drawing from the clipboard.
Paste Special Paste objects from the clipboard as data or as OLE 

objects.
Clear Remove selection, all objects, a single construction, or

all constructions from the drawing.

Select Activate the Select tool.
Node Edit Activate the Node Edit Select tool.
Select All Select all objects in the active drawing.
Select By Select by query, entity type, color, layer, or attribute. 

Also provides tool for selection using a free-form 
"fence."

Copy Entities Tools Create multiple copies of objects along lines, around 
arcs, in two-dimensional arrays, and more.

Links Make changes to linked OLE objects.
Object Edit OLE object using its source application.

Undo
Menu: Edit|Undo Hotkey: <Ctrl>+<Z> Toolbar: Standard

The Undo command reverses the previous action, restoring your drawing to its state prior to your last 
editing or drawing command. The name of this command will change, depending on the specific action 
that it undoes. Undo is also available on the Local Menu.
See Also: Redo



Redo
Menu: Edit|Redo Hotkey: <Ctrl>+<Y> Toolbar: Standard

The Redo command reverses the effects of an Undo command. The name of this command changes, 
depending on the specific action that it redoes. Redo is also available on the Local Menu. 
See Also: Undo



Cut
Menu: Edit|Cut Hotkey: <Ctrl>+<X> Toolbar: Standard

The Cut command removes any selected object or objects from your drawing and places them in the 
clipboard. From the clipboard you can paste them into TurboCAD drawings or into other Windows 
applications using the Paste or Paste Special commands.
See Also: Copy, Paste, Paste Special, Copy Entities Tools



Copy
Menu: Edit|Copy Hotkey: <Ctrl>+<C> Toolbar: Standard

The Copy command copies any selected object or objects from your drawing and places them in the 
clipboard. From the clipboard you can paste them into TurboCAD drawings or into other Windows 
applications using the Paste or Paste Special commands.
See Also: Cut, Paste, Paste Special, Copy Entities Tools



Paste
Menu: Edit|Paste Hotkey: <Ctrl>+<V> Toolbar: Standard

The Paste command pastes into your drawing any data that has been copied or cut into the clipboard. 
You can paste TurboCAD drawing objects, as well as text, bitmap, or Windows metafile data that has 
been placed in the clipboard from other programs.



Paste Special
Menu: Edit|Paste Special

The Paste Special command displays the Paste Special dialog.
The Paste Special dialog lets you choose how to paste into your drawing an object that was previously 
cut or copied to the clipboard. The object on the clipboard can be from TurboCAD, or it can come from 
another application. The options available in the Paste Special dialog depend on the type of object in the 
clipboard, and on the program in which the object was created (the source application). 
When you open the Paste Special dialog, you will see a number of choices in the As list box. For 
example, if there is a document on the clipboard created in Microsoft Word, the As text box will contain 
the following options:

Word Document
Picture (Metafile)
Text

If you choose Word Document, the data in the clipboard will be inserted into your drawing as an OLE 
object, which you can edit within TurboCAD using Microsoft Word features. If you choose Picture, the 
data will be inserted as an image. If you choose Text, the data will be inserted as text, creating a 
TurboCAD text object, which you can treat exactly like text created with the TurboCAD Text tool.
If you choose to insert a clipboard object into your drawing as an OLE object, you have a choice of either 
linking or embedding the object. If you click the Paste option button, you will embed the OLE object in 
your drawing. This means that the drawing will have its own independent copy of the OLE object. Any 
changes you make to this object will not affect the file on which it was based. If you activate the Paste 
Link option button, the OLE object will be linked to the file on which it was based. This means that any 
changes made to the file will be reflected in the OLE object, and any changes made to the OLE object will
also affect the file.
If you check the Display as Icon check box, the OLE object will appear in your drawing as an icon. (When 
this box is checked, you can click on the Change Icon button to select another icon.)
Note: There are only two types of data that can be inserted into TurboCAD as an editable TurboCAD 
drawing object. These are text data, which is inserted as a TurboCAD text object, and actual TurboCAD 
drawing entities that have been copied onto the clipboard from TurboCAD drawings. All other clipboard 
objects will be pasted either as OLE objects or as pictures (either bitmaps or metafiles).
Tip: If you plan to insert multiple copies of a single object into your drawing, you can keep your drawing 
file from growing too large by linking the objects rather than embedding them. This is possible because 
each linked object is simply a reference to the file on which it is based. If you link the object multiple 
times, each copy of the object shares the same source of data.
See Also: Edit Links, Edit Object, Insert Object, Insert Picture, Paste



Clear Commands
Menu: Edit|Clear

The Clear commands let you remove graphic objects and other objects from a drawing. The Edit|Clear 
menu item opens a submenu containing four options: Selection, All, Construction, and All Constructions. 
You can reverse any clear with the Undo command. The following table summarizes the Clear 
commands.

Command Function
Clear Selection Clear all objects that are currently selected.
Clear All Clear all objects in the drawing.
Clear Construction Activate the clear construction tool, with which you can delete 

individual constructions.
Clear All Constructions Clear all construction entities in the drawing.

Clear Selection
Menu: Edit|Clear|Selection Hotkey: <Del>

Use the Clear Selection command to delete any graphics or other objects that have been selected. If no 
objects have been selected, then this command is unavailable.
See Also: Select, Cut



Clear All
Menu: Edit|Clear|All

Use the Clear All command to delete everything on the drawing space and begin a new drawing.



Clear Construction
Menu: Edit|Clear|Construction

The Clear Construction command activates the Clear Construction tool, with which you can delete 
individual construction lines and circles. To use it, first activate the tool, then click on any construction that
you wish to delete. Choose Cancel from the local menu or switch to another tool when you are finished.



Clear All Constructions
Menu: Edit|Clear|All Constructions

Use the Clear All Constructions command to delete all construction entities (construction lines and circles)
from your drawing.



Select Commands
If you want to perform an editing action on an object or a set of objects in your drawing, you often need to 
select the objects first. When you select objects, they change to a pale magenta color and appear inside a
frame with handles. 
TurboCAD provides a large set of selection options, summarized in the following table.

Command Function
Select Activate the selection tool.
Node Edit 
Command

Activate the Node Edit Select tool. 

Select All Select all objects in the drawing.
Select By 
Commands

Access a submenu that lets you select objects by query, entity type, 
color, layer, attribute, or with a free-form "fence."

Select
Menu: Edit|Select Toolbar: Standard

The Select tool lets you select and deselect objects in the drawing area using the mouse. You can select 
a graphic entity (as well as an OLE object or bitmap) by clicking on it near its border, or you can select 
objects using a selection rectangle. Once objects are selected, you can deselect everything by clicking 
the mouse anywhere in the drawing area outside of the selection rectangle. You can also deselect 
everything by pressing <Esc>, choosing Cancel from the local menu, or clicking another drawing tool. 
Warning: If you try to deselect everything by clicking inside the selection rectangle, nothing will happen: 
You need to click outside the selection rectangle. Normally this is not a problem, but it might be confusing 
if you are zoomed in so that your view is inside the selection rectangle. If you find yourself in this situation 
just press <Esc> or choose Cancel from the local menu to deselect everything.

Subtopics
Selection by Clicking
Selection within Rectangle



Selection by Clicking
To select any object, simply activate the Select tool, then click on the object.
To select a series of objects, adding them one at a time to the selection, hold down the <Shift> key while 
clicking on each object in succession. To deselect multiple objects one at a time, hold down the <Shift> 
key and click on each selected object in succession.



Selection within Rectangle
The selection rectangle gives you different results, depending on whether Open Window Mode is on or 
off. To change this option, click the right mouse button in the drawing area to open the local menu, then 
choose Open Window Mode. If the menu item has a check next to it, the option is on; otherwise the option
is off.
To use the selection rectangle with the Open Window option on, hold the left mouse button down and 
move the cursor, creating a rectangle over an area that contains any part of the objects that you want to 
select, then release the mouse button. If any portion of an object is inside the rectangle, the entire object 
will be selected.
To use the selection rectangle with the Open Window option off, hold the left mouse button down and 
move the cursor, creating a rectangle over an area that contains the objects that you want to select in 
their entirety, then release the mouse button. If any portion of an object is outside the rectangle, it will not 
be selected.
Four function-key selection options are also available. <F6> will select the first object created in the 
drawing. Continuing to press <F6> will select additional objects in the order they were created. <F7> will 
select the last object drawn; continuing to press <F7> will select additional objects in reverse order. 
<Shift-F6> will add an additional object to the selection; in order of creation after the selected object. 
<Shift-F7> will add an additional object to the select, selecting the object drawn just previous to the 
selected object. 



Node Edit Command
Menu: Edit|Node Edit Hotkey: <Ctrl>+click Toolbar: Standard

Use the Node Edit tool to select objects that will be edited using Node Edit commands and tools. 



Select All
Menu: Edit|Select All Hotkey: <Ctrl>+<A>

Use the Select All command to select all objects that are currently on the drawing.



Select By Commands
Menu: Edit|Select By

Select By opens a submenu of special selection commands, summarized in the following table:

Command Action
Select by Query 
Dialog

Brings up a dialog that allows for multiple selection criteria.

Select by Entity Type
Dialog

Brings up a dialog that lets you select objects by their type.

Select by Color Dialog Brings up a dialog that lets you select objects by their color. 
Select by Layer Dialog Brings up a dialog that lets you select all the object on a layer or 

subset of layers.
Select by Attribute 
Dialog

Brings up a dialog that lets you select objects that share the same 
text in their Attribute property.

Select by Fence Activates a tool that lets you select a set of objects by drawing a 
polygonal "fence" 

Each of the selection methods can be cumulative; that is, you could first select by color, then add other 
objects selected by attribute to the total items selected. 



Select by Query Dialog 
Menu: Edit|Select By|Query

Select By Query allows for complex selection of entity variables. It is especially useful in large 
complicated drawings where color, layer, and entity type are all used to represent objects. 
The command opens a dialog where you may build a query, step by step. 

Subtopics
Query Procedural Language and Tools
Creating a Query Statement
Parse Query



Query Procedural Language and Tools
To build a query, you assemble a query statement. The query statement can be typed directly into the 
dialog, or generated using the available tools. A query statement is a logic statement, created using 
expressions, criteria, and variables. 
Expressions. The query language uses the math symbols = (Equals), < (Less Than), > (Greater Than), 
<> (Not Equal), and parenthesis, plus the logic expressions AND, OR and NOT. Buttons are available for 
the logic expressions and the parentheses; the math symbols are generated when criteria are selected (or
you may type them in directly).
Criteria. All the "Select By" options are available as criteria for a query: All, Selection, Field, Layer, Entity 
Type, Pen Color, Brush Color, and Attribute. Click the Criteria button to select these options.
Variables. Variables are the specific pieces of information that define criteria. For example, Yellow could 
be a variable that defines the criteria Color; "0" is a variable that defines the Criteria Layer. Variables are 
chosen along with criteria, or may be typed in directly.



Creating a Query Statement
Follow the steps below to create a sample query statement where Layer = "0" AND Color <> Yellow. 
1. From the menu, select Edit|Select By|Query. 
2. Click the Criteria button, then click on By Layer. The Select By Field dialog appears. 
3. Click on the text box list arrow for Value. All available layer names will be listed. Select "0" and click 

OK. 
4. Use the right arrow key on the keyboard, or your mouse, to move the blinking text insertion cursor to 

the end of the query statement. Press <Spacebar> once. 
5. Click the AND button. Press <Spacebar> once. 
6. Click Criteria and select By PenColor. 
7. Click the Relation drop-down and select the <> (not equal) relationship.
8. Click the text box list arrow for Value. All available colors will be listed. Select Yellow from the list and 

click on OK. 



Parse Query
The Parse Query command will test the syntax of the query statement. If there is an error in logic or 
format, a "Syntax Error" message will appear. If the query statement makes sense, a "Query was parsed 
successfully" statement will appear. 
Note: The Parse Query command only tests to see if a query statement makes sense. It does not test to 
see if the statement will actually select entities or objects in the drawing.



Select by Entity Type Dialog
Menu: Edit|Select By|Entity Type

The Select By Entity Type command opens a dialog that lets you select all the objects in the drawing that 
belong to specific types.
You can use this dialog to select objects that belong to any type or combination of types, using common 
Windows list box selection techniques. For example, if you wish to select all linear and angular 
dimensions in your drawing, you would hold down the <Ctrl> key while clicking on Linear Dimension and 
Angular Dimension, highlighting both items. If you wish to add objects of these types to a current 
selection, place a check in the Add to the Current Selection check box. If this box is not checked, then any
currently selected items will be deselected as the new objects are selected.



Select by Color Dialog
Menu: Edit|Select By|Color Hotkey: <Ctrl>+<K>

The Select By color command opens a dialog that lets you select all the objects in the drawing by 
specifying the color.
Note: Objects inside a group or block will not be found using Select By Color. The Explode command 
must be used to reduce groups or blocks to their basic elements before a By Color search would find any 
part of these objects.    



Select by Layer Dialog
Menu: Edit|Select By|Layer Hotkey: <Ctrl>+<L>

The Select By Layer command selects all objects that exist on a specific layer or on a specific set of 
layers.
You can use this dialog to select objects that exist on a particular layer or combination of layers, using 
common Windows list box selection techniques. For example, if you wish to select all objects on layers 
Floor and Furniture (assuming that you have created these layers in your drawing), you would hold down 
the <Ctrl> key while clicking on Floor and Furniture, highlighting both items. If you wish to add objects of 
these types to a current selection, click the Add to the Current Selection check box. If this box is not 
checked, then any currently selected items will be deselected as the new objects are selected.
See Also: Layers Property Sheet



Select by Attribute Dialog
Menu: Edit|Select By|AttributeHotkey: <Ctrl>+<I>

The Select by Attribute dialog lets you select all objects that share the same text in their Attribute property,
which you can set for each object in the General property sheet of the Format|Properties dialog.
To use this dialog, type text in the Attribute text box that matches the contents of the attribute text box of a
set of entities, then click OK to select the entities. Because the attribute property contains group and block
names, you can use this dialog to select all groups or blocks that share the same name. The dialog also 
contains the following options:
Case Sensitive. Place a check mark in this box if you want the search to distinguish between uppercase 
and lowercase letters. Entering Wall with this checked would select objects that have the attribute "Wall", 
but not "wall" or "WALL".
All Entities. Select this option if you want to select all entities that share the specified text attribute.
Group Names Only. Select this option if you want to select only groups that share the specified text 
attribute.
Block Names Only. Select this option if you want to select only block inserts that share the specified text 
attribute.
Text Entities Only. Select this option if you want to select only text entities that share the specified text 
attribute.
Note: The text attribute of a text entity contains the same text that the entity displays.
You can also select objects that share attribute text that begins with the same characters by using the * 
symbol. The * symbol stands for any terminating characters in the text. For example, objects with text 
attributes "Wall 1", "Wall 2", and "Wall 3" will all be selected if you type Wall* into the Attribute text box. 
This is convenient for selecting all groups and blocks that belong to the same general category. You might
want to keep this in mind when you are choosing names for groups and blocks.
Note: All characters that follow the * symbol will be ignored. If you type Wall * with Window, for example, 
you will select objects with the attribute "Wall 1", and "Wall 2", as well as "Wall 1 with Window" and "Wall 2
with Window".
See Also: Properties Dialog



Select by Fence
Menu: Edit|Select By|Fence

The Select by Fence tool lets you select a set of objects by drawing a polygonal "fence" around them. 
This fence works exactly like the Irregular Polygon drawing tool.
1. Activate the Select by Fence tool.
2. Define a series of points by clicking and moving the mouse, using any snap mode. Each point you 

define will become a new vertex (corner) of an irregular polygon fence. Make sure that any objects 
you wish to select are contained within the fence.

3. Right-click in the drawing area and choose Finish to complete the fence and select the objects.

Note: Like the Select tool, the Select by Fence tool responds to the state of the Open Window Mode 
option. You can change this option in the local menu after right-clicking in the drawing area. If Open 
Window Mode is on, then any objects that are partially contained within the fence will be selected. If Open
Window Mode is off, then only objects that are entirely contained within the fence will be selected.
See Also: Selection within Rectangle

Subtopics
Using Snap Modes
Constraining Angles with Ortho
Setting Snap Modes and Ortho



Copy Entities Tools
Menu: Edit|Copy Entities

TurboCAD’s tools for copying entities enable you to make single or multiple copies of entities, and at the 
same time precisely control the placement of the copies. The following table summarizes the entity 
copying tools:

Command Function
Linear Copy Make copies along a line, specifying the interval between each copy.
Radial Copy Arrange copies in an arc, specifying the angular distance between each 

copy and the rotation of each copy relative to the previous copy.
Array Copy Copy entities in a two-dimensional array, specifying the distance 

between each entity.
Linear Fit Copy Make copies along a line, specifying the total distance into which all the 

copies fit.
Radial Fit Copy Arrange copies in an arc, specifying the total angular distance in which 

all the copies must fit and the rotation of each copy relative to the 
previous copy.

Array Fit Copy Copy entities in a two-dimensional array, specifying the dimension of the 
rectangle into which they fit.

Mirror Copy Create a mirror image of an object on the opposite side of a line that you
specify.

Vector Copy Make a single copy of an object, specifying the angle and distance of the
copy from the original.

Tip: When you are using the Copy Entities tools, you may often find it necessary to switch back and forth 
between the Edit Bar and the drawing area. One reason for this is to use the Edit Bar to specify the 
number of copies that you want to make. Remember that you can move to the Edit Bar without moving 
the mouse by pressing <Tab>. You can return to the drawing space from the Edit Bar, with the cursor in 
exactly the position you left it, by either clicking once in the drawing area or by pressing <Ctrl>+<D>.
Note: If you do not change the rotation or scale of the copies that you create, TurboCAD will include the 
original copy in the number of sets. If you do rotate or scale the copies, the original will not be included in 
the number of sets. For example, if you specify a new scale or rotation and specify 20 sets, TurboCAD will
make 20 copies of the original. If you do not specify a new scale or rotation, TurboCAD will make 19 
copies, using the original as the 20th copy.



Linear Copy
Menu: Edit|Copy Entities|Linear Toolbar: Standard, Copy fly-out

Use Linear Copy to create one or more copies of an object along a straight line, specifying the distance 
between each copy, the angle of the line along which the copies will be made, and the number of copies.
1. Select the object or objects that you want to copy.
2. Choose the Linear Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it
4. Type these values into the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values into XStep and YStep to specify the horizontal and vertical distance of each copy 
from the previous copy.

Type the number of copies you want to make into Sets. 
5. Press <Enter> to create the copies.

Note: You can also specify the XStep and YStep values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of sets, as well as values for 
rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to accept the 
current values.



Radial Copy
Menu: Edit|Copy Entities|Radial Toolbar: Standard, Copy fly-out

Use Radial Copy to arrange one or more copies of an object in an arc, specifying the angular distance 
from one copy to the next.
1. Select the object or objects that you want to copy.
2. Choose the Radial Copy tool.
3. Define a point for the center point of the arc around which you want to arrange the copies. The radius 

of the arc is the distance from this point to the reference point of the selection. This arc is visible as a 
rubber-band circle in the drawing area.

4. Press <Tab> or click in the Edit Bar to activate it, then enter the following values into the Edit Bar 
fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type the number of copies you want to make into Sets. If you have scaled or rotated the copies, 
the original will not be included in the number of sets. TurboCAD will choose appropriate values for Angle 
and +Rot based on the number of sets you enter.

Optionally type a value into the Angle text box to specify the angular distance between the copies.
Optionally type a value into +Rot to specify the rotation of each copy relative to the previous copy.

5. Press <Enter> to create the copies

Notes: You can also specify Angle by defining a point within the rubber band circle in the drawing area 
using the mouse. However, the number of sets, the +Rot rotation value, as well as values for rotating and 
resizing the copies, must be specified in the Edit Bar first, unless you want to accept the current values. 
The Sets, Angle, and +Rot values are interdependent. Changing the number of sets will change the 
values in Angle and +Rot; changing Angle will affect +Rot. These default ratios are designed to give you 
an elegant, symmetrical radial copy. Once you have entered values in these fields, however, the 
automatic interdependency is switched off, and you can enter any values you like.



Array Copy
Menu: Edit|Copy Entities|Array Toolbar: Standard, Copy fly-out

Use Array Copy to arrange copies of selected objects into a two-dimensional array (rows and columns). 
You specify the horizontal and vertical distance between the copies.
1. Select the object or objects that you want to copy.
2. Choose the Array Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it, then enter the following values in the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values in the XStep and YStep fields to specify the horizontal and vertical distance between 
the center points of the copies.

Type values into the Rows and Columns fields to specify the number of rows and columns in the 
array.
4. Press <Enter> to create the copies.

Note: You can also specify the XStep and YStep values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of rows and columns, as well 
as values for rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to 
accept the current values.



Linear Fit Copy
Menu: Edit|Copy Entities|Fit Linear Toolbar: Standard, Copy fly-out

Use Linear Fit Copy to create one or more copies of an object along a straight line, specifying a length 
into which all the copies will fit.
1. Select the object or objects that you want to copy.
2. Choose the Linear Fit Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it, then enter these values into the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values into XSize and YSize to specify the length of the line onto which all the copies will fit. 
The copies will be placed on this line an equal distance apart.

Type the number of copies you want to make into the Sets field. If you have scaled or rotated the 
copies, the original will not be included in the number of sets.
4. Press <Enter> or create the copies.

Note: You can also specify the XSize and YSize values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of sets, as well as values for 
rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to accept the 
current values.



Radial Fit Copy
Menu: Edit|Copy Entities|Fit Radial Toolbar: Standard, Copy fly-out

1. Select the object or objects that you want to copy.
2. Choose the Radial Fit Copy tool.
3. Define a point for the center point of the arc around which you want to arrange the copies. The radius 

of the arc is the distance from this point to the reference point of the selection. This arc is visible as a 
rubber-band circle in the drawing area.

4. Press <Tab> or click in the Edit Bar to activate it, then type the following values in the Edit Bar fields:
Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 

same time as you copy.
Type the number of copies you want to make into the Sets field. 
Optionally type a value into the Angle text box to specify the angular distance into which all the 

copies will fit.
Optionally type a value into the +Rot field to specify the rotation of each copy relative to the 

previous copy. 
5. Press <Enter> or click the mouse in the drawing area to create the copies.

TurboCAD will make radial copies in a counterclockwise direction, starting with the original object and 
ending at the angle set in step 4. The copy direction will be counterclockwise regardless of the direction 
setting in the Angle property sheet of the Drawing Setup dialog.
Notes: You can also specify Angle by defining a point within the rubber band circle in the drawing area 
using the mouse. However, the number of sets, the +Rot rotation value, as well as values for rotating and 
resizing the copies, must be specified in the Edit Bar first, unless you want to accept the current values. 
The Sets, Angle, and +Rot values are interdependent. Changing the number of sets will change the 
values in Angle and +Rot; and changing Angle will affect +Rot. These default ratios are designed to give 
you an elegant, symmetrical radial copy. Once you have entered values in these fields, however, the 
automatic interdependency is switched off, and you can enter values into fields without affecting values in 
the related fields.



Array Fit Copy
Menu: Edit|Copy Entities|Fit Array Toolbar: Standard, Copy fly-out

Use Array Fit Copy to arrange copies of selected objects into a two-dimensional array (rows and 
columns). The reference points of the outermost objects in the array will align to the edges of a rectangle 
that you define.
1. Select the object or objects that you want to copy.
2. Choose the Fit Array Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it.

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values in the XBound and YBound fields to specify the horizontal and vertical extents of the 
rectangle into which all the copies will fit.

Type values into the Rows and Columns fields to specify the number of rows and columns in the 
array.
4. Press <Enter> to create the copies.

Note: You can also specify the XBound and YBound values by defining a point relative to the selection in 
the drawing area using the mouse or Coordinate Fields. However, the number of rows and columns, as 
well as values for rotating and resizing the copies, must be specified in the Edit Bar first, unless you want 
to accept the current values.



Mirror Copy
Menu: Edit|Copy Entities|Mirror Toolbar: Standard, Copy fly-out

Use Mirror Copy to create a mirror image of an object on the opposite side of a line that you specify.
1. Select the object or objects that you want to copy. 
2. Choose the Mirror Copy tool.
3. Click in the drawing area or use the Coordinate Fields to define a point in the drawing area through 

which a mirror construction line will pass. (The line that appears in the drawing space looks and 
behaves like an angular construction line.)

4. Enter the angle of the mirror construction line in the Angle field, and press <Enter>. Alternatively, you 
can use the Coordinate Fields or click in the drawing area to define a second point through which the 
mirror construction line will pass.

TurboCAD will draw a mirror image of the selected objects at the same distance from the line on the 
opposite side.
Note: To mirror text you must first make sure the text is "flexible." You can change the setting of selected 
text in the Text sheet of the Properties dialog. 



Vector Copy
Menu: Edit|Copy Entities|Vector Toolbar: Standard, Copy fly-out

Use Vector Copy to place a copy of an object at a specified angle and distance from the reference point of
the original.
1. Select the object or objects that you want to copy.
2. Choose the Vector Copy tool.
3. Use the Coordinate Fields or click in the drawing area to define two points of a virtual line to specify 

the angle and distance of the copy from the original. This line appears in the drawing area as an 
arrow.

Alternatively, you can define the angle and distance of the vector directly in the Edit Bar and press 
<Enter>.



Edit Links
Menu: Edit|Links

Edit Links displays a dialog in which you can make changes to any linked OLE objects in the current 
drawing. OLE objects are created in other Windows applications and inserted into your TurboCAD 
drawing with the Insert|Object command. You can edit an OLE object within TurboCAD using the 
Windows application in which the object was created (the source application). For example, you can 
insert a Windows Paint object into your drawing and edit it within TurboCAD using the Windows Paint 
tools.
A linked object is one that retains its link to the file on which it is based. Changes to the OLE object affect 
the file, and changes to the file affect the object. These changes take place when the OLE object is 
updated. You can set each linked object so that the update happens automatically, or so that the update 
must be done manually.
The Links list box contains all the links in the active drawing. The changes that you make in the Edit Links
dialog affect any links that are highlighted in the list. You can highlight multiple links by holding down the 
<Shift> or <Ctrl> key and clicking in the list. The Links column in the list gives you the name and path of 
the file to which the OLE object is linked. The Type column tells you the name of the source application. 
The Update column tells you whether the link is set to be updated automatically or manually.
Update Option. These option buttons enable you to set whether the selected links are updated 
automatically or manually.
Update Now. This button updates the current link immediately. This is how you update a link if it is set to 
be manually updated.
Open Source. This button opens the source file in the application that created it. This enables you to 
compare the linked object to the source file, and it allows you to edit the file in the source application.
Change Source. This button opens a dialog that lets you choose a new source for the linked OLE object. 
Once the OLE object is linked to the new file, its contents will change to match the new file.
Break Link. This button terminates the link between the OLE object and its source file. Once the link is 
broken, the OLE object is treated as an embedded object. It is still an OLE object, but changes to it no 
longer affect the source file, and changes to the source file no longer can affect the object. Breaking the 
link also affects the size (in bytes) of your drawing, since the embedded object contains its own copy of 
the data in the object, while the linked object contains only a reference to the object.
See Also: Edit Object, Embedded and Linked OLE Objects, Insert Object



Edit Object
Menu: Edit|Object

Edit Object enables you to edit a selected OLE object in the object’s source application. 
1. Select an OLE object in your drawing. This object may appear as a document or a bitmap, or it may 

appear as an icon, depending on the options you chose when you inserted the OLE object.
2. Choose Edit|Objects from the menu, or simply double-click on the object.

Note: Other names can appear in place of Object on the Edit menu, depending on the OLE source 
application. If you select a Microsoft Word object, for example, the name on the menu will change to 
Document Object. For a bit-mapped image, a menu item entitled Linked Image Object will appear, with 
options that allow you to edit, open or convert the image. 
See Also: Embedded and Linked OLE Objects, Insert Object



Drawing Environment 
The View menu provides control over two aspects of the drawing environment. Using View menu 
commands, you may: 

Change the view of your drawing.
Modify your desktop by displaying and hiding toolbars and other interface controls. 

Note: There are several new view features in TurboCAD Learning Edition, when compared with previous 
versions. The new features include docking palettes, on-the-fly measurement commands, grid 
magnification options, insert viewport, and aerial view. The experienced TurboCAD user will find many 
productivity improvements in these new features. 

Subtopics
Views of the Drawing Space
Zooming
Panning
Inserting Named Views with Insert Viewport
Aerial View
Grid Magnification and Set Origin
Setting Up the Desktop
View Menu Commands



Views of the Drawing Space 
The TurboCAD drawing space is your creative surface. It is a plane on which you place drawing entities 
and other objects. A view is the area of the drawing space that appears on your screen. As your drawing 
becomes larger and more complex, it’s important to find views that let you work at the right location in 
your drawing, at an appropriate level of detail. You may need to concentrate your work within a tiny 
portion of the drawing, you may need to pull back and see all the objects on the drawing, or you may 
need to see the drawing at the size it will be when printed. TurboCAD offers a variety of options for 
panning and zooming that get you quickly to the exact view that you need. 
If you arrive at a view that you want to return to later, you can save it as a Named View, then return to that
view at any time. If you need to see a close-up of two parts of the drawing at the same time, or you need 
to see both a close-up and a broad overview, use either Aerial View or Insert Viewport (in the Insert 
Menu). 
Note: Aerial View is especially useful if you do not have a large monitor.    
Tip: Another powerful way to control your view of the drawing is by selectively viewing layers. You can 
control the viewability of layers through the Options|Layers property sheet.
See Also: Layers Property Sheet, Named View Dialog



Zooming
Zooming means to move in or out of the drawing space, viewing the drawing at a greater or lesser level of
detail. The View menu provides a number of zooming commands, which are discussed in Zoom 
Commands .
One quick and easy way to zoom is to use the plus and minus keys of the numeric keypad: plus zooms in 
one step; minus zooms out one step. The amount that you zoom in each step depends on the zoom 
factor, which by default is set to two. You can set the zoom factor in the Options|Program Setup dialog.
Notes: When you zoom in and out using the plus and minus keys of the numeric keypad, the view 
centers on the mouse cursor. If you zoom in using the menu command, you will zoom in on the center of 
the current view, regardless of the position of the mouse cursor. 
As you zoom out, TurboCAD simplifies the representation of very small objects on the screen to increase 
redraw speed. You can set the size at which this occurs using the Suppress Display... control on the 
Options|Display property sheet.
Tip: To zoom in on a particular point in the drawing and place it at the center of the screen, place the 
mouse cursor over the point and press the <+> key on the numeric keypad.
See Also: Display Property Sheet, Program Setup Dialog, Zoom Commands 



Panning 
Panning means to move the view to another location across the plane of the drawing. TurboCAD provides
several different options for panning, which are discussed in Pan Commands . 
Two simple ways of panning are to use the scroll bars or arrow keys. The scroll bars work the same way 
that they do in other Windows programs. You can click the scroll bar arrow buttons to scroll one step, click
in the body of the scroll bar to scroll about one third of a screen, or drag the "thumb" of the scroll bar to 
move quickly across the drawing. The arrow keys are also simple and intuitive: press the up, down, left, or
right arrow key to pan a single step.
Tip: To quickly pan to a specific point, place the mouse cursor at the point, then press <Ctrl>+<End>. You
will instantly move to a view with the point you chose at the center of the screen. 



Inserting Named Views with Insert Viewport
As mentioned earlier, it is possible to name specific views, then adjust the screen to that particular view. 
New in TurboCAD Learning Edition is the ability to display a named view on the drawing area, using the 
Insert Viewport command. This feature allows you to see the exact contents of a named view without 
dedicating the entire screen to it. 
Using Insert Viewport requires that one or more named views have already been created. Instructions on 
using Insert Viewport are found in Insert Menu Commands . 
Tip: Named views are accessible from the Views toolbar.



Aerial View
Aerial View is a window you open to provide a second view of the drawing. You may use Aerial View to 
have a close-up view of one small part of the drawing, or of the entire drawing. 
You can use the Aerial View to adjust the view in the drawing screen, without changing the Aerial View. 
Five drawing tools and a cursor-based tool make it easy to maintain two views of your work, adjusting it 
as necessary. 



Grid Magnification and Set Origin
New in TurboCAD Learning Edition’s View menu are commands to modify the grid without returning to 
Drawing Setup. You may double or halve the current distance between grid lines, toggle the display of the
grid, or change the origin of the grid.
Tip: The grid magnification and set origin features are also available as a toolbar. 



Setting Up the Desktop
In TurboCAD you can set up the user interface to suit your own preferences, or to fit the requirements of a
particular drawing task. You do this by selectively displaying and hiding toolbars and other interface 
controls, and by positioning or "docking" toolbars and other movable controls, such as palettes, on the 
TurboCAD desktop. 
Tip: You can control whether TurboCAD saves your desktop arrangement when you exit by setting the 
Save Desktop on Exit option in the Program Setup dialog. 
See Also: Program Setup Dialog, TurboCAD Desktop 

Subtopics
Displaying and Hiding Controls
Docking Toolbars
Docking Palettes



Displaying and Hiding Controls
The View menu provides a number of commands for displaying and hiding interface controls such as the 
Edit Bar, Status Bar, Aerial View, and Rulers. Each of these commands is a toggle, which means that it 
acts as an on/off switch. If the menu command is displayed with a check mark, the control is currently 
displayed. If the menu command is displayed without a check mark, the control is hidden. 
You can display and hide TurboCAD toolbars through the Options|Toolbars and Menus property sheet, 
which is also accessible through the View|Toolbars command.
Tip: It’s generally a good idea to set your preferred settings in the Options|Toolbars and Menus property 
sheet, and then use the View menu to show and hide individual controls as you work.
Tip: Many of these viewing commands are now available on the view toolbar. 
See Also: Desktop Property Sheet 



Docking Toolbars 
You can move any toolbar, or the Edit Bar, by positioning the mouse over its edge and dragging it to 
another position. There are four places on the TurboCAD screen where you can "dock" toolbars: the 
upper toolbar area, just below the menu bar; the left or right edge of the screen, which expands to form a 
vertical docking area; and the bottom of the desktop. When you dock a toolbar on the upper or lower 
sections of the screen it will be oriented horizontally. If you place it along the left or right edge of the 
screen it will be positioned vertically. Toolbars placed over the drawing area will be contained in their own 
window, which acts as a floating palette. A floating palette is always visible in front of your drawing.
Note: The Edit Bar and the toolbars that contain text fields (Property and Text Format), cannot be 
positioned vertically.



Docking Palettes
New in TurboCAD Learning Edition are docking palettes for symbol libraries, blocks, selection information,
and measurement. 
You may toggle a docking palette between being docked and floating over the drawing area by double-
clicking on the margin just inside the boundaries of the palette window. You can also drag the name tab at
the bottom of the palette into the center of the drawing area to float the palette. You can re-dock a floating 
palette by dragging it to the side of the screen. Docking palettes can attach to either side of the desktop, 
but not the top or bottom. 



View Menu Commands
The following table summarizes the commands you can access from the View menu:

Command Function
Redraw Manually refresh a drawing that has changed. 
Zoom Access tools and commands for moving your view closer to 

or further away from an area of the drawing. 
Aerial View Navigate zoomed views by use of a small overall view. 
Pan Commands Pan to Point and Vector Pan let you either pick a point in the 

drawing and move it to the center of the screen, or pick a 
point in the drawing and move it to a particular location on the
screen. 

Named View Save your current view under a name, or move to a 
previously named view. 

Create View Use selection rectangle to pick an area on the screen to save
as a named view. 

Previous View Return to the previous view of the drawing. 
Grid Access commands to display, reorient and resize the grid. 
Cursor Set cursor style and aperture display. 
Margins Display or hide the Margins. 
Background Display or hide the Background. 
Rulers Display or hide the Rulers. 
View Status Bar Display or hide the Status Bar. 
View Edit Bar Display or hide the Edit Bar. 
Toolbars Display the Desktop property sheet in which you can display 

or hide toolbars.
View Symbol Library Display or hide the Symbol Library palette. 
Blocks Display or hide the Blocks palette. 

View Selection Info Display or hide the palette of information about the currently 
selected object.

View Measurement Info Display or hide the measurement data palette. 



Redraw 
Menu: View|Redraw Hotkey: <F5>  Toolbar: View 

In most cases TurboCAD will automatically redraw your screen whenever the drawing changes. 
Occasionally, however, you may find that the screen is not completely "cleaned up" after a drawing or 
editing operation. If this happens, you can manually redraw the screen using the Redraw command. 



Zoom Commands
Menu: View|Zoom Toolbar: View 

The Zoom commands and tools let you "zoom" into your drawing to view detail areas close up, or pull 
back to view larger areas of your drawing. The following table summarizes the Zoom commands and 
tools:

Command Action 

Zoom In Move one step into the drawing. 
Zoom Out Move one step further from the drawing. 
Zoom Window Activate the Zoom Window tool to select an area to view.
View Extents Zoom to a view that contains all of the objects in the drawing. 
Full View Return to "starting" view of the drawing. 
View Printed Size View the drawing at the size it will be when printed.

Zoom In
Menu: View|Zoom|Zoom InHotkey: <+> Numeric Keypad  Toolbar: View 

The Zoom In command magnifies the current view of the screen. The scale of magnification is determined
by the zoom factor, which by default is equal to two. You can reset the zoom factor in the General 
property sheet of the Options|Program Setup dialog.
Note: If you zoom in using the menu command, you will zoom in on an area centered on the current view.
If you zoom in using the <+> key on the numeric keypad, you will zoom in to an area defined so that the 
mouse cursor is kept in the same relative position within the view rectangle. 
See Also: Program Setup Dialog



Zoom Out
Menu: View|Zoom|Zoom Out Hotkey: <-> Numeric Keypad Toolbar: View 

The Zoom Out command backs away from the area where the mouse cursor is currently located. The 
amount that the view pulls back in each step is determined by the zoom factor, which by default is equal 
to two. You can reset the zoom factor in the General property sheet of the Options|Program Setup dialog.
Note: If you zoom out using the menu command, you will zoom out to an area centered on the current 
view. If you zoom out using the <-> key on the numeric keypad, you will zoom out to an area defined so 
that the mouse cursor is kept in the same relative position within the view rectangle.
See Also: Program Setup Dialog 



Zoom Window
Menu: View|Zoom|Zoom WindowHotkey: <Ctrl>+<Home> Toolbar: View 

The Zoom Window tool enables you to select a rectangle area of the screen and zoom in to a view of that 
area. To use this tool: 
1. Activate the Zoom Window tool. 
2. Click to specify one corner of the zoom window. 
3. Move the mouse cursor to the point where you want to place the diagonally opposite corner of the 

zoom window, so that the zoom window encompasses the area that you want to view. 
4. Click to specify the opposite corner of the window. TurboCAD will immediately zoom in on the area 

that the zoom window encloses. 

You can also drag the mouse to create the zoom window, in which case your view will zoom in 
immediately after you release the mouse button.
Note: Because the dimensions of the zoom rectangle will probably not be exactly proportional to the 
screen, TurboCAD chooses the closest view based on the zoom rectangle you define. 



View Extents
Menu: View|Zoom|ExtentsHotkey: <Ctrl>+<Backspace> Toolbar: View 

View Extents zooms to a view of the smallest area of your drawing that completely contains all of the 
objects in your drawing. This is the same as the area enclosed by the selection rectangle if you select all 
the objects in the drawing. 



Full View
Menu: View|Zoom|Full ViewHotkey: <Shift>+<Backspace> Toolbar: View 

Full View sets the view to the full drawing page. 



View Printed Size
Menu: View|Zoom|Printed Size Toolbar: View 

The View Printed Size command takes you to a view of the drawing at approximately the size it will be 
when printed. In this view one inch of screen space is approximately equal to one inch on paper.
Note: The exact correspondence of screen space to paper space will vary, depending on your graphics 
display and screen resolution. 



Aerial View Command
Menu: View|Aerial  Toolbar: View

Aerial View provides a second viewport of the drawing area. It may display any part of the drawing you 
select. Only one aerial view can be open on the desktop. 
To create an aerial view:
1. Select Aerial View from the view menu or the view toolbar. 
2. Click to specify one corner of the aerial view window. 
3. Move the mouse cursor to the point where you want to place the diagonally opposite corner of the 

window, so that the window encompasses the area that you want to view. 
4. Click to specify the opposite corner of the window. TurboCAD will immediately create the aerial view 

window, displaying the view you selected. You can also drag the mouse to create the aerial view 
window, in which case your view will be created immediately after you release the mouse button.

You may move or resize the aerial view window as you would any other window: Drag the title bar to 
move the window; drag a border or corner to resize the window. 

Subtopics
Aerial View Tools



Aerial View Tools
Menu: In window of View|Aerial View 

Five tools appear in a toolbar just beneath the Aerial View’s title bar. A sixth tool is cursor-based. Note 
that the five tool icons are in two groups. The first three affect the view inside the aerial view window; the 
last two are used inside the aerial view window, but affect the drawing. 
Aerial Zoom In. Move one step into the aerial view.
Aerial Zoom Out. Move one step back from the aerial view.
Aerial Zoom Extents. Zoom to an aerial view containing all objects in the drawing.
Aerial Zoom Window. Select a new view for the drawing window with a selection rectangle in the aerial 
view. 
Aerial Pan View. Select a new drawing view at the same scale moving the red rectangle that appears 
inside the aerial view window. 
Aerial Cursor Pan. Adjust aerial view with cursor. Place the cursor just inside a border of the aerial view 
window. After a pause, the cursor will change to a small solid arrow and start panning the drawing in the 
direction the arrow points. Move the cursor away from the edge to end panning.
Note: You can roll up or roll down the Aerial View window    by clicking the roll-up button (similar to the 
minimize button in most Windows applications) on the title bar. You can also right-click the Title bar to turn
MultiPicker option ON, which enables the Aerial View Window to be used across multiple drawings. 



Pan Commands 
The Pan commands and tools move your view across the drawing area, in any direction. The following 
table summarizes the Pan commands and tools.

Command Function 

Pan to Point Choose a point and scroll the drawing so that the point is at the 
center of the screen. 

Vector Pan Choose a point and a destination and scroll the drawing so that 
the point moves to the destination.

Pan to Point 
Menu: View|Pan to Point Hotkey: <Ctrl>+<End> 

Use the Pan to Point feature to choose a point on the screen and scroll the drawing so that the point you 
chose moves to the center of the screen. This feature is available from the menu as a tool and from the 
keyboard as a command. To use the menu version of the feature: 
1. Choose View|Pan to Point to activate the Pan to Point tool. The cursor will change to an arrow 

pointing to the center of a small crosshairs icon. 
2. Click on any point in the drawing. This point will move to the center of the screen. 

To use the keyboard Pan to Point command, place the cursor at a point on the screen and press 
<Ctrl>+<End>. The point at the location of the cursor will scroll to the center of the screen. 



Vector Pan 
Menu: View|Vector Pan 

Use the Vector Pan tool to choose a point and a destination, and scroll the drawing so that the point 
moves to the destination. To use Vector Pan: 
1. Activate the Vector Pan tool. 
2. Click at any location in the drawing area. This specifies the location of the point that you would like to 

move (the base point). 
3. Move the cursor to the destination point and click. The drawing will scroll so that the base point 

moves to this destination.



Named View Dialog 
Menu: View|Named View Toolbar: View

Once you have used the zoom and pan features to arrive at exactly the view of your drawing that you 
want, you won’t want to repeat all that work to get back to the same view later. You can use the Named 
View dialog to save a view so that you can return to it at any time. Named views are saved with your 
drawing and remain available until you explicitly delete them.
See Also: Create View
To save a view under a name: 
1. Use the zoom and pan commands to arrive at the view you want to name. 
2. Choose View|Named View from the menu to display the Views dialog. 
3. Click in the Name text box and type a name for the view. The name can be up to 128 characters in 

length and can include spaces. 
4. Click the New button to add the name to the list of named views.

Tip: Give the view a descriptive name that will help you remember it, such as "Door Leading to Garden." 
If you use names like "View 1" and "View 2," you’ll quickly lose track of which is which. 

Subtopics
Returning to a Named View
Deleting a Named View
Modifying a Named View



Returning to a Named View 
To return to a view that you have previously saved under a name: 
1. Choose View|Named View from the menu, or the View toolbar, to display the Views dialog. 
2. Select a view in the Name list box, then click the Go To button to go to that view. The view will change

while the dialog box is open, so you can check the screen to see if the view is correct without leaving 
the dialog. 

3. When you have found the view you want, click the Close button to leave the dialog. 

To immediately go to a named view and close the dialog, double-click on the name of the view. 



Deleting a Named View 
To delete a named view that you no longer need: 
1. Choose View|Named View from the menu to display the Views dialog. 
2. Select a view in the Name list box, then click the Delete button to delete the view. Click the Close 

button to leave the dialog. 



Modifying a Named View 
The modify button of the Named View dialog allows you to replace a view that you have selected in the 
list. To do this: 
1. Use the zoom and pan tools to go to a view with which you want to replace a currently named view. 
2. Choose View|Named View to display the Views dialog. 
3. In the list box, select the named view that you want to replace. 
4. Click the Modify button. Your current view will replace the named view that you selected. 



Create View 
Menu: View|Create View Toolbar: View

The Create View tool enables you to select a rectangular area of the screen and save this area as a 
named view. You can use this view as you would any other named view created with the Named View 
tool. 
To use the Create View tool: 
1. Choose Create View from the View menu. 
2. Click to define one corner of the rectangular area that you want to save as a named view. 
3. Move the mouse cursor to the point where you want to place the diagonally opposite corner of the 

rectangle and click: The Create Named View dialog will appear.
4. Type a name for the new view in the text box, then click OK to save the named view and close the 

dialog.

See Also: Named View Dialog 



Previous View
Menu: View|Previous View  Toolbar: View

The Previous View command returns you to the previous view of the drawing. 
Tip: This command is particularly useful if you want to switch back and forth between two views without 
using Aerial View.



View Grid Options 
Menu: View|Grid Toolbar: Snap/Grid

The View Grid commands control the display of the drawing grid. The grid is a pattern of dots, crosses, or 
lines that divides your drawing space geometrically into Cartesian, isometric or polar coordinate locations.
You can define points at positions on the grid using the Snap to Grid snap mode. You can set the spacing,
type, and display parameters of the grid in the Options|Grid property sheet.
The following table summarizes the grid commands and tools: 

Command Function
Display Toggles the grid display on/off.
Size * 2 Doubles the distance between grid points.
Size / 2 Halves the distance between grid points.
Set Origin Changes the location from which the grid originates.

Tip: Use Set Origin to have the grid line up with a corner or other strategic point on an object in your 
drawing, then set the grid distance to a logical interval for the project. 
Note: Making the grid visible or invisible does not affect whether the grid is active. The grid can be visible 
and inactive, and it can be invisible and active. To control whether the grid is active, use the Snap to Grid 
command from the Modes|Snaps menu, the Snaps toolbar, the local menu, or the keyboard equivalent 
<G>. 
See Also: Coordinate Systems, Grid Property Sheet, Snap Modes, Using Single Entry Keyboard 
Equivalents 



Cursor View Commands
Menu: View|Cursor 

Two cursor view options are available: Aperture and Crosshairs. Both function as toggles. 

Subtopics
View Aperture
View Crosshairs



View Aperture
Menu: View|Cursor|Aperture

When selected, Aperture displays the snap aperture, a circular area surrounding the cursor. An entity (or 
grid point) must be inside the circle in order for a snap command to find the entity or grid point. The 
aperture is always active; this command merely toggles the view of the aperture. 
Tip: You can set the radius of the snap aperture in the Options|Program Setup dialog. 



View Crosshairs
Menu: View|Cursor|Crosshairs

Crosshairs changes the drawing cursor from a small cross to one that stretches across the entire drawing 
screen. By extending the crosshairs, you can often more clearly identify how the current location of the 
cursor corresponds to the ruler and to other objects in the drawing. 
See Also: Program Setup Dialog 



View Margins 
Menu: View|Margins 

The View Margins command is a toggle that displays and hides the Margins. Margins, the dotted 
rectangle inside the edges of the paper, let you know whether you are drawing inside or outside the 
printable area of your drawing.

See Also: Drawing Setup Dialog 



View Background    
Menu: View|Background 

The View Background command is a toggle that displays and hides the Background. 



View Rulers 
Menu: View|Rulers 

The View Rulers command is a toggle that displays and hides the Rulers. Rulers are displayed along the 
top and left edges of the screen and show the measurements of your drawing in Page or World units. You
can change between Page and World units by clicking the Paper/World button located near the upper-left 
corner of the drawing area at the intersection of the horizontal and vertical rulers. 
You can change the units and scale of the drawing in the Units and Scale property sheet of the Options|
Drawing Setup dialog. The rulers will change to reflect the current scale and display. 
See Also: Drawing Setup Dialog 



View Status Bar 
Menu: View|Status Bar

The View Status Bar command is a toggle that displays and hides the Status Bar. The Status Bar is 
displayed along the bottom of your screen. It contains a brief status message, the Coordinate Fields, and 
a zoom percentage box on its right side, which displays the zoom percentage of your current view. At 
printed size, the drawing’s zoom percentage is 100. 



View Edit Bar 
Menu: View|Edit Bar 

The View Edit Bar command is a toggle that displays and hides the Edit Bar. The Edit Bar is a control that
enables you to create and edit entities by entering distances, angles, and other data directly into the Edit 
Bar fields. You can drag the Edit Bar and place it anywhere in the tool area under the menu bar, or at the 
bottom of the screen. You can also place the Edit Bar over the drawing space, where it will float over the 
drawing as a palette. 
Tip: Although you can draw in TurboCAD using only the mouse, many drawing and editing tools are more
accurate if you work in the Edit Bar, and some tools have limited use without the Edit Bar. You will 
probably want to keep the Edit Bar visible at all times. 
Note: The fields in the Edit Bar change dynamically, depending on the currently active drawing or editing 
tool. The number of fields varies, so it’s a good idea to place the Edit Bar toward the left edge of the 
screen so that all the fields will always be visible.
See Also: Drawing with the Edit Bar 



View Toolbars 
Menu: View|Toolbars

The View|Toolbars brings up the Options|Toolbars and Menu Property Sheet. You may add or remove 
toolbars from the desktop. In TurboCAD Learning Edition you can also change their appearance, or even 
create custom toolbars. 



View Symbol Library
Menu: View|Symbol Library 

The View Symbol Library command displays the Symbol Library palette. The Symbol Library palette 
shows the symbols available in any library you have opened. 
Symbols are pre-drawn objects available for repeated use. In TurboCAD, symbols can be fully 
independent TurboCAD (or other CAD) drawings. You can draw an object that you intend to reuse, save it
as a drawing, then pick it from the symbol library palette when working on future projects. Any folder in 
Windows containing vector drawings can be recognized by the symbol library palette. 
TurboCAD will recognize an individual drawing file as a symbol, and can display it in the symbol library 
palette. TurboCAD also allows you to create a symbol library file, containing several related objects, and 
can display the contents in the symbol library palette. 
To identify a symbol in the palette, move the cursor over it. A tool tip will identify the symbol by name. To 
see the symbol’s path name, right click on the symbol’s icon. 
New in TurboCAD Learning Edition is the ability to dock the Symbol Library palette the way you would a 
toolbar. To switch between a floating palette and a docked palette, double-click on the margin that 
separates the outside boundaries of the palette from the interior (raised) sections, or drag this area to the 
center of the screen.
The title and description of the symbol is determined by information entered into the Summary Info dialog 
when the symbol is first created. The Title field of the Summary Info dialog determines the text that 
appears under the icon. The Subject field determines the icon description. 
When the Symbol Library palette is open, you can: 

Place a symbol by dragging and dropping it onto the drawing. 
Turn a selected part of your drawing into a symbol, using drag and drop. 
Change to another open symbol library using the drop-down list. 
Open a new symbol library using the Open button on the palette. 
Change your view of the Symbol Library. 

See Also: Symbol Libraries Property Sheet, Summary Info Dialog 

Subtopics
Placing a Symbol in a Drawing
Symbol Management Options
Naming New Symbols
Storing New Symbols
Turning a Selection into a Symbol
Changing to Another Symbol Library
Changing Your View of a Symbol Library



Placing a Symbol in a Drawing
To place a symbol in your drawing, simply drag it out of the Symbol palette and drop it in your drawing. 
The symbol will be placed in the drawing at the point where you release it. The symbol will remain 
selected after you place it, so that it can be repositioned and scaled. You may need to click the symbol 
after you drop it into the drawing, to restore the focus of the program on the drawing area, if you intend to 
scale or move it.  
The symbols that IMSI provides with TurboCAD are groups. This means that they have names, which 
makes them easier to keep track of, and it means that they can be selected and manipulated as a single 
unit. 
Warning: Don’t expect all symbols to be this well-behaved. A symbol is just a TurboCAD drawing, and it 
won’t be a group unless the person who created the symbol saved it as a group.



Symbol Management Options
Any TurboCAD drawing can be a symbol. To create your own symbol library, all you need to do is save all 
the drawings that comprise the library into a single Windows folder. However, another equally good way to
save symbols is to drag selections from drawings into the Symbol palette. This gives you the additional 
option of saving only part of an existing drawing as a symbol.
Before you start saving drawings or drawing parts as symbols, you need to plan your file management 
strategy. There are two fundamental decisions to make: How to name the symbols, and where to store 
them.



Naming New Symbols
Every new symbol must be given a name. You can have TurboCAD generate a name, or you may assign 
one. The Auto-Naming property sheet (Options|Auto-Naming) is used to set which method you prefer. 
Auto-naming controls the naming process for Groups, Blocks, and Symbols. For symbol libraries, three 
command settings need to be considered. 
Generate Symbol Name. If this item is checked, TurboCAD will automatically assign a name to the 
symbol. The prefix listed in the "Symbol Name Prefix" text box will be used as the first part of the symbol 
name, followed by a sequence number in place of the @ symbol (0 for the first symbol, 1 for the second 
symbol, and so on). If this item is not checked, TurboCAD will prompt you to provide a name for the 
symbol.
Prompt for Library Locations. If this selection is checked, TurboCAD will give you the opportunity to 
specify a folder for the symbols you have created. You may save each symbol as soon as you create it 
(by clicking the Save Symbol tool in the Symbol Library palette), or wait until you close the active drawing 
(to save all the new symbols at once). If Prompt for Library Locations is not checked, the symbols you 
create during a drawing session will be saved to the default (pre-selected) folder.
Symbol Name Prefix. If Generate Symbol Name is selected, each symbol you save will be named with 
the prefix listed here, followed by a sequence number in place of the @ symbol. 



Storing New Symbols
If the Options|Auto-Naming|Prompt for Library Location option is checked, a special Save As dialog for 
symbols will appear when symbols are saved. 
The options in the Save As dialog work as follows: 
Library File (*.SLW). A TurboCAD Library file is a drawing saved with the .SLW extension instead of 
the .TCW extension. TurboCAD will display the contents of an .SLW file in the Symbol Library palette just 
as it will the contents of any other windows folder containing drawing files. The advantage of using .SLW 
files is that many symbols can be saved to disk under one unifying name. 
Library Folder. Use this option to select any Windows folder as the storage location for symbols. The 
advantage of storing symbols by folder is that you can combine symbols created at different times into 
one storage area.
Note: If you save a .SLW file in a folder used to store symbols, it will appear as a separate library in the 
Symbol Library.



Turning a Selection into a Symbol
1. Select the parts of your drawing that you want to turn into a symbol. (If you want to drag your entire 

drawing into the Symbol palette, choose Edit|Select All.) 
2. Before dragging it into the Symbol palette, it’s a good idea to group the selection by choosing Format|

Create Group. (This isn’t strictly necessary, but it will make the symbol easier to work with later.) 
3. Hold the mouse over the selection’s reference point (the yellow dot in the middle of the selection). 

You will know the mouse is in the right position when the cursor turns into a four-directional pointer.
4. Hold the mouse button down and drag the selection into the Symbol palette. Release the mouse 

button to drop the selection. An icon for the symbol will appear in the palette. 
5. You may save the symbol as a file now. Click the Save tool at the top of the palette. You have the 

option of navigating to another folder, which will have the effect of placing the symbol into a different 
symbol library. If you put it in a folder that isn’t already a symbol library, TurboCAD will open a new 
symbol library in your drawing. 

See Also: Save As Dialog 



Changing to Another Symbol Library 
You can quickly switch between active symbol libraries open in your drawing. Open a different symbol 
library in the Symbols Folder list box, just above the display of symbols in the Symbol Library palette. To 
view the list of available libraries, click the list box display arrow. To switch to another library, click on its 
name in the list box. The contents of that library will then be displayed in the Symbol palette. 



Changing Your View of a Symbol Library 
The Symbol palette can display its symbols as icons, small icons, or as names. To switch between these 
three options, click the appropriate icon:

Names 
Small Icons
Large Icons 

When symbols are displayed either as icons or small icons, the Windows tool tip feature is available to 
provide additional information about any symbol. Place the cursor on any symbol to view its name. Right-
click on a symbol to see its file path name (folder location). 



View Blocks 
Menu: View|Blocks Toolbar: View

Blocks are similar to groups, in that they consist of a collection of entities unified into a single object. But 
while each group is a separate object in your drawing, blocks are stored in your drawing’s block library 
and then inserted into your drawing. Each block insert is a reference to the block in your drawing’s block 
library. Because each block insert is a reference to a block, the inserts take up very little memory space in
your drawing file. Blocks are therefore most useful if you want to store drawing objects that you will use 
more than once in a particular drawing. 
The View|Blocks command displays the Blocks palette.
Note: Block libraries are only available to a specific drawing. Symbol libraries are available to any 
drawing at any time. Drawing elements that you want available for repeated use from project to project 
should be saved as symbols for easy retrieval. 
See Also: Create Block, Groups and Blocks, Block Insertion Property Sheet 

Subtopics
Inserting Blocks
Drag and Drop Block Creation
Deleting a Block from the Palette
Changing Your View of the Block palette



Inserting Blocks 
To insert a block into your drawing, simply drag it out of the Block palette and drop it into your drawing. 
The inserted block will be selected after you place it, so that you can move, scale, or rotate it. 



Drag and Drop Block Creation 
You can create a block by dragging any selected objects into the Block palette. 
1. Select the objects that you want to turn into a block. 
2. Place the cursor over the selection’s Reference Point (the yellow circle at the center of the selection 

rectangle). The cursor turns into a four-directional pointer. 
3. Hold down the mouse cursor and drag the selection into the Block palette, then release the mouse 

button. If you have checked the Prompt for Name option in the Groups and Blocks property sheet, 
you will be prompted for a block name. If you have checked the Insert Blocks When Creating option, a
block insertion will be automatically inserted in place of the selection.

Note: Blocks will be created on the same layer as the objects found in the block. Additional placements of
this block will also be on the same layer. If you require the block to be on a specific layer, make sure to 
change this in Line Properties prior to creating the block. 



Deleting a Block from the Palette 
To delete a block from the palette, first click on the block name or icon to highlight it, and then click the 
Delete button (X mark) at the top of the palette. 



Changing Your View of the Block palette 
The Blocks palette can display its symbols as icons, small icons, or as names. To switch between these 
three options, click the corresponding button.

Names 
Small Icons
Large Icons 



View Selection Info 
Menu: View|Selection Info Toolbar: View

The View Selection Info command displays and hides the Selection Info palette. This palette contains 
information about the currently selected object, such as its entity type, dimensions, and location in the 
drawing. 
Like the Symbol Library/Blocks palette, the Selection Info palette can be docked into the desktop or 
allowed to float over the drawing area. To switch between docked and floating, double-click on the margin 
just inside the palette’s borders. You can also drag the name tab to float the particular palette while 
leaving the other palettes docked. 
The Selection Info palette contains two windows. The upper window shows the type and structure of the 
objects selected. If an object such as a group or block contains other objects, this relationship will be 
displayed in outline form. A plus sign next to an item indicates that it contains other items that are not 
displayed. To open the outline, and see what objects are contained, click on the plus sign; click again to 
close the outline to see a higher level of the hierarchy. 
The lower window displays precise data about whatever object is currently selected in the upper window. 
It shows the object’s graphic type, its coordinate location in the drawing space, and its dimensions in 
current World units. 
Pressing the Copy button copies this data to the Windows clipboard so that you can paste it into a word 
processor or text editor, such as Windows Notepad. The text that you copy contains special markers so 
that programmers, or very adventurous users, can "parse" the data in their own programs.
Note: Experienced Web users may notice that the markers are similar to those used in HTML. 



View Measurement Info
Menu: View|Measurement Info Toolbar: View

The View Measurement Info command displays and hides the View Measurement Info palette. This 
palette displays the results when any of the four Measurement commands are used.
Like the Symbol Library palette, the View Measurement palette can be docked into the desktop or allowed
to float over the drawing area. To switch between docked and floating, double-click on the margin just 
inside the palette’s borders. You can also drag the tab name to float the palette, leaving the other palettes
docked. 



Creating and Inserting Objects
The Insert menu gives you access to all of the TurboCAD drawing tools, as well as to dialogs that let you 
insert various types of objects into your drawing. You can use the drawing tools to create:

Drawing entities (such as lines, circles, and polygons). 
Construction entities (lines and circles that you use as reference points or to mark off areas in 

your drawing).
Hatch entities (brush patterns defined by a path)

You can also insert the following types of objects into your drawing:
Viewport (a different "camera" view of part of the drawing)
Files (all standard CAD file types).
Pictures (Windows metafiles or bitmaps).
OLE objects, which you can edit using other Windows applications.

Note: There are, in addition, two other types of objects that can be inserted into a drawing: blocks and 
symbols. You insert these directly from the Blocks and Symbols palettes, which you can display from the 
View menu.
See Also: View Blocks, View Symbol Library

Subtopics
Creating Entities
Insert Menu Commands



Creating Entities
To use any drawing tool you need to understand a set of common techniques. These techniques include:

Formatting objects by setting their properties.
Defining points by using the mouse in combination with snap modes, or by using the Coordinate 

Fields.
Specifying quantities, such as length and angle, using the Edit Bar.
Using SEKEs, Single Entry Keyboard Equivalents. 

See Also: Finishing and Canceling, Using the Local Menu.
For a more detailed discussion of how to apply the techniques in the process of creating an actual 
drawing, run the TurboCAD Quick Tour from the Opening screen, and look at the TurboCAD Guide to 
Learning CAD.

Subtopics
Formatting Entities
Defining Points and Specifying Measurements
Drawing with the Edit Bar
Using Single Entry Keyboard Equivalents
Finishing and Canceling
Changing Focus
Using the Local Menu



Formatting Entities
When you draw an entity in TurboCAD, the entity is formatted using the current properties of the tool in 
use. If you do not adjust these properties, the TurboCAD defaults will be used. These properties include, 
among many other things, the width, style, and color of the pen, as well as the pattern and color of the 
brush. In addition to these common properties, some types of entities, such as text, double lines, curves, 
and dimensions, have properties that belong only to the specific entity type. To set the properties for a 
drawing tool, you can activate the tool and choose Format|Properties, or you can simply right-click on the 
drawing tool.
Once an entity is drawn, you can format it by changing its properties. To do this, first select the entity, then
choose Format|Properties; or simply activate the Select tool, then double-click on the entity that you want 
to format (or select the entity, then choose Format|Properties).
Note: You cannot access or change the properties of Construction Entities (construction lines and 
circles). You can, however, edit the color and line style via the layers dialog.
See Also: Setting Properties, Property Toolbar, Properties Dialog



Defining Points and Specifying Measurements
To create any entity you must use some combination of the following three methods:

Define points by clicking the mouse in the drawing area, using snap modes.
Define points by entering their coordinates in the Coordinate Fields.
Specify measurements (lengths, angles, and sometimes other information) in the Edit Bar.

Almost always, the first step in drawing any entity is to define its starting point. After the first point is 
defined, you create the entity by defining a series of points and/or specifying measurements.
For example, to draw a circle using the Center and Point tool, you first need to define a point for the 
center of the circle. After this point is defined, you have three ways of completing the circle: 

Define any point that will be on the perimeter of the circle using the Coordinate Fields or mouse.
Specify the radius of the circle in the Edit Bar.
Specify the circumference of the circle in the Edit Bar.

The method you choose depends on the specific characteristics of the tool you are using, the drawing 
task, and your own preferences. 
Warning: Trying to draw an entity in the Edit Bar without defining the entity’s starting point can 
sometimes lead to confusing results. It’s almost always simpler to start drawing an entity by defining its 
starting point.

Subtopics
Defining Points with the Mouse
Defining Points Using the Coordinate Fields



Defining Points with the Mouse
In a sense, you define points with the mouse by simply pointing and clicking. However, what exactly 
happens when you define a point this way depends on snap modes and on TurboCAD's Ortho setting. 



Using Snap Modes
The result you get when you click the mouse in the drawing area depends, in part, on the current snap 
mode. If your snap mode is currently set to No Snap, then the point will simply be defined at the position 
where you clicked the mouse. Otherwise, the location of the point will be calculated relative to a drawing 
object or to the grid. If there is no point to snap to based on the mouse position, TurboCAD will beep, and 
it won't define a point at all. To find out how to change snap modes, see Setting Snap Modes and Ortho.
See Also: Snap Modes 



Constraining Angles with Ortho
To constrain angles when you are drawing with the mouse, use Ortho mode. You can activate Ortho 
through the Modes menu, the Snap toolbar, or the local menu. The local menu turns Ortho on or off only 
until the next point is defined; TurboCAD then reverts to the Ortho setting in the Modes menu. 
If you are using TurboCAD's default settings, Ortho restricts lines to orthogonal (vertical and horizontal) 
angles. You can configure Ortho mode to less restrictive settings in the Angle property sheet (choose 
Options|Angle). Some CAD users, for example, prefer to restrict angles to increments of 15 degrees.
See Also: Angle Property Sheet, Ortho
Tip: Another convenient way to turn Ortho on or off temporarily is to hold down the <Shift> key while 
drawing. 



Setting Snap Modes and Ortho
You can change snap modes and Ortho mode any time, even while you are in the middle of drawing an 
entity. For example, to create a spoke on a wheel you could snap the first point of a line to the center of a 
circle, then snap the second point of the line to a point on the perimeter of the circle. To set a default snap
mode, use the Snaps toolbar or the menu; to set a "one shot" snap mode that stays in effect until you 
define the next point, use the local menu or press a SEKE – Single Entry Keyboard " Equivalent. To use 
the local menu, click the right mouse button in the drawing area to open the menu, choose the desired 
snap mode, then click the mouse to define the point. To use a SEKE, press the key that matches the snap
you need. 
Note: Both the local menu and SEKEs give you "one shot" mode changes. If you select a snap command
using either method, the mode will change back to the setting in the Modes menu after you define the 
next point.



Defining Points Using the Coordinate Fields
In addition to using the mouse with snap modes and Ortho, you can also define points by entering them 
directly into the Coordinate Fields and then pressing <Enter>. Points defined in the Coordinate Fields are 
always defined at the exact coordinate positions specified, regardless of the snap mode. The type of 
coordinates you type in the Coordinate Fields depends on the coordinate system you are using. In the 
absolute and relative coordinate systems you use X,Y coordinates. In the polar coordinate system you 
enter an angle and distance.
You can lock down the coordinates in the Coordinate Fields, so that the values in the boxes don’t change 
when you move the mouse cursor over the drawing area. To do this, check their lockdown boxes (these 
are immediately to the left of the fields), or select either "Lock X Position" or "Lock Y Position" from the 
Modes Menu. 
See Also: Coordinate Fields, Coordinate Systems
Tip: The Coordinate Field lockdown boxes are particularly useful when you lock down just one field. If you
enter a value in just one of the fields and lock it down, you can then set the second coordinate using the 
mouse. This makes it easy to define a series of points along a specific horizontal or vertical line.



Drawing with the Edit Bar
The Edit Bar lets you draw entities parametrically by specifying dimensions and angles. To do this, you 
must define a starting point for the entity that you are drawing. For example, to draw a regular polygon 
using the Edit Bar, define the center point of the polygon using the mouse or Coordinate Fields, and 
define the polygon’s number of sides, radius, and start angle in the Edit Bar.
Note: Creating or editing an entity with the Edit Bar ignores Ortho and snap mode settings. The entity will 
be defined using the exact values that you enter in the Edit Bar.

Subtopics
Using the Edit Bar Lockdown Boxes



Using the Edit Bar Lockdown Boxes
Many fields on the Edit Bar have lockdown check boxes, similar to those on the Coordinate Fields. When 
these boxes are checked, the values in the fields don’t change when you move the mouse over the 
drawing area. This makes it possible to lock down one of the values and manipulate the second value 
with the mouse.
For example, you might want to specify the exact radius of an arc in the Edit Bar, then use the mouse to 
determine the locations of the arc's starting and ending angles. After defining the starting point for the arc,
you could type its radius into the Edit Bar, then lock down the Radius field. This prevents the radius from 
changing when you re-enter the drawing area. You could then use the mouse and snap modes to 
determine the arc's starting and ending angles.



Using Single Entry Keyboard Equivalents
New in TurboCAD Learning Edition are Single Entry Keyboard Equivalents, or SEKEs. Now in addition to 
using the local menu as you draw, you can press a single key to access the most common snaps and 
other drawing aids. An example would be to close a multiline by pressing <V> for Vertex. The cursor will 
use Snap Vertex to attach the multiline to the nearest endpoint. 
Taking advantage of SEKEs means you can keep both hands busy, one hand on the mouse and one 
hand on the keyboard. A list of SEKEs appears in Local Snaps and SEKEs , which covers the Modes 
menu commands. 



Finishing and Canceling
Some entities are defined by a specific number of points. For example, you can draw a triple-point circle 
by defining three points. When you define the circle's third point, the circle is finished automatically.
Other entities, such as multilines and concentric circles, are composed of an indeterminate number of 
parts. You can add as many segments to a multiline, or as many circles to a set of concentric circles, as 
you like.
Users of earlier versions of TurboCAD may be confused by the way you cancel and finish such entities in 
TurboCAD Learning Edition. However, with a little practice you will find that TurboCAD Learning Edition is 
consistent and intuitive in the way it handles these operations. It will help the transition if you remember 
these rules:
Cancel always means to stop the current drawing operation and start over. It removes the entire entity 
you are currently drawing. For example, if you press <Esc> or choose Cancel from the local menu while 
you are drawing a multiline, the entire multiline will vanish, not just the last segment.
Finish means to complete the entire entity. For example, if you are creating a multiline you can finish the 
entity by (1) double-clicking, (2) pressing the right mouse button and choosing Finish from the local menu,
or (3) pressing <Ctrl>+<F> while working in the Edit Bar. 
Pressing <Enter> in the Edit Bar means to accept the current setting in the Edit Bar fields. If you press 
<Enter> while drawing a multiline, the settings in the Edit Bar will be used to draw the next segment of the
multiline. If you are creating an entity with a fixed number of steps, then pressing <Enter> in the Edit Bar 
will finish the entity, provided you have already defined a starting point.
Note: When you are working in the Coordinate Fields, pressing <Enter> simply defines a point as 
specified in the Coordinate Fields. 
Tip: Entities that can be closed geometrically, specifically the Multiline, Double Multiline, Bezier Curve, 
and Spline Curve tools provide another option for finishing. If you choose Close from the local menu, 
TurboCAD will complete the entity by drawing a line or curve from the entity’s last point to its first point.



Changing Focus
When you are drawing and editing, you will need to move back and forth between TurboCAD’s various 
controls, sometimes in the middle of an operation. You may start an entity by defining a point with the 
mouse, then continue by defining a point in the Status Bar, then set values in the Edit Bar, then return to 
the drawing area to complete the operation. You may even want to set up a construction line, zoom into 
an area of the screen, change the coordinate system, then return to the drawing area to continue an 
operation already in progress. 

Subtopics
Changing Focus with the Mouse
Changing Focus with the Keyboard



Changing Focus with the Mouse
Keep in mind that only one control on the screen can have the focus at a given time. When you move 
from control to control, you change the focus from one control to another. Generally speaking, users 
change the focus from one control to another by clicking the control they want to change to. If you are in 
the drawing area, you can move to the Edit Bar by simply clicking in one of its fields, or move to the 
Status Bar by clicking in one of its fields. Then you return to the drawing area by clicking there.
The tricky part is that when you return to the drawing area, you will probably want to reactivate it first, so 
that you can get appropriate feedback while you move your mouse, and only then continue the current 
operation. For this reason, you need to click twice. The first click reactivates the drawing area, restoring 
all feedback, and the second click actually continues the current drawing operation.



Changing Focus with the Keyboard
You can also move the focus between controls using the keyboard. Remember these keystrokes:

If you are in the drawing area or the coordinate fields, you can move the focus to the Edit Bar by 
pressing <Ctrl>+<E>.

If you are in the Edit Bar or the coordinate fields, you can move to the drawing area by pressing 
<Ctrl>+<D>.

If you are in the Edit Bar or the drawing area, you can return the focus to the coordinate fields by 
pressing <Ctrl>+<R>.
If you are in the drawing area you can also use <tab> or <shift + tab> to move to the Edit or Coordinate 
bars.
See Also: Defining Points and Specifying Measurements, Finishing and Canceling



Using the Local Menu
The local menu is context-sensitive. The specific commands and options available in the local menu 
change, depending on the currently active drawing or editing tool. Many of these commands and options 
are quite powerful, so it really pays to right-click in the drawing area and see what options are there when 
you are learning to use a drawing tool.
For example, when you are using the Text tool, the local menu lets you size and rotate the text "on the 
fly," and specify with great precision exactly where the text will be placed relative to the insertion point.



Insert Menu Commands
The Insert menu provides access to tools that let you draw entities and commands that enable you to 
insert pictures and OLE objects into your drawing. The following table summarizes the contents of the 
Insert menu:

Tool Function
Construction Create construction lines and circles to use as points of 

reference.
Point Draw single-point marker entities in various shapes.
Line Draw lines, rectangles, polygons, and lines tangent to circles and

arcs.
Double Line Draw double line segments, rectangles, and polygons.

Circle/Ellipse Draw circles and ellipses.
Arc Draw circular and elliptical arcs.

Curve Draw Bezier curves, spline curves, and freehand sketches.
Text Add single- or multiple-line text to the drawing.
Dimension Draw dimension entities.
Viewport Place a close-up view in the drawing.
Path Hatching Draw a hatched or filled area by defining its boundaries.
File Insert a CAD file into an open drawing.
Picture Insert images (bitmaps or metafiles) into the drawing.
Object Insert OLE objects into the drawing.



Construction Tools
Menu: Insert|Construction Toolbar: Standard, Construction Fly-out

The construction tools enable you to place temporary construction lines and circles on your drawing. 
Constructions are entities used for reference: You can define points in relation to constructions and use 
them to segment your drawing space. 
Tip: If there are existing entities in the drawing, it is generally best to use snap commands (from the local 
menu or a SEKE) to place constructions. 
Note: Constructions exist on their own layer of the drawing, called "$CONSTRUCTION". You can clear 
this layer with the Clear|Constructions command. You can clear an individual construction with the Edit|
Clear|Construction tool. The properties of constructions cannot be accessed or changed, but you can 
change their color and line styles via the layer dialog box.
The following table summarizes the Construction tools:

Tool Function

Angular Line Draw a construction line at any angle.
Horizontal Line Draw a horizontal construction line.
Vertical Line Draw a vertical construction line.
Center and Point Circle Draw a construction circle defined by its centerpoint and a 

point on its perimeter.
Double Point Circle Draw a construction circle that passes through two defined 

points 180 degrees apart.
Triple Point Circle Draw a construction circle that passes through three defined 

points.

Angular Construction Line
Menu: Insert|Construction|Angular Line Toolbar: Standard, Construction Fly-out

Angular construction lines intersect a point that you define at any angle. You can constrain the 
construction line to predefined angles using Ortho mode. To place an angular construction line in your 
drawing:
1. Activate the Angular Construction Line tool.
2. Define a point in the drawing space that the construction line will pass through. 
3. Define a second point. The construction line will intersect both points.

You can also define just the first point, specify the slant of the construction line in the Edit Bar, and then 
press <Enter>.



Horizontal Construction Line
Menu: Insert|Construction|Horizontal Line Toolbar: 
Standard, Construction Fly-out

To place a horizontal construction line in your drawing:
1. Activate the Horizontal Construction Line tool.
2. Define a point that you want the line to intersect. TurboCAD draws a horizontal construction line that 

intersects the point you have defined.



Vertical Construction Line
Menu: Insert|Construction|Vertical Line Toolbar: Standard, Construction Fly-out

To place a vertical construction line in your drawing:
1. Activate the Vertical Construction Line tool.
2. Define a point that you want the line to intersect. TurboCAD draws a vertical construction line that 

intersects the point you have defined.



Center and Point Construction Circle
Menu: Insert|Construction|Center and Point Circle Toolbar: 
Standard, Construction Fly-out

The Center and Point Construction Circle tool enables you to create a construction circle by defining its 
center point and any point on its perimeter: 
1. Activate the Center and Point Construction Circle tool.
2. Define a point for the center of the construction circle.
3. Do one of the following:

Define a point on the perimeter of the circle. TurboCAD will draw a circle with its center at the first
point, and its perimeter intersecting the second point.

Type the radius or circumference of the construction circle in the Edit Bar fields, then press 
<Enter>.



Double Point Construction Circle
Menu: Insert|Construction|Double Point Circle Toolbar: 
Standard, Construction Fly-out

Use the Double Point Construction Circle tool to draw a construction circle by defining two opposite points
on the circle’s perimeter:
1. Activate the Double Point Construction Circle tool.
2. Define a starting position, which will be a point on the perimeter of the circle.
3. Do one of the following:

Define a second point. The circle will be drawn through the two points, which will be 180 degrees 
apart. 

Type the circle's diameter (or its circumference) and angle of the circle’s diameter in the Edit Bar 
fields, then press <Enter>.



Triple Point Construction Circle
Menu: Insert|Construction|Triple Point Circle Toolbar: 
Standard, Construction Fly-out

Use the Triple Point Construction Circle tool to draw a construction circle that passes through any three 
points:
1. Activate the Triple Point tool.
2. Define three points.

Note: The Edit Bar is not used with this tool.



Point
Menu: Insert|Point Toolbars: Standard, Point

You can create five different types of marker points: dot, star, square, cross, or circle. Each type of point is
created in the same way.

Subtopics
Dot, Star, Square, Cross, and Circle



Dot, Star, Square, Cross, and Circle
Menu: Insert|Point|Dot, Star, Square, Cross, or Circle Toolbar: 
Standard, Point

TurboCAD has five styles of points, four of which are essentially similar, except for their shape. The Dot 
point is different: It stays the same size no matter how close you zoom in or how far you zoom out. This is 
useful if you want to use it as a point of reference while working in different views of the drawing. 
To place a point:
1. Activate the Point tools and select the type of point you want to create.
2. Define a point.

Note: Points cannot be scaled or rotated without first exploding them into polygons.
Tip: If you create a point of a particular shape and you subsequently want to change the shape, activate 
the Select tool, double-clicking on the point, and then change its Point Type in the Point property sheet. 
You can also change the size of the point with this method.



Line
Menu: Insert|Line Toolbar: Standard, Line

The Line tools enable you to draw a single line segment, multiple connected segments (multilines), 
polygons, rectangles, perpendicular lines, parallel lines, and lines tangent to arcs. The following table 
summarizes the line tools:

Tool Function

Single Draw a single line segment.
Multiline Draw a series of connected line segments.
Polygon Draw a regular polygon with an arbitrary number of sides.
Irregular Polygon Draw a polygon with arbitrary segment lengths and angles.
Rectangle Draw an orthogonal rectangle.
Rotated Rectangle Draw a rectangle oriented at any angle.
Perpendicular Draw a line perpendicular to an existing line from any point.
Parallel Draw a line parallel to an existing line, at a specific distance from 

the line.
Tangent Arc Point Draw a line tangent to an arc, touching the arc at the line’s 

midpoint.
Tangent to Arc Draw a line tangent to an arc, with the line’s endpoint touching 

the arc.
Tangent from Arc Draw a line tangent to an arc, with the line’s start point touching 

the arc.
Tangent to 2 Arcs Draw a line tangent to two arcs, with the end points of the line 

tangent to the arcs.

Single Line
Menu: Insert|Line|Single Toolbars: Standard, Line

Use the Single Line tool to draw a line segment between two defined points:
1. Activate the Single Line tool. 
2. Define the line segment’s starting point. 
3. Do one of the following:

Define the line segment’s ending point. 
Set the length and angle of the line segment in the Edit Bar, then press <Enter>. 



Multiline
Menu: Insert|Line|Multiline Toolbars: Standard, Line

The Multiline tool enables you to draw a series of connected line segments that comprise one entity. You 
can create a multiline by defining a series of points. Alternatively, you can set a starting point, then define 
each line segment in sequence by entering its length and angle in the Edit Bar, pressing <Enter> to 
complete each segment of the multiline, and pressing <Ctrl>+<F> to finish the multiline:
1. Activate the Multiline tool (a fly-out from the Line toolbar).
2. Define the first point of the multiline entity.
3. Do one of the following:

If necessary, reset the snap mode, then define a second point: TurboCAD draws a line segment 
between the two points. 

Specify the length and angle of the segment in the Edit Bar and press <Enter>.
4. Repeat step 3, adding connected segments to the multiline, until the multiline is finished. 
5. To define the last point in the series, double-click, choose Finish from the local menu, or press 

<Ctrl>+<F> if you are working in the Edit Bar. 

Tip: Instead of choosing Finish, you can have TurboCAD close the multiline for you by choosing Close 
from the local menu. This draws a line segment from the last point of the multiline to the first point. 
Tip: To undo the most recently drawn segment of the multiline, open the local menu and choose One 
Step Back, or press    <Backspace>.
Note: Once a multiline is closed, TurboCAD treats it as a polygon, which means that it will be filled with 
the color and pattern of the current brush. You can control brush formatting through the Format|Properties
dialog box, or the Properties toolbar.



Polygon
Menu: Insert|Line|Polygon Toolbars: Standard, Line

Use the Polygon tool to draw a regular polygon by defining points for the polygon’s center and for one of 
its vertices:
1. Activate the Polygon tool.
2. Define a point for the center of the polygon.
3. Enter the number of sides for the new polygon in the Sides field on the Edit Bar.
4. Do one of the following:

Define a second point for one of the polygon’s vertices.
Type values for the polygon's radius and degree of rotation in the Edit Bar. The radius is the 

distance from the center point to one of the vertices, and the degree of rotation is the angle of a line from 
the center point to one vertex.



Irregular Polygon
Menu: Insert|Line|Irregular Polygon Toolbars: Standard, Line

Use the Irregular Polygon tool to draw a polygon with irregular sides and angles. 
1. Activate the Irregular Polygon tool.
2. Define a point for the first vertex of the irregular polygon.
3. Define a second point: TurboCAD draws a line segment between the two points. 
4. Define a third point. TurboCAD draws a closed polygon, connecting the three points.
5. Repeat step 4, adding sides and vertices to the irregular polygon. 
6. After you have defined the final point, right-click in the drawing area and choose Finish from the local 

menu. 

Alternatively, you can enter the length and angle of each new line segment from the current vertex to the 
new vertex in the Edit Bar. Press <Enter> to define each new line segment. Press <Ctrl>+<F> to finish the
irregular polygon.



Rectangle
Menu: Insert|Line|Rectangle Toolbars: Standard, Line

The Rectangle tool enables you to create a rectangle by defining two diagonally opposite corners. 
Rectangles created in this way are oriented orthogonally, although they can subsequently be rotated 
using the editing tools:
1. Activate the Rectangle tool.
2. Define a point for one corner of the rectangle.
3. Do one of the following:

Define a point for the diagonally opposite corner. 
Specify the A (horizontal) and B (vertical) size of the rectangle in the Edit Bar, then press <Enter>.

Tip: If you use the Edit Bar method, the A size will be drawn using positive-X values from the starting 
point, and the B size will be drawn to the right of the starting point. To draw toward the negative-X 
direction, use negative values.



Rotated Rectangle
Menu: Insert|Line|Rotated Rectangle Toolbars: Standard, Line

Use the Rotated Rectangle tool to create a rectangle oriented at any angle. You create rotated rectangles 
by defining three points:
1. Define two points to specify the endpoints of a line that forms the rectangle’s base.
2. Do one of the following:

Define a third point to specify the distance of the opposite side of the rectangle from the baseline.
Type the rectangle's dimensions and angle of rotation into the Edit Bar fields, then press <Enter>.  



Perpendicular 
Menu: Insert|Line|Perpendicular Toolbars: Standard, Line

Use the Perpendicular Line tool when you want to draw a line perpendicular to an existing line. The new 
line extends from a defined point on the line to the endpoint of the line:
1. Activate the Perpendicular Line tool.
2. Click on an existing line segment to which you want to draw the perpendicular line.
3. Select a point on (or near) the existing line.
4. Define the endpoint of the perpendicular line. 

If the point you define is beyond the end of the existing line segment, TurboCAD by default will draw the 
perpendicular line from this point to the point where the two lines would meet if the existing line segment 
were extended. To constrain the perpendicular line so that it must meet the existing line segment, right-
click in the drawing area and choose Limit to Segment in the local menu.



Parallel Line
Menu: Insert|Line|Parallel Toolbars: Standard, Line

Use the Parallel Line tool to draw a line parallel to an existing line.
1. Activate the Parallel Line tool.
2. Click on or near an existing line. Call this the source line. As you move the mouse cursor away from 

the source line, TurboCAD draws a line parallel to it. 
3. Define a second point, which will be the second endpoint of the new line.

You can also select the source line, then specify the length of the parallel line and its distance from the 
source line in the Edit Bar. Press <Enter> or <Ctrl>+<F> to finish the parallel line.
Tip: To create a parallel line that is constrained to be the same length as the source line, right-click in the 
drawing area with the Parallel Line tool active, then switch on the Keep Length option in the local menu.
Tip: To create multiple parallel lines lock the distance in the Edit bar and then use the mouse to position 
the new line either above or below the existing line.



Tangent Arc Point
Menu: Insert|Line|Tangent Arc Point Toolbars: Standard, Line

The Tangent Arc Point tool enables you to draw a line tangent to an arc or circle with the midpoint of the 
line centered at the point of tangency.
1. Activate the Tangent Arc Point tool.
2. Click on the arc or circle to which the tangent must be drawn. A line appears tangent to the arc at a 

point on the arc near the mouse click.
3. Move the mouse to adjust the length of the line. The line length changes in both directions so that the 

midpoint of the line remains at the point where the line and arc meet. Click to set the line length.
4. A dotted line appears, from the center of the arc or circle to the mouse position, perpendicular to the 

tangent line. Move the mouse to change the angle of the dotted line and the position where the 
tangent line touches the arc, then click to set the angle of the tangent line.

Alternatively, you can click on the circle or arc, then specify the length and angle of the tangent line in the 
Edit Bar, then press <Enter>.



Tangent to Arc
Menu: Insert|Line|Tangent to Arc Toolbars: Standard, Line

Use the Tangent To Arc tool to draw a line tangent to an arc or circle from a defined point. 
1. Activate the Tangent to Arc tool.
2. Define the point from which you want to draw the tangent line.
3. Click on the side of the arc or circle to which you want to draw the tangent line.

Tip: To create a tangent line with a fixed length, define the first point of the line, then enter a length in the 
Edit Bar and check the lockdown box. Return to the drawing area and click on the circle or arc near the 
point of tangency. If the length you define is too long or too short this won't work—but you can return to 
the Edit Bar to adjust the length.



Tangent from Arc
Menu: Insert|Line|Tan from Arc Toolbars: Standard, Line

Use the Tangent from Arc tool to draw a line tangent from an arc or circle.
1. Activate the Tangent from Arc tool.
2. Click on the side of the arc or circle from which you want to draw the tangent line.
3. Do one of the following:

Define the point to which you want to draw the tangent line. 
Specify the length of the line in the Edit Bar, then press <Enter>.



Tangent to 2 Arcs
Menu: Insert|Line|Tangent to 2 Arcs Toolbars: Standard, Line

Use the Tangent to 2 Arcs tool to draw a line tangent to two arcs or circles:
1. Activate the Draw|Line|Tangent to 2 Arcs tool.
2. Click on the side of the first arc or circle from which you want the tangent drawn. 
3. Click on a side of the second arc or circle. 

Note: The current snap mode is irrelevant when you use this tool.



Double Line Tools
Menu: Insert|Double Line Toolbars: Standard, Double Line

Use the double line tools to draw two parallel lines as a single entity. The Double Line tools are essentially
similar to the Line tools, except that there are no Double Line tools for drawing lines tangent to arcs. The 
following table summarizes the double line tools:

Tool Function
Single Draw a double line segment by defining two endpoints.
Multiline Draw a series of connected double lines.
Polygon Draw a regular double line polygon with an arbitrary number of 

sides.
Irregular Polygon Draw a double line polygon with arbitrary line lengths and angles.
Rectangle Draw a horizontal double line rectangle.
Rotated Rectangle Draw a double line rectangle tilted at any angle.
Perpendicular Draw a double line perpendicular to an existing line.
Parallel Draw a double line parallel to an existing line.

Subtopics
Double Line Properties
Double Line Separation



Double Line Properties
Double Lines have unique properties that you can set in the Double Line property sheet of the Format|
Properties dialog box. You can access the default properties for double lines by right-clicking on any 
double line tool. You can access the properties of a specific double line entity by activating the Select tool 
and then double-clicking on the entity, or select and right-click for local menu and choose Properties. 
In the Double Line property sheet you can:

Set the distance between the two lines of the double line.
Determine whether the endpoints of the double line are open or closed. Each endpoint can be set

individually.
Set the alignment of the double line. Alignment sets whether the nodes (reference points) of the 

double line are aligned along its "left" line, its "right" line, or along its center. 
The alignment of the nodes determines how the double line aligns itself to the coordinate system, to the 
grid and other objects when you use snap modes to position the double line. 
Tip: To determine which is the left and which is the right side of a double line, imagine yourself standing 
on the starting point of the line, facing the endpoint. No matter which way you rotate the line, the right side
remains on your right. This is similar to the terms "port" and "starboard" which define directions relative to 
the fore and aft of a ship. The critical thing is to know the direction in which the double line is drawn.



Double Line Separation
The separation of a double line (the distance between the two single lines that comprise the double line) 
is set only in its property sheet. If you stretch or scale a double line, its separation always remains the 
same. If you want the separation of the double line to change as you resize a selection that contains the 
double line, first select the double line and choose Explode from the Format menu. The first time you 
explode a double line, it will become a polyline. (If the double line entity is itself contained within a group 
or block, you will need to explode it more than once.) Once the double line is exploded into two single 
lines, the distance between the two single lines will be scaled along with the selection that contains them.
See Also: Double Line Properties



Double Line
Menu: Insert|Double Line|Single Toolbars: Standard, Double Line

Use the Double Line Single tool to draw a double line segment between two defined points. 
1. Activate the Double Line Single tool. 
2. Define the double line segment’s starting point. 
3. Do one of the following:

Define the double line segment’s ending point.
Specify the length and angle of the double line segment in the Edit Bar, then press <Enter>.



Double Line Multiline
Menu: Insert|Double Line|Multiline Toolbars: Standard, Double Line

The Double Line Multiline tool enables you to draw a series of connected double line segments. You can 
create a multiline by defining a series of points. Alternatively, you can set a starting point, then define 
each double line segment in sequence by entering the length and angle of each segment in the Edit Bar, 
pressing <Enter> to complete each segment of the multiline.
1. Activate the Double Line Multiline tool.
2. Define the first point of the multiline entity.
3. Do one of the following:

If necessary, reset the snap mode, then define a second point: TurboCAD draws a double line 
segment between the two points. 

Specify the length and angle of the double line segment in the Edit Bar and press <Enter>.
4. Repeat step 3, adding connected double line segments to the multiline, until the multiline is finished. 
5. To define the last point in the series, right-click in the drawing area and choose Finish from the local 

menu, or press <Ctrl>+<F> if you are working in the Edit Bar. 

Tip: You can have TurboCAD close the multiline for you by choosing Close from the local menu. This 
draws a double line segment from the last point of the multiline to the first point, resulting in a double line 
polygon. 
Tip: If you want to cancel the previous line segment, open the local menu and choose One Step Back.



Double Line Polygon
Menu: Insert|Double Line|Polygon Toolbars: Standard, Double Line

Use the Double Line Polygon tool to draw a regular double line polygon by defining points for the 
polygon’s center and for one of its vertices (corners). 
1. Activate the Double Line Polygon tool.
2. Enter the number of sides for the double line polygon in the Sides field of the Edit Bar.
3. Define the centerpoint of the polygon.
4. Do one of the following:

Define a second point for one of the polygon’s vertices. 
Type values for the polygon's radius and degree of rotation in the Edit Bar. The radius is the 

distance from the centerpoint to one of the vertices, and the degree of rotation is the angle of a line from 
the centerpoint to one vertex.



Double Line Irregular Polygon
Menu: Insert|Double Line|Irregular Polygon Toolbars: 
Standard, Double Line

Use the Double Line Irregular Polygon tool to draw a double line polygon with irregular line segment 
lengths and angles:
1. Activate the Double Line Irregular Polygon tool.
2. Define the first point of the irregular polygon.
3. Define a second point: TurboCAD draws a double line between the two points. 
4. Define a third point. TurboCAD draws a closed polygon, connecting the three points.
5. Repeat step 4, adding sides and vertices to the irregular polygon. 
6. To define the last point in the series, choose Finish from the local menu. 

Alternatively, you can enter the length and angle of each line segment from the current point in the Edit 
Bar. Press <Enter> to define each new line. Press <Ctrl>+<F> to finish the irregular polygon.



Double Line Rectangle
Menu: Insert|Double Line|Rectangle Toolbars: Standard, Double Line

This tool enables you to create a double line rectangle by defining two diagonally opposite corners. 
Rectangles created in this way are orthogonal, although they can subsequently be rotated using editing 
tools.
1. Activate the Double Line Rectangle tool.
2. Define the first point.
3. Do one of the following:

Define a point for the diagonally opposite corner. 
Specify the vertical and horizontal dimensions of the rectangle in the Edit Bar, and then press 

<Enter>.
Note: If you use the Edit Bar method, the A size will be drawn toward the positive-X direction from the 
starting point, and the B size will be drawn to the right of the starting point. You can draw to the negative -
X direction by entering negative values.



Double Line Rotated Rectangle
Menu: Insert|Double Line|Rotated Rectangle Toolbars: 
Standard, Double Line

Use the Rotated Rectangle tool to create a rectangle oriented at an angle that you choose. You create a 
rotated rectangle by defining three points:
1. Define two points to specify the endpoints of the line that forms the rectangle’s base. The angle of 

this line determines the angle of the rectangle.
2. Do one of the following:

Define a third point specifying the distance of the opposite side of the rectangle from the baseline.
Specify the length of side B and angle of the double line rectangle in the Edit Bar, and then press 

<Enter>.



Perpendicular Double Line
Menu: Insert|Double Line|Perpendicular Toolbars: Standard, Double Line

Use the Perpendicular Double Line tool when you want to draw a double line perpendicular to an existing 
line. The double line extends from a defined point to the existing line.
1. Activate the Perpendicular Line tool.
2. Click on an existing line segment to which you want to draw the perpendicular double line. (This can 

be one of the sides of another double line.)
3. Define the point from which you want the perpendicular line to originate. 
4. Define the end point of the line.

Tip: If the point you define is beyond the end of the existing line segment, TurboCAD will normally draw 
the double perpendicular line from this point to where it would meet the existing line segment if the 
existing line segment were extended. If you want to constrain the perpendicular line so that it will not be 
drawn beyond the ends of the existing line segment, right-click in the drawing area to open the local 
menu, then choose Limit to Segment.



Parallel Double Line
Menu: Insert|Double Line|Parallel Toolbars: Standard, Double Line

Use the Double Parallel Line tool to draw a Double Line parallel to an existing line.
1. Activate the Double Parallel Line tool.
2. Click on or near an existing line. Let's call this the source line. As you move the mouse cursor away 

from the source line, TurboCAD draws a double line parallel to it. 
3. Define a second point, which will be the second endpoint of the new line.

You can also select the source line, then specify the length of the parallel line and its distance from the 
source line in the Edit Bar. Press <Enter> or <Ctrl>+<F> to finish the parallel line from the Edit Bar.
Tip: To create a parallel double line that is constrained to be the same length as the source line, right-
click in the drawing area with the Parallel Double Line tool active, and then switch on the Keep Length 
option in the local menu.



Circle/Ellipse
Menu: Insert|Circle/Ellipse Toolbar: Standard, Circle/Ellipse

The Circle/Ellipse menu item opens a submenu containing tools for drawing circles and ellipses. You can 
also access these tools from the Circle/Ellipse fly-out on the Standard toolbar. The following table 
summarizes the Circle/Ellipse tools:

Tool Function

Center and Point Draw a circle by specifying its centerpoint and radius.
Concentric Draw a set of circles that share the same centerpoint.
Double Point Draw a circle by defining two opposite points on its perimeter.
Tangent to Arc Draw a circle tangent to another circle or arc.
Tangent to Line Draw a circle tangent to a line.
Triple Point Draw a circle by defining three points on the circle’s perimeter.
Tangent to 3 Arcs Draw a circle tangent to three existing arcs or circles.
Ellipse Draw an ellipse by defining its bounding rectangle.
Rotated Ellipse Draw an ellipse rotated at any angle.
Ellipse Fixed Ratio Draw an ellipse, specifying the ratio of the major axis length to the 

minor axis length.

Center and Point
Menu: Insert|Circle/Ellipse|Center and Point Toolbar: 
Standard, Circle/Ellipse

Use the Center and Point tool to create a circle by defining its center and a point on its perimeter. 
1. Activate the Center and Point tool.
2. Define a point for the center of the circle.
3. Do one of the following:

Define a point on the perimeter of the circle.
Enter the radius of the circle in the Radius field, or the circumference of the circle in the Circumf. 

field on the Edit Bar, then press <Enter>.



Concentric
Menu: Insert|Circle/Ellipse|Concentric Toolbar: Standard, Circle/Ellipse

Use the Concentric tool to draw concentric circles, that is, circles that share the same centerpoint. You 
can create as many concentric circles as you need at one time:
1. Activate the Concentric tool.
2. Define a centerpoint for the circles.
3. Do one of the following:

Define a point on the perimeter of the circle.
Enter the circle’s radius in the Radius field on the Edit Bar and press <Enter>. 

TurboCAD will draw a circle with the specified center and radius.
4. Repeat step 3, drawing as many concentric circles as required.
5. Finish the concentric circles by choosing Finish from the local menu, or by pressing <Ctrl>+<F> if you

are working in the Edit Bar.

You can also enter the radius or circumference of each concentric circle in succession in the Edit Bar. 
Press <Enter> to complete individual circles. Press <Ctrl>+<F> to complete the set of concentric circles.
Tip: To draw a circle concentric to an existing circle, choose the Concentric tool, then use Snap to Arc 
Center to snap to the center of the existing circle.



Double Point
Menu: Insert|Circle/Ellipse|Double Point Toolbar: Standard, Circle/Ellipse

The Double Point tool lets you draw a circle by defining two opposite points on the circle's perimeter:

1. Activate the Double Point tool.
2. Define a point that will be on the perimeter of the circle. 
3. Do one of the following:

Define a second point, 180 degrees from the first point on the perimeter of the circle.
Specify the diameter (or circumference) of the circle and the angle of the line in the Edit Bar, then 

press <Enter>.



Circle Tangent to Arc
Menu: Insert|Circle/Ellipse|Tangent to Arc Toolbar: Standard, Circle/Ellipse

Use the Circle Tangent to Arc tool to draw a circle tangent to an arc or to another circle. 
1. Activate the Circle Tangent to Arc tool.
2. Click on the existing arc or circle to which you want the circle to be tangent.
3. Do one of the following:

Define the centerpoint of the circle.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking in it (or press <Ctrl>+<D>). Click once 
more to continue to the next step.
4. Move the mouse along the perimeter of the arc to position the circle on the arc. If you move the 

mouse along the inside of the arc, the circle will move to the inside of the arc; if you move the mouse 
along the outside of the arc, the circle will move to the outside. Once the circle is in place, click the 
mouse to fix its position.

Note: After clicking on the circle or arc (step 2), you can set the radius or circumference of the circle you 
are drawing in the Edit Bar and press <Enter>, finishing the entity. Be aware that if you use this method, 
you will not be able to reposition the circle on the arc using this tool, so make sure that you place it where 
you want it with the first click.



Circle Tangent to Line
Menu: Insert|Circle/Ellipse|Tangent to Line Toolbar: 
Standard, Circle/Ellipse

Use the Circle Tangent to Line tool to draw a circle tangent to an existing line.
1. Activate the Circle Tangent to Line tool.
2. Click on the line to which you want the circle to be tangent.
3. Do one of the following:

Define the centerpoint of the circle.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking in it (or press <Ctrl>+<D>). Click once 
more to continue to the next step.
4. Move the mouse along the line to position the circle, then click (using any snap mode) to fix the 

circle’s position.

Note: After clicking on the line (step 2), you can set the radius or circumference of the circle you are 
drawing in the Edit Bar and press <Enter>, finishing the entity. Be aware that if you use this method, you 
will not be able to reposition the circle on the line using this tool, so make sure that you place it where you
want it with the first click.



Triple Point
Menu: Insert|Circle/Ellipse|Triple Point Toolbar: Standard, Circle/Ellipse

Use the Triple Point tool to draw a circle that passes through any three points.
1. Activate the Triple Point tool.
2. Define the first, then the second, and then the third point through which the perimeter of the circle will 

pass.



Tangent to 3 Arcs
Menu: Insert|Circle/Ellipse|Tangent to 3 Arcs Toolbar: 
Standard, Circle/Ellipse

Use the Tangent to 3 Arcs tool to draw a circle tangent to three existing arcs or circles. You can specify 
whether the new circle will include or exclude each one of the existing three arcs or circles.
1. Activate the Tangent to 3 Arcs tool.
2. Use the mouse to select an arc or circle to which you want the new circle to be tangent. Click just 

inside the perimeter of the arc to include it in the new circle, or click just outside the arc to exclude it 
from the circle. A small arrow will appear on the each arc, indicating whether it is to be included or 
excluded.

3. Repeat step 2 with the remaining two existing circles or arcs.



Ellipse
Menu: Insert|Circle/Ellipse|Ellipse Toolbar: Standard, Circle/Ellipse

The Ellipse tool lets you create an ellipse by defining a bounding rectangle for the ellipse. The axes of the 
ellipse will be orthogonal; however, you can rotate the ellipse after you have created it using the editing 
tools.
1. Activate the Ellipse tool.
2. Define the first point or corner of the bounding rectangle.
3. Do one of the following:

Define the diagonally opposed corner of the bounding rectangle.
Specify the lengths of the ellipse's major and minor axes in the Edit Bar, then press <Enter>.



Rotated Ellipse
Menu: Insert|Circle/Ellipse|Rotated Ellipse Toolbar: 
Standard, Circle/Ellipse

The Rotated Ellipse tool enables you to create an ellipse tilted at any angle. 
1. Activate the Rotated Ellipse tool.
2. Define the centerpoint of the ellipse.
3. Define a point to specify an angle and distance from the centerpoint. This creates an axis from the 

defined point, through the centerpoint, to an opposite point the same distance from the centerpoint. 
You can view this major axis on the screen as you adjust the position of the point using the mouse or 
Coordinate Fields.

4. Define a second point to specify the length of the opposite (minor) axis. This axis will of course be 
perpendicular to the first axis.

Alternatively, you can define the centerpoint of the ellipse, specify the length and angle of the major axis 
and the length of the minor axis in the Edit Bar, then press <Enter>.



Ellipse Fixed Ratio
Menu: Insert|Circle/Ellipse|Ellipse Fixed Ratio Toolbar: 
Standard, Circle/Ellipse

The Ellipse Fixed Ratio tool lets you create an ellipse by specifying its aspect ratio; that is, the ratio of the 
length of its major axis to the length of its minor axis. For example, if the ratio is 2 then the major axis will 
be twice as long as the minor axis (the ellipse will be twice as long as it is wide). The axes of the ellipse 
will initially be horizontal and vertical; however, you can subsequently rotate the ellipse using editing tools.
1. Activate the Ellipse Fixed Ratio tool.
2. Define the centerpoint of the ellipse.
3. Enter the aspect ratio in the a:b field on the Edit Bar, then lock down this field. To return to the 

drawing area, click in it or press <Ctrl>+<D>.
4. Define any point of the perimeter of the ellipse.



Arc Tools
Menu: Insert|Arc Toolbars: Standard, Arc

Drawing arcs is very similar to drawing circles. Generally, the arc tools work precisely the same way as 
the circle tools, except that they add one extra step: defining the start and end angles of the arc.
Note: Arcs are drawn in a counterclockwise direction. This can be changed in Options|Angle.
The following table summarizes the arc drawing tools:

Tool Function
Center and Radius Arc Draw a regular arc by specifying its centerpoint and a point on its 

circumference.
Concentric Arc Draw a set of concentric regular arcs that share the same 

centerpoint.
Double Point Arc Draw a regular arc by defining the endpoints of its diameter.
Tangent to Arc Draw a regular arc tangent to a circle or arc.
Tangent to Line Draw a regular arc tangent to a line.
Start/Included/End Draw a regular arc by defining (1) its starting point, (2) a point on 

its perimeter, and (3) its ending point.
Start/End/Included Draw a regular arc by defining (1) its starting point, (3) its ending 

point, and (2) a point on its perimeter.
Tan to 3 Arcs Draw a regular arc that is tangent to 3 existing arcs or circles.
Elliptical Draw an elliptical arc by defining its bounding rectangle.
Rotated Elliptical Draw an elliptical arc rotated at any angle.
Elliptical Fixed Ratio Draw an elliptical arc by setting its aspect ratio and defining either

axis.

Subtopics
Circumference and Length of Arcs
Combining Edit Bar and Mouse When Drawing Arcs



Circumference and Length of Arcs
When you are drawing arcs using the Edit Bar, you will need to distinguish between the Circumf. field and 
the Length field. 
The Circumf. field holds the value that represents the circumference of the arc circle, that is, the length of 
the circle that the arc would form if it were closed. This field and the Radius field are mutually dependent: 
Changing one moves the other. The Length field is the actual length of the arc, taking into account its 
starting and ending angles.



Combining Edit Bar and Mouse When Drawing Arcs
Arcs are relatively complex entities, it is likely that you will want to use various combinations of the Edit 
Bar and the mouse to create them.
Tip: Keep in mind that if you specify values in the Edit Bar, you must lock the fields down before returning
to the drawing area to finish the entity. If you don't, the values that you typed in the Edit Bar will change 
when you re-enter the drawing area.



Center and Radius Arc
Menu: Insert|Arc|Center and Radius Toolbars: Standard, Arc

Use the Center and Radius tool to create an arc by defining its center, a point on its circumference, and 
its starting and ending angles.
1. Activate the Center and Radius tool.
2. Define the centerpoint of the arc.
3. Define a point at a distance from the centerpoint to specify the radius of the arc. TurboCAD draws a 

circle with the specified radius and centerpoint. A dotted line appears, extending from the centerpoint 
of the circle to the cursor.

4. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 
set the arc’s starting angle. Move the cursor counterclockwise to draw the arc, then click the mouse 
button to define the ending angle.

Alternatively, you can define a point for the center of the circle, enter the radius (or circumference) of the 
arc and its starting and ending angles (or length) in the Edit Bar, and then press <Enter>. 
You can also combine the two approaches. For example, you could define the center and radius of the 
arc using the mouse, then specify the starting and ending angles in the Edit Bar.



Concentric Arc
Menu: Insert|Arc|Concentric Toolbars: Standard, Arc

Use the Concentric tool to draw concentric arcs; that is, arcs that share the same centerpoint. These 
concentric circles are a series of center and radius arcs, created in succession. You can create as many 
concentric arcs as necessary at one time.
1. Activate the Concentric Arc tool.
2. Define a centerpoint for the arcs.
3. Define a point on the circumference of the arc. TurboCAD will draw a circle with the specified center 

and radius. A dotted line will appear, extending from the centerpoint of the arc to the cursor.
4. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 

set the arc’s starting angle. Move the cursor counterclockwise to draw the arc, then click the mouse 
button to define the ending angle.

5. Repeat steps 3 and 4, drawing as many concentric arcs as required.
6. Once you have all the concentric arcs you need, complete the set of concentric arcs by choosing 

Finish from the local menu, double-clicking, or pressing <Enter>.

You can also enter the radius (or circumference) and the starting and ending angles (or length) of each 
concentric arc in succession in the Edit Bar. Press <Enter> to complete individual circles. Press 
<Ctrl>+<F> to complete the set of concentric circles.



Double Point Arc
Menu: Insert|Arc|Double Point Toolbars: Standard, Arc

The Double Point tool lets you draw an arc by defining the endpoints of its diameter.
1. Activate the Double Point tool.
2. Define the starting point of a line that will pass through the center of the arc. 
3. Define the endpoint of this line. TurboCAD draws a circle that passes through the two defined points. 

A dotted line appears, extending from the centerpoint of the circle to the cursor.
4. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 

set the arc’s starting angle. Move the cursor counterclockwise to draw the arc, then click the mouse 
button to define the ending angle.

Alternatively, you can define the first point of the arc’s diameter, then specify all the quantities that define 
the arc in the Edit Bar. 
You can also combine the two approaches. For example, you could define the center and radius of the 
arc using the mouse, then specify the starting and ending angles in the Edit Bar.



Arc Tangent to Arc
Menu: Insert|Arc|Tangent to Arc Toolbars: Standard, Arc

Use the Tangent to Arc tool to draw an arc tangent to an existing arc or circle. 
1. Activate the Tangent to Arc tool.
2. Click on the existing arc or circle to which you want the arc to be tangent. 
3. Do one of the following:

Define the centerpoint of the arc you are drawing.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking there (or press <Ctrl>+<D>). Click to 
continue to the next step.
4. Move the mouse along the perimeter of the arc to position the circle on the arc. If you move the 

mouse along the inside of the arc, the circle will move to the inside of the arc; if you move the mouse 
along the outside of the arc, the circle will move to the outside. Once the circle is in place, click the 
mouse to fix its position. A dotted line appears, extending from the centerpoint of the circle to the 
cursor.

5. Move the cursor to move the dotted line to the angle at which you want the arc to start, then click to 
set the arc’s starting angle.

6. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

Note: After clicking on the circle or arc (step 2), you can set the radius (or circumference) of the arc, as 
well as its starting and ending angles (or length) in the Edit Bar, then press <Enter> to finish the entity. Be 
aware that if you use this method, you will not be able to reposition the circle on the arc using this tool, so 
make sure that you place it where you want it with the first click.



Tangent to Line
Menu: Insert|Arc|Tan to Line Toolbars: Standard, Arc

Use the Tangent to Line tool to draw an arc tangent to an existing line.
1. Activate the Tangent to Line tool.
2. Click on the line to which you want the arc to be tangent.
3. Do one of the following:

Define the centerpoint of the arc you are drawing.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking there (or press <Ctrl>+<D>). Click to 
continue to the next step.
4. Move the mouse to either side of the line and define a point to position the arc on the line. A dotted 

line appears, extending from the centerpoint of the circle to the cursor.
5. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 

set the arc’s starting angle.
6. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 

angle.

Note: After clicking on the line (step 2), you can set the radius (or circumference) of the arc, as well as its 
starting and ending angles (or length) in the Edit Bar, then press <Enter> to finish the entity. Be aware 
that if you use this method, you will not be able to reposition the circle on the line using this tool, so make 
sure that you place it where you want it with the first click.



Arc Start/Included/End
Menu: Insert|Arc|Start/Included/End Toolbars: Standard, Arc

The Start/Included/End tool lets you draw an arc by defining three points: a starting point, a middle point, 
and an ending point. The arc will touch all three of the points.
1. Activate the Arc Start/Included/End tool.
2. Define the starting point of the arc. 
3. Define a point through which the arc will pass.
4. Define the ending point of the arc.



Arc Start/End/Included
Menu: Insert|Arc|Arc Start/End/Included Toolbars: Standard, Arc

The Start/End/Included tool lets you draw an arc by defining three points. This is similar to drawing a triple
point circle, except that the first two points you define determine the points at which the arc begins and 
ends.
1. Activate the Start/End/Included tool.
2. Define the starting point of the arc.
3. Define the ending point of the arc.
4. Define a third point through which the arc will pass.



Arc Tan to 3 Arcs
Menu: Insert|Arc|Tangent to 3 Arcs Toolbar: Standard, Arc

Use the Tangent to 3 Arcs tool to draw an arc tangent to three existing arcs or circles. You can specify 
whether the new arc will include or exclude any of the three arcs or circles.
1. Activate the Tangent to 3 Arcs tool.
2. Use the mouse to select an arc or circle to which you want the new circle to be tangent. Click just 

inside the perimeter of the arc to include it in the new circle, or click just outside the arc to exclude it 
from the circle. An arrow on each arc indicates whether it is included or excluded.

3. Repeat step 2 with two more existing circles or arcs. TurboCAD draws a circle tangent to the three 
arcs or circles you have selected. A dotted line appears, extending from the centerpoint of the circle to
the cursor.

4. Move the cursor to the angle at which you want the arc to start, then click to set the arc’s starting 
angle.

5. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

As an alternative to steps 4 and 5, you can specify the starting and ending angles of the arc in the Edit 
Bar, then press <Enter>.



Elliptical Arc
Menu: Insert|Arc|Elliptical Toolbar: Standard, Arc

The Elliptical Arc tool lets you create an elliptical arc by defining its bounding rectangle. The lengths of the
minor and major axes of the arc are determined by the lengths of the sides of the bounding rectangle. The
axes of the arc will be orthogonal; however, you can rotate the arc after you have created it using the 
editing tools:
1. Activate the Ellipse tool.
2. Define a point for the first corner of the bounding rectangle.
3. Define a point for the diagonally opposite corner of the bounding rectangle. TurboCAD draws an 

ellipse bounded by the rectangle that you have defined. A dotted line appears, extending from the 
centerpoint of the ellipse to the cursor.

4. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 
set the arc’s starting angle.

5. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

Alternatively, you can define the starting point of the elliptical arc, then specify its major and minor axes 
and starting and ending angles in the Edit Bar. You can also combine use of the mouse and Edit Bar.



Rotated Elliptical Arc
Menu: Insert|Arc|Rotated Elliptical Toolbar: Standard, Arc

The Rotated Elliptical Arc tool enables you to create an elliptical arc tilted at any angle:
1. Activate the Rotated Elliptical Arc tool.
2. Define the centerpoint of the arc.
3. Define a point to specify an angle and distance from the centerpoint. This creates an axis from the 

defined point, through the centerpoint, to an opposite point the same distance from the centerpoint. 
This is the major axis of the elliptical arc.

4. Define a third point to specify the length of the minor axis (perpendicular to the major axis). TurboCAD
draws an ellipse with the specified major and minor axes. A dotted line appears, extending from the 
centerpoint of the ellipse to the cursor.

5. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 
set the arc’s starting angle.

6. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

You can also define the centerpoint of the ellipse, then specify the length and angle of the major axis and 
the length of the minor axis, as well as the starting and ending angles of the arc, in the Edit Bar.



Elliptical Fixed Ratio Arc
Menu: Insert|Arc|Elliptical Fixed Ratio Toolbar: Standard, Arc

The Elliptical Fixed Ratio tool lets you create an elliptical arc by specifying its aspect ratio; that is, the ratio
of the length of its major axis to the length of its minor axis. For example, if the ratio is 2 the major axis will
be twice as long as the minor axis. The axes of the elliptical arc will initially be orthogonal; however, you 
can subsequently rotate the elliptical arc using the editing tools.
1. Activate the Elliptical Fixed Ratio Arc tool.
2. Define the centerpoint of the arc.
3. Type the aspect ratio of the arc into the Ratio field of the Edit Bar.
4. Define any point on the perimeter of the ellipse. TurboCAD draws an ellipse with the specified major 

and minor axes. A dotted line appears, extending from the centerpoint of the ellipse to the cursor.
5. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 

set the arc’s starting angle.
6. Move the cursor to draw the arc, then click the mouse button to define the ending angle.

As an alternative to steps 5 and 6, you can specify the start and end angles of the arc in the Edit Bar, then
press <Enter>.



Curve Tools
Menu: Insert|Curve Toolbar: Standard, Curve

The following table summarizes the curve tools:

Tool Function
Spline Connects two endpoints; gravitates toward control points 

along its path.
Bezier Continuous curve that connects a series of points.
Sketch Freehand multiline drawn with mouse.

Subtopics
Curve Properties



Curve Properties
Curves have special properties, set in the Curve property sheet of the Properties dialog. This property 
sheet lets you show or hide the frame of a Bezier or Spline curve, transform a Bezier curve into a Spline 
curve, or vice versa. You can access the default properties of curves by double-clicking on a curve with 
the Select tool, or by selecting the curve and then choosing Format|Properties.
Tip: You can close a Bezier or Spline curve by choosing Close from the local menu instead of Finish. This
draws a curved line between the two endpoints. You can also close curves or break open closed curves 
using Node Edit mode, employing the same technique that you use on multilines and polygons.
See Also: Breaking Polygons, Closing Multilines, Curve Property Sheet



Spline Curve
Menu: Insert|Curve|Spline Toolbars: Standard, Curve

To create a Spline curve, define points along the intended path of the curve. The curve will span the two 
endpoints and be pulled toward the intermediate points, which act as control points along its path.
1. Activate the Spline Curve tool.
2. Define the first endpoint of the curve. 
3. Continue to define points along the path of the curve.
4. To define the final point, right-click and choose Finish from the local menu. If you want to close the 

curve, choose Close instead of Finish.

If at any point you wish to undo the segment of the curve that you just drew, right-click in the drawing area
and choose One Step Back from the local menu.
An alternative to defining points along the path of the curve is to specify the length and angles of the line 
segments between the points, which form the frame of the curve. You can do this in the Edit Bar, pressing
<Enter> to complete each segment of the frame, then pressing <Alt>+<F> to complete the entire curve. 
This procedure is essentially similar to drawing a multiline.



Bezier Curve
Menu: Insert|Curve|Bezier Toolbars: Standard, Curve

To create a Bezier curve, define points along the intended path of the curve. The curve will pass through 
the defined points.
1. Activate the Bezier Curve tool.
2. Define the first endpoint of the curve. 
3. Continue to define points along the path of the curve. 
4. To define the final point choose Finish from the local menu. If you want to close the curve choose 

Close instead of Finish.

If at any point you wish to undo the segment of the curve that you just drew, right-click in the drawing area
and choose One Step Back from the local menu or press <Backspace>.
An alternative to defining points along the path of the curve is to specify the length and angles of the line 
segments between the points, which form the frame of the curve. You can do this in the Edit Bar, pressing
<Enter> to complete each segment of the frame, then pressing <Alt>+<F> to complete the entire curve. 
This procedure is essentially similar to drawing a multiline.



Sketch Curve
Menu: Insert|Curve|Sketch Toolbar: Standard, Curve

The Sketch tool is used for freehand drawing.
1. Activate the Sketch tool. 
2. Click the mouse to define the starting point of the sketch.
3. Move the mouse to draw a freehand polyline.
4. Click the mouse to define the final endpoint of the sketch polyline.



Text
Menu: Insert|Text Toolbar: Standard

The features for creating, formatting, and manipulating text in TurboCAD Learning Edition are very 
powerful; however, entering text and placing it in your drawing is simple and intuitive:
1. Activate the Text tool.
2. If you wish to set the font, size, and attributes of text prior to typing, display the Property toolbar 

(using View|Toolbars) and choose settings from the toolbar. As an alternative, you can set text 
properties by right-clicking on the Text tool, then changing the properties in the Text property sheet. 
You can use any TrueType font installed in your system.

3. Click in the drawing area at the point where you want to place your text.
4. Type the text that you want to place, using the <Backspace> key to make corrections. Press 

<Shift>+<Enter> to add a new line of text. To finish the entity, press <Enter>, or right-click and choose
Finish from the local menu.

Note: To edit text that has already been placed on a drawing use the Selection Tool and double-click the 
text and then edit the attribute string in the General tab.
See Also: For information about installing TrueType fonts, see your Windows documentation.

Subtopics
Text Properties
Text Height and Angle Options
Text Alignment Options



Text Properties
The Text tool has a special set of properties that are accessible through the Text property sheet. You can 
access the default properties of the Text tool by right-clicking on the tool. You can access the properties of
selected text by right-clicking on the selection and then choosing Properties from the local menu. The Text
property sheet has options for setting font, font style, text height, text color, text mode and text placement 
style.
Tip: To edit the contents of the text, select the text object and choose Format|Properties, then edit the text
in the Attribute field of the General property sheet. To reformat the text, use the Text property sheet in the 
same dialog.
See Also: Manipulating Text, Formatting Text, Text Property Sheet



Text Height and Angle Options
The local menu offers options for changing the height and angle of text "on the fly" while the Text tool is 
active. 
If you right-click and choose Height from the local menu, a line will appear. Move the mouse to position 
the lower-right corner of the box until it is the desired size. Click the mouse to set the text height, then 
continue entering text.
If you choose Angle from the local menu, a line will appear. Move the mouse to rotate the rectangle, then 
click the mouse. You can now continue entering text into the angled text frame.
You can also change the text height and by typing values into the Height and Angle fields of the Edit Bar.
Tip: To use Ortho while rotating text, hold down the <Shift> key.
Note: The editing and formatting tools provide other options for rotating and resizing text more precisely 
after it has been drawn.
See Also: Manipulating Text, Formatting Text, Text Property Sheet



Text Alignment Options
The text alignment options of the Text tool give you precise control over how the text is aligned relative to 
the point where it is inserted in your drawing. To access these options, activate the text tool, right-click in 
the drawing area, and then choose Align (the command will be followed by two capital letters that vary, 
depending on the current alignment setting).
The figures next to each alignment setting show you graphically how the text is positioned relative to the 
insertion point, which is represented by a star. There are three vertical positions (Top, Center, and 
Bottom) and three horizontal positions (Left, Middle, and Right). When you re-open the local menu with 
the Text tool active, the letters next to the command represent the current settings. TL, for example, 
means the insertion point will be at the top-left corner of the text.



Dimension Tools
Menu: Insert|Dimension Toolbars: Standard, Dimension

TurboCAD contains a variety of dimension tools that you can use to display the measurements of lines 
and angles. Dimensions generally consist of a dimension line or arc, extension lines extending to the 
object being measured, and dimension text. Leader and datum dimensions consist of dimension text and 
a simple leader line. Dimensioning an entity means to display a dimension that measures or otherwise 
marks that entity. 
By default, dimension text contains a measurement of the dimensioned object or coordinates in current 
World units. (Leader dimensions, which contain text labels, are the exception to this rule.) You can 
override the default text of a dimension by specifying the text in the Edit Bar prior to finishing the 
dimension. You can also change the dimension text from the general property sheet.
See Also: Dimension Property Sheets
The following table summarizes the dimension tools:

Tool Function
Horizontal Draw a linear dimension showing horizontal distance.
Vertical Draw a linear dimension showing vertical distance.
Parallel Draw a linear dimension showing absolute distance between two points.
Rotated Draw a linear dimension showing absolute distance between two points 

(the length of a line), with extension lines rotated to any angle relative to 
the line you are dimensioning.

Datum Draw a series of dimensions connected to angled leader lines.
Baseline Draw a series of parallel linear dimensions sharing a common baseline.
Continuous Draw a series of parallel linear dimensions, each measuring a distance 

from the end of the previous dimension in the series.
Angular Draw an angular dimension showing the angle formed by two lines, by 

points on the perimeter of a circle or arc, or the angle formed by any two 
points relative to a defined vertex.

Radius Draw a dimension indicating the radius of an arc or circle.
Diameter Draw a dimension indicating the diameter of an arc or circle.
Leader Draw a simple line leader with label text.

Subtopics
Manual, Segment, and Entity Dimensioning
Associative Dimensions
Setting Dimension Properties



Manual, Segment, and Entity Dimensioning
Horizontal, vertical, parallel, and rotated dimensions are collectively known as linear dimensions. When 
you create a linear dimension, you have three primary choices:

You can draw the dimension manually, using the Coordinate Fields, Edit Bar, or the mouse and 
snap modes.

You can associate the dimension with a line segment.
You can associate the dimension with an entire entity (such as a multiline, a group, or a block 

insert).
To choose one of these three modes:
1. Activate the dimension tool that you want to use.
2. Right-click in the drawing area to open the local menu.
3. Do one of the following:

Click to place a check mark next to Segment Dimensioning to associate the dimension with a line 
segment. 

Click to place a check mark next to Entity Dimensioning to associate the dimension with an entity.
If you want to create the dimension manually, deselect both Segment Dimensioning and Entity 

Dimensioning.
Once you have selected a dimensioning mode, the mode is saved with the drawing and remains in effect 
for that drawing unless you explicitly change it. 
Tip: If you generally prefer one of the dimensioning modes over the others, you can save it in a drawing 
template.
Warning: If you are using the Rotated Dimension tool, the Segment Dimensioning and Entity 
Dimensioning items in the local menu will be grayed out until after the first two clicks. See Rotated 
Dimension further information.
See Also: Horizontal Dimension; Parallel Dimension; Rotated Dimension; Vertical Dimension



Associative Dimensions
Dimensions can be associated with objects. This means that you can freely move, rotate, or resize the 
objects with which the dimension is associated, and the dimension will retain its position relative to the 
objects, and the dimension text will change automatically to reflect changes resulting from the objects 
being resized or moved (provided that you did not override the automatic text in the Edit Bar, or in the 
attribute string of the Dimension Property sheet, when you created the dimension).
If you want a dimension to be associated with an object, you first need to be sure that the Associative 
Dimension option is turned on. To do this, first right-click on any dimension tool to bring up the Properties 
dialog, which will contain the property sheets for default dimension properties. If there is no check mark in
the Associative Dimension check box, then click in the box. Click OK to close the dialog.
Once this box is checked, then any dimension that is "connected" to an object will be associated with the 
object. You can accomplish this in the following ways:

Use Segment Dimensioning.
Use Entity Dimensioning.
Use any snap mode to snap the dimension to an existing object.
Use a dimension tool that automatically connects to an entity. If you dimension an angle on a 

circle, for example, the dimension will be associated with the circle. If you dimension an angle between 
two lines, the dimension will be associated with both lines.
Tips: To tell whether a dimension is associated with an entity, select the entity. Any dimensions 
associated with that entity will be colored blue. 
If you want to turn off default associative dimensions, first right-click on a dimension tool to bring up the 
Properties dialog. Then, in the Format property sheet, deselect the Associative Dimensions check box. 



Setting Dimension Properties
The Dimension property sheets provide a large number of options for controlling the format of 
dimensions. You can set the default properties of dimensions by right-clicking on a dimension tool and 
then choosing settings in the Dimension property sheets. These settings are saved in your drawing or 
template and remain in effect until you explicitly change them. 
If you want to set the properties of a dimension or a set of dimensions, activate the Select tool, select the 
dimensions that you want to format, then right-click on the selection and choose Properties from the local 
menu to bring up the Properties dialog.
See Also: Dimension Property Sheets



Horizontal Dimension
Menu: Insert|Dimension|Horizontal Toolbars: Standard, Dimension

Use the Horizontal Dimension tool to display the horizontal length of an entity, or to display the Horizontal 
distance between any two points that you define in the drawing space:
1. Activate the Horizontal Dimension tool.
2. If desired, change the current dimensioning mode, as described in the Manual, Segment, and Entity 

Dimensioning.
3. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
4. Define a final point to determine the direction and length of the dimension's extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default, automatic dimension text, type the text you want in the Edit Bar prior to finishing 
the dimension, or in the attribute string of the Dimension Property Sheet.



Vertical Dimension
Menu: Insert|Dimension|Vertical Toolbars: Standard, Dimension

Use the Vertical Dimension tool to display the Vertical length of an entity, or to display the vertical distance
between any two points that you define in the drawing space:
1. Activate the Vertical Dimension tool.
2. If desired, change the current dimensioning mode, as described in the Manual, Segment, and Entity 

Dimensioning.
3. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
4. Define a final point to determine the direction and length of the dimension's extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default dimension text, type the text you want in the Edit Bar prior to finishing the 
dimension. Once the dimension is placed you can override the text in the Property sheet’s attribute string.



Parallel Dimension
Menu: Insert|Dimension|Parallel Toolbars: Standard, Dimension

Use the Parallel Dimension tool to display the absolute length of an entity (the distance between the two 
points on the entity that are farthest apart).
1. Activate the Parallel Dimension tool.
2. If desired, change the current dimensioning mode, as described in the Manual, Segment, and Entity 

Dimensioning.
3. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
4. Define a final point to determine the direction and length of the dimension's extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default, automatic dimension text, type the text you want in the Edit Bar prior to finishing 
the dimension.
Note: When dimensioning a circle or arc, you can position the parallel dimension at any angle.



Rotated Dimension
Menu: Insert|Dimension|Rotated Toolbars: Standard, Dimension

Use the Rotated Dimension tool to measure the absolute length of an entity (the distance between the 
two points on the entity that are farthest apart). Rotated dimensions are similar to parallel dimensions, 
except that the extension lines of the Rotated Dimension tool can be rotated to any angle relative to the 
entity you are dimensioning.
1. Activate the Rotated Dimension tool.
2. Define two points to draw a vector specifying the angle and direction of the dimension's extension 

lines. Alternatively, you can define the first point, then specify the angle of the vector in the Edit Bar.
3. If desired, change the current dimensioning mode, as described in the Manual, Segment, and Entity 

Dimensioning.
4. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
5. Define a final point to determine the direction and length of the dimension's extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default dimension text, type the text you want in the Edit Bar prior to finishing the 
dimension. Once the dimension is placed you can override the text in the Property sheet’s attribute string.
Note: The Segment Dimensioning and Entity Dimensioning menu items will be disabled in the local menu
until after you have completed step 2.



Datum Dimension
Menu: Insert|Dimension|Datum Toolbars: Standard, Dimension

Use the Datum Dimension tool to display dimension text along with a horizontal or vertical leader line with
an arrow pointer. The leader line is bent at right angles, allowing you to offset the dimension text. Datum 
dimensions are typically used to display a progression of measurements along the horizontal or vertical 
axis.
1. Activate the Datum Dimension tool.
2. Define the starting point of the datum dimension: This is the point where the arrow will be drawn. A 

rubberband line appears, indicating the origin of the dimension.
3. Define a second point to position the dimension text. Depending on the position of this point (in 

relation to an imaginary 65 line), TurboCAD will draw either a vertical or a horizontal dimension.

By default, a horizontal datum dimension displays the X coordinate of the starting point, and a vertical 
dimension displays the Y coordinate. You can override the automatic dimension text by typing a value into
the Text field of the Edit Bar before finishing the dimension.

Subtopics
Changing the Origin of Datum Dimensions



Changing the Origin of Datum Dimensions
By default, the automatic text of a datum dimension displays the X or Y distance from the Absolute Origin 
(0,0 in the absolute coordinate system). If you like, you can specify an origin for datum dimensions. This 
is useful if you would like to display distances relative to the entity that you are dimensioning. For 
example, if you were placing datum dimensions along a wall to show points along its length, you would 
want to set the origin by snapping to one end of the wall, then draw a series of datum dimensions relative 
to this point along the length of the wall. To set an origin for datum dimensions:
1. Activate the Datum Dimension tool.
2. Define the origin point using any snap mode or the Coordinate Fields.
3. Right-click in the drawing area and choose Set Origin.
4. Continue to draw the datum dimension as described in Datum Dimension .

Note: Once you have set the origin for datum dimensions, the origin will be saved with your drawing or 
template, and remain in effect for that drawing or template until you explicitly change it.



Baseline Dimension
Menu: Insert|Dimension|Baseline Toolbars: Standard, Dimension

The Baseline Dimension tool allows you to create a series of parallel linear dimensions that share the 
same baseline on one axis. The automatic dimension text displays the distance from the shared baseline 
to the end of the individual dimension. Before you draw the first baseline dimension in a series, you need 
to select a previously drawn linear dimension, either end of which can serve as the base for the series. 
(You would choose the left end, for example, if you were dimensioning to the right.) The previously drawn 
dimension can be any linear dimension (horizontal, vertical, parallel, or rotated):
1. Activate the Baseline Dimension tool. 
2. Click on a previously drawn linear dimension, nearest the end that you want to serve as the baseline 

for the series. A rectangle appears at the end of the dimension nearest the point where you clicked, 
indicating the position of the baseline.

3. Define a second point using an appropriate snap mode or the Coordinate Fields, relative to the 
baseline. This creates a new linear dimension displaying the distance between the baseline and this 
defined point.

4. Repeat step 2 to create a series of baseline dimensions. You can continue to do so as long as the tool
is active.

See Also: Continuous Dimension



Continuous Dimension
Menu: Insert|Dimension|Continuous Toolbars: Standard, Dimension

The Continuous Dimension tool allows you to create a series of parallel dimensions. Each dimension in 
the series displays the distance from a baseline on the previous dimension in the series to a defined 
point. If you are dimensioning from left to right, for example, the baseline of each dimension would be the 
right end of the previous dimension. Before you draw the first continuous dimension in a series, you need 
to select a previously drawn linear dimension, which will serve as the base dimension for the series. The 
previously drawn dimension can be any linear dimension (horizontal, vertical, parallel, or rotated):
1. Activate the Continuous Dimension tool. 
2. Click on a previously drawn linear dimension, nearest the end that will serve as the baseline for the 

first continuous dimension in the series. A small rectangle appears, marking the baseline.
3. Define a second point using an appropriate snap mode or the Coordinate Fields, relative to the 

baseline. This creates a new linear dimension displaying the distance from the baseline to this 
defined point. The rectangle is now displayed at the end of the current continuous dimension, marking
the new location of the baseline.

4. Repeat step 3 to create a series of continuous dimensions. You can continue to do so as long as the 
tool is active.



Angular Dimension
Menu: Insert|Dimension|Angular Toolbars: Standard, Dimension

Use this tool to dimension angles in your drawing. You can dimension:
The angle formed by any two lines.
The angle of an arc.
The angle formed by any two points on the perimeter of a circle.
A free-form angle that you create by defining a vertex node and two points.

Subtopics
Dimensioning an Angle Formed by Two Lines
Dimensioning Angles on Circles
Dimensioning Angles on Arcs
Dimensioning Freeform Angles



Dimensioning an Angle Formed by Two Lines
To dimension the angle formed between two lines:
1. Activate the Angular Dimension tool.
2. Click on the first line.
3. Click on the second line. If you now move the mouse cursor between the two lines, TurboCAD forms 

a dimension showing the inner angle. If you move the mouse cursor outside the two lines, a 
dimension will be formed showing the outer angle.

4. Click to specify the position of the dimension arc.



Dimensioning Angles on Circles
To dimension the angle formed between any two points on the perimeter of a circle:
1. Activate the Angular Dimension tool.
2. Click on the circle that you want to dimension. A rubberband line will appear, extending from the 

center of the circle to the mouse cursor.
3. Define a second point, which forms an angle with the first point you defined, with the centerpoint of 

the circle as the angle’s vertex.
4. Define a third point to specify the location of the dimension arc. If you specify a location between the 

first two points, you will dimension the inner angle; if you specify a location outside the two points, you
will dimension the outer angle. You can locate the dimension arc inside or outside the circle.



Dimensioning Angles on Arcs
To dimension the angle of an arc:
1. Activate the Angular Dimension tool.
2. Click on the arc that you want to dimension.
3. Click to specify the location of the dimension arc. You can dimension either the inner or outer arc, and

you can place the dimension either inside or outside the arc that you are dimensioning.

Note: When you use the Angular Dimension tool on an arc, TurboCAD automatically dimensions the 
angle formed by the endpoints of the arc. If you want to dimension the angle formed by any other two 
points on the perimeter of the arc, you can employ the Angle Node technique described in Dimensioning 
Freeform Angles , using snap modes to define points at the center and on the perimeter of the arc.



Dimensioning Freeform Angles
You can dimension the angle formed by any two points in the drawing space relative to a defined vertex, 
using the Angle Node option from the local menu:
1. Activate the Angular Dimension tool.
2. Right-click in the drawing area to display the local menu, then choose Angle Node.
3. Define a point, using any snap mode or the Coordinate Fields, for the vertex of the angle.
4. Define two more points to form an angle with the VERTEX NODE.
5. Define a point to position the dimension arc. You can measure either the inner or outer angle formed 

by the three points.



Radius Dimension
Menu: Insert|Dimension|Radius Toolbars: Standard, Dimension

Use the Radius Dimension tool to dimension the radius of an arc or circle. 
1. Activate the Radius Dimension tool.
2. Click on the arc or circle that you want to dimension. TurboCAD draws a dimension from the center of

the circle or arc to its perimeter. 
3. Define a second point to position the dimension on the perimeter of the circle, and to specify the 

position of the dimension text. The text can be positioned either inside or outside the circle or arc.

Alternatively, you can click on the circle or arc that you want to dimension, specify the text, angle, and 
length of the dimension in the Edit Bar, then press <Enter>.



Diameter Dimension
Menu: Insert|Dimension|Diameter Toolbars: Standard, Dimension

Use the Diameter Dimension tool to dimension the Diameter of an arc or circle. 
1. Activate the Diameter Dimension tool.
2. Click on the arc or circle that you want to dimension. TurboCAD draws a dimension through the 

center of the circle or arc to the opposed points on its perimeter. 
3. Define a second point to position the angle of the dimension and to specify the position of the 

dimension text. The text is positioned outside the circle.

Alternatively, you can click on the circle or arc that you want to dimension, specify the text, angle, and 
length of the dimension in the edit bar, then press <Enter>.



Leader Dimension
Menu: Insert|Dimension|Leader Toolbars: Standard, Dimension

Use the Leader tool to create dimension text attached to a simple line leader pointing to a location in your 
drawing. The Leader tool is similar to the Multiline tools in that it can contain an arbitrary number of 
connected line segments, which can be oriented at any angle.
1. Define the starting point of the leader (the end that is pointing toward an object).
2. Define a second point to specify the second endpoint of the line segment. TurboCAD will draw a line 

between the two points with an arrowhead on the first point.
3. If necessary, define more points, adding new line segments to the leader.
4. Type the text of the note in the field on the Edit Bar.
5. Complete the leader by double-clicking, or choosing Finish from the local menu.

You can also use the Edit Bar to create a leader. First define the starting point of the leader, then enter the
length and angle of the line segment in the Edit Bar. Press <Enter> to add a new line to the dimension 
without finishing the entity. Press <Ctrl>+<F> to complete the leader.



Viewport
Menu: Insert|Viewport Toolbar: Standard

New in TurboCAD Learning Edition is the ability to insert a Named View as an element of the drawing. 
This is useful to create callouts and other forms of detailing.
To use Insert|Viewport, you must have previously created a Named View that matches the area you now 
want to display as an inserted view. When you select Insert|Viewport, you will be prompted to draw a 
rectangle on the drawing. Place the rectangle where you want the inserted view to appear. When you 
complete the rectangle, a list of available named views will appear in a dialog. Select a named view, click 
Go To, and click Close.
If you make changes to the part of the drawing depicted in the inserted view, the inserted view will update 
to match.
To select a Viewport either use a window selection, or click near the edge of the Viewport.



Path Hatching
Menu: Insert|Path Hatching Toolbar: Standard

In TurboCAD Learning Edition you can place hatch patterns or solid color fills as independent objects 
using the Path Hatching command. As you draw the path, a thick purple line shows the path. To use: 
1. Choose Insert|Path Hatching. 
2. Draw the boundary of the hatch pattern. If the hatch boundary follows the perimeter of an existing 

entity, use the appropriate snap commands (from the local menu or by typing SEKEs) to conform to 
the entity.

3. To finish, right-click to summon the local menu, and select Close.



Insert File
Menu: Insert|File Toolbar: Standard, Insert

Use this to insert a TurboCAD or other CAD file into an open drawing:
1. Choose Insert|File to display the Insert File dialog.
2. Choose the type of CAD file you want to import from the List Files of the Type dropdown list.
3. If necessary, navigate to the directory where the graphic file you need is located. 
4. Choose the file that you want to open from the File Name list box, then click the OK button.

The complete contents of the file will be inserted into your drawing, alongside any existing objects. The 
file types that can be inserted are the same as those that can be opened in the Open dialog.
Tip: To see the entire file after it has been inserted, choose View|Zoom|Extents.
See Also: Supported File Types



Insert Picture
Menu: Insert|Picture Toolbar: Standard, Insert

Use this command to insert a picture into your drawing. The picture file can be of type WMF (Windows 
metafile), BMP (bitmap), or DIB (device-independent bitmap). Once the image is inserted, you can move 
it, copy it, or scale it. You cannot, however, rotate bitmap pictures or edit their contents.
To insert a WMF or bitmap picture:
1. Choose Insert|Picture to display the Open dialog.
2. Choose the type of graphic file you want to import from the List Files of Type dropdown list.
3. If necessary, navigate to the directory where the graphic file you need is located. 
4. Choose the file that you want to open from the File Name list box and click the OK button.

Tips: The picture you insert is actually an OLE object, so you can double-click the picture in TurboCAD 
and then edit it using Paint (or whatever bitmap editor is registered in your Windows system). 
To select a previously inserted picture, click along an edge instead of inside the picture.
Bitmap images cannot be plotted on old pen type plotters.
See Also: Insert Object, Insert File



Insert Object
Menu: Insert|Object Toolbar: Standard, Insert

The Insert Object command lets you insert OLE (Object Linking and Embedding) objects from other 
Windows applications into your TurboCAD drawing. You can edit the object from within TurboCAD using 
the features and commands of the Windows application in which the object was created (the source 
application). For example, you can insert a Microsoft Word application into your drawing and edit the text 
or graphics using Microsoft Word tools.
To insert an OLE object into your drawing, first choose Insert|Object to display the Insert Object dialog. 
You can then Choose one of two basic options by clicking the Create New or the Create From File option 
button (Create New is the default). 
See Also: Edit Links, Edit Object, Paste Special

Subtopics
Create New
Create from File
Embedded and Linked OLE Objects



Create New
The Create New option lets you embed a new OLE object from another application into your drawing.
1. Choose Insert|Object to display the Insert Object dialog.
2. If you want an icon representing the OLE object to be placed in your drawing, click in the Display As 

Icon check box.
3. Choose an OLE application from the dialog’s scrolling list: Either double-click the application’s name, 

or select it and press <Enter>. The object will appear in your TurboCAD drawing.

You can edit the object using the tools of the source application.



Create from File
The Create From File option lets you either embed or link an OLE object into your drawing based on a file
previously created in the source application. See Embedded and Linked OLE Objects for an explanation 
of the difference between embedding and linking. 
1. Choose Insert|Object to display the Insert Object dialog.
2. Click the Create From File radio button. The appearance of the dialog will change.
3. If you want the OLE object to be displayed as an icon in your drawing, click the Display As Icon check

box.
4. Check the Link check box if you want the OLE object to be linked; otherwise it will be embedded. 
5. Type the path and name of the file that you want to use in the text box, or click the Browse button and

locate the file using the Open dialog.

An OLE object based on the file will be inserted into your TurboCAD drawing. To edit the object in 
TurboCAD using the application that created the file, double-click the object, or select the object and 
choose Edit|Object. To update or edit links to a linked object, use the Edit|Links dialog.
See Also: Edit Object, Edit Links, Paste Special



Embedded and Linked OLE Objects
OLE objects that you insert can be either linked or embedded. Note these important differences between 
embedded and linked OLE objects:

Embedded objects become an integral part of your TurboCAD file, and take up more space in the 
file than a linked object. Embedded objects will move with the file if you transfer it to another computer 
system. If you make subsequent changes to the file on which the embedded OLE object was based, 
these changes will not affect the embedded OLE object.

Linked objects are references to the file on which they were based, and they retain their 
connection to that file. If you make changes to the file on which a linked OLE object is based, the changes
will also affect the linked OLE object.
See Also: Edit Links
Warning: If you move a TurboCAD file containing a linked object to another system, you will need to 
move any linked files along with the TurboCAD file. Linked OLE objects are referenced to their files by a 
specification of their drive and path. If you move the linked file to another drive or directory, Windows will 
attempt to find the linked file, but if it cannot locate the file, you will need to change the drive path and 
directory using the Edit|Links dialog.



Formatting Objects
The Format menu contains commands and tools for setting the appearance and format of drawing entities
and other objects. These features enable you to:

Format objects by setting their properties.
Combine objects into groups or blocks.
Explode groups, blocks, and objects into their constituent parts.
Apply hatch patterns to objects.
Send objects to the back and bring them to the front.
Align multiple selected objects.

Subtopics
Setting Properties
Property Toolbar
Formatting Text
Text Placement Options
Groups and Blocks
Format Menu Commands



Setting Properties
Every object in TurboCAD has a set of properties. The exact set of properties depends on the type of 
object. All drawing entities share the following common sets of properties, organized by property sheet in 
the Properties dialog:
General. The layer on which the object resides, style, and a text attribute (generally its name) associated 
with it.
Pen. The color, width, and style of lines.
Brush. Determine the characteristics of fills and hatches.
There are also many other properties associated with specific classes of entities. Dimensions, for 
example, have a large number of properties that apply specifically to them, located on the Format, 
Advanced Format, and Advanced Text property sheets. Points, double lines, text, and curves also have 
properties and corresponding property sheets specific to them.
When you set properties, you can either set the default properties for a drawing tool, or set the individual 
properties of selected objects.
Note: The Properties dialog is context-sensitive, meaning it will display only the property sheets 
appropriate to the currently selected tool (or the currently selected objects). For example, if you select a 
line segment and a double line segment, then bring up the Properties dialog, you will see the General, 
Pen, Brush, and Double-Line property sheets. You will not see the Curve property sheet because no 
curves are included in the objects you have selected.
See Also: Properties Dialog

Subtopics
Setting the Default Properties of a Tool
Setting the Properties of Selected Objects



Setting the Default Properties of a Tool
When you set the default properties of a tool, all subsequent entities drawn with that tool will have the 
settings you specified, until you explicitly change them. To access the default properties, either right-click 
on the tool icon, or activate the tool and then choose Format|Properties.



Setting the Properties of Selected Objects
The Properties dialog is context-sensitive, meaning the dialog will display the set of property sheets 
appropriate to the objects selected. If you select a double line, or a set of entities that include a double 
line entity, then bring up the Properties dialog, the properties dialog will contain the Double Line property 
sheet.
You can use this dialog to set the default properties for a drawing tool; or to set the individual properties of
a particular object or set of objects.
If you have property settings that you want to reuse, you can save them as a style, then reapply the style 
later to new entities. 
Note: Styles in TurboCAD are used to preselect tool properties, so the user can quickly access a 
predefined drawing style (blue thick dotted lines on layer 24, for example). TurboCAD does not use styles 
to adjust the properties of existing entities or objects in a drawing. 
See Also: Layers Property Sheet, Properties Dialog, Property Toolbar



Property Toolbar
The Property toolbar gives you a quick and convenient way of setting the properties of any selected 
object or set of objects, or for setting the default properties of a drawing tool. If the Property toolbar is not 
visible on the screen, you can display it using the View|Toolbars dialog. 
If no objects are currently selected, the settings on the Property toolbar apply to the active drawing tool. 
For example, if you activate any single line tool and then change the settings on the Property toolbar, the 
settings will apply to all objects drawn with any single line tool. 
If there are objects selected, settings in the Property toolbar apply to the selected objects.
Note: In TurboCAD Learning Edition you cannot apply a style to a selection. The Style pull-down box is 
accessible only when you are setting the default properties of a drawing tool.
The Property toolbar consists of eight list boxes, two fly-out toolbars, and three tools. From left to right 
they are:
Style. Use this list box to apply predefined property settings to a drawing tool. You can save styles in the 
Properties dialog. This control can be used only to set the properties of a drawing tool; it is unavailable if 
you are setting the properties of selected objects.
Layer. Use this list box to set the layer on which objects are drawn.
Color. Use this list box to set the pen color.
Pen Style. Use this list box to set the style of the line. You can use a continuous line or choose from 
several types of dotted or dashed lines.
Brush Pattern. Use this list box to choose a fill pattern for closed entities.
Pen Width. Use this list box to choose the line width.
Font. Use this list box to choose a font for text in the drawing. All TrueType fonts installed on your 
computer will be available.
Text Height. Use this list box to set the height of text.
Text Font Attributes. Use the options in this fly-out toolbar to set text to Bold, Italic, Underline, or 
Strikethrough. The text will be plain if none of these options are selected.
Text Placement. Five placement styles are available in this fly-out toolbar: Standard, Text Box, Hidden, 
Scalable, and Flexible. These placement styles are defined in Formatting Text.
See Also: Layers Property Sheet, Properties Dialog
Note: New in TurboCAD Learning Edition is the ability to set the properties of all drawing tools by 
changing the Property toolbar. This means that if no entity or object is selected in the drawing, changing 
the settings on the Property toolbar will effect every drawing tool used thereafter. If you want Property 
settings to work as they did in TurboCAD 3.0, where drawing tool properties are each set independently, 
make sure the option "Update All Styles" (Menu: Options|Toolbars and Menu) is not selected.
Note: Changing a selected object’s properties will have no effect on the default properties for new objects
drawn. 



Formatting Text
You can format text in TurboCAD using either the Property toolbar or the Text property sheet. The Text 
property sheet will be covered in Format Menu Commands . 
You can use text tools either to set default properties for the Text tool (which will be saved with your 
drawing) or you can use it to format selected text. To change default settings, activate the Text tool on the 
Standard toolbar, and then choose Text settings on the Property toolbar. These setting will stay in effect 
until you explicitly reset them. To format selected text, first select the text using the Select tool, then 
choose settings in the Property toolbar.



Text Placement Options
TurboCAD Learning Edition offers a variety of text placement options. As shown in the Text Property 
dialog, they fall into four basic categories. 
Font Attributes. These are the characteristics of text common to virtually all Windows programs. The 
elements are Font Name, Font Style, Height, and Color.
Text Mode. Text may be inserted into a drawing in one of three ways: Standard (always proportional even
if resized), Scalable (can be re-sized non-proportionally), and Flexible (pen, brush and slant options 
available.)
Text Effects. Text may be set to Strikethrough, Underline, Text Box, Hidden, All Caps.
Justification. Any block of text may be aligned to Left, Center, or Right.
See Also: Manipulating Text, Text, Text Property Sheet



Groups and Blocks
TurboCAD drawing objects can be combined into groups or blocks. The drawing objects can be entities, 
such as lines circles and arcs, or they can be other groups and blocks. You can include groups in blocks, 
and you can include blocks in groups. TurboCAD treats a block or a group as a single object for purposes 
of selecting and editing. There are two practical differences between groups and blocks:

When you create a block you store it in your drawing’s block library. This allows you to 
conveniently drag and drop the block into the current drawing, or into another drawing, from the Blocks 
palette (View|Blocks). Each "copy" of the block that you place in your drawing is called a block insert or 
block insertion.

Each group contains its own drawing data. This means that making a copy of a group increases 
the size of your drawing by the size of the group. Block inserts, on the other hand, are references to a 
single object in a drawing’s block library. You can insert multiple block inserts from the Block Palette into 
your drawing without significantly increasing the size of your drawing.
To break up a block insert or group into its constituent parts, select it, then use the Format|Explode 
command. 
The names of groups and blocks are held in the Attribute field of the properties dialog. To view or edit this 
field, activate the Select tool, and then double-click on the group or block insert.
Because groups and blocks can themselves contain groups and blocks, you can think of them as complex
hierarchical structures. This type of structure can be represented as a tree, as shown in the following 
diagram:
Tip: You can view the structure of a group or block insert by selecting it and exploring the Selection Info 
palette (View|Selection Info).
See Also: Create Block, Create Group, Explode, View Blocks



Format Menu Commands
The following table summarizes the contents of the Format menu:

Command Function

Properties Edit the properties of selected objects or the default properties of 
the current tool.

Create Hatch Draw a hatch pattern over selected objects.
Create Block Define all objects in the selection as a block and save it in the 

block library.
Create Group Define all objects in the selection as a group.
Explode Break up an object into its constituent parts.
Send To Back Send selected objects to the back of the object stack on their 

layer.
Bring to Front Bring selected objects to the front of the object stack on their 

layer.
Align Line up all selected objects on the left, right, top, bottom, vertical 

center, horizontal center, or along a line that you specify.

Properties Dialog
Menu: Format|Properties Toolbar: Standard

The Properties command displays the Properties dialog. Use this dialog to set the properties of objects, or
the default properties of drawing tools. 
The Properties dialog contains a set of property sheets. The General, Pen, and Brush property sheets are
available whenever you display the dialog. Other property sheets (Double Line, Curve, Point, Text, and 
the three dimension property sheets) are displayed only when the tool to which they apply is activated, or 
if an entity to which they apply is selected.
See Also: Select, Property Toolbar

Subtopics
General Property Sheet of Properties Dialog
Pen Property Sheet
Brush Property Sheet
Curve Property Sheet
Double Line Property Sheet
Dimension Property Sheets
Format Property Sheet
Advanced Format Property Sheet
Advanced Text Property Sheet
Point Property Sheet
Text Property Sheet
Block Insertion Property Sheet
Group Property Settings
Viewport Property Sheet



General Property Sheet of Properties Dialog
The General property sheet of the Properties dialog lets you:

Select the layer of the drawing on which objects are drawn.
View or edit an object's text attribute.
Select a style (a set of pre-defined property settings).
Save a set of property settings as a new style, or edit the property settings of an existing style.

The property sheet contains the following controls:
Attribute. To give selected objects a text attribute, click in the Attribute text box and type in whatever 
information you want to record. For groups and blocks, the Attribute text field holds the group or block 
name. This field is also used to hold the text string for Text and Dimension entries.
Layer. To set the layer property, which determines the layer on which entities are drawn, click on the 
Layer drop-down list box, then click on the desired layer. You can create new layers using the Layers 
dialog (Options|Layers).
Style. A style is a set of saved property settings. You can select and edit existing styles.

Subtopics
Selecting, Editing, and Creating New Styles



Selecting, Editing, and Creating New Styles
To select a style that has already been defined, click the down arrow on the right side of the Style text box
and then click to select the style from the drop-down list that appears. The property settings that define 
that style will now become the default property settings of the tool, the properties of which you are editing.
Note: Styles are applicable only if you are setting the default properties of a drawing tool. You cannot 
apply a style to selected objects, nor can you define a style based on the properties of selected objects.
To edit an existing style:
1. Select the style from the drop-down list.
2. Make changes to settings in the Properties dialog, in any of the property sheets that are available in 

the dialog.
3. Click the OK button to close the dialog.

To create a new style:
1. If you like, select a style that you want to use as a basis for a new style. (If you skip this step, then 

you will use whatever style is currently selected.)
2. Select a style name in the text box and type a name for the new style.
3. Click the New button. This creates a new style that has all the property settings of the style you 

selected in step 1.
4. Make any changes you like to settings in the property sheets, then click the OK button. The property 

sheet settings will be saved in the new style, which will be available the next time you open the 
Properties dialog for the tool for which you are setting properties.

Note: There are separate sets of styles for points, single-line entities, double-line entities, arcs, curves, 
dimensions, and text. Circle and arcs share the same set of styles. The set of styles available to you 
depends on the tool whose properties you are modifying.



Pen Property Sheet
The Pen property sheet lets you set properties of the drawing pen, such as its pattern, color, and 
thickness.
The Pen property sheet contains the following controls:
Pattern. Scroll through this list to choose a pattern for the line. You can choose either a continuous line or
one of many dot-and-dash patterns. The available line patterns are the styles most commonly used in the 
various drafting and design professions. The exact look of any particular pen pattern depends on the 
settings in Dash Scale, Width Scaling, and Width. In addition to specific patterns, By Layer and By Block 
settings are also available. If the pen pattern is set to either By Layer or By Block, the pattern can change 
as the setting for the particular layer or block changes. 
Alignment. Click this box if you want the pattern to align itself so that the corners of rectangles and 
polygons are always solid.
Color. Click in this box to choose a color for the drawing pen. If you select By Layer, the pen color will be 
set to the default color of the object's layer. This color is set in the Layers property sheet. If you select By 
Block, you will be able to modify the pen color of any object drawn after it becomes part of a block. If By 
Block is not the color option, the object’s pen color will stay even if it is part of a block.
Note: You can create new colors using the Color Palette property sheet (Options|Color Palette).
Dash Scale. You can modify the factor in this box to set the scale of the pen's dot-and-dash pattern. For 
example, if you set the scale to .5 (instead of 1, the default), the dots and dashes will be half the default 
scale, and the pattern will therefore be repeated twice as often.
Width Scaling. This setting determines whether the width of the line will be scaled, or remain the same 
size, when you zoom in and out of the drawing. If you select Device, the width will be scaled relative to 
your computer screen, and will remain the same size at any magnification. If you choose World, then the 
width will be scaled with your drawing and will change size as you zoom in and out. This setting also 
applies to the size of the elements in the pen's dot-and-dash pattern.
Width. Click in this box to choose a width for the pen, or type a custom width directly into the box. (To set 
the unit of measure for the Pen Width, use the Advanced Units property sheet.) Zero width uses the width 
of one screen pixel, and will print at one unit of the printer’s available resolution (a 300 dots-per-inch 
printer will print a zero width line at 1/300".)
See Also: Advanced Units Property Sheet, Layers Property Sheet



Brush Property Sheet
The Brush property sheet lets you set fill properties of objects, as well as the properties of hatch patterns. 
Fills and hatches appear only on closed entities, such as circles and polygons, and Flexible text.
The Brush property sheet contains the following controls:
Pattern. To change the fill pattern, scroll through the Brush Style list box and click to select the pattern 
that you want. The name of the pattern will be displayed just above the Brush Style list box.
Color. To change the color of the fill, click on the Color drop-down list box, then scroll through the list and 
click to select the color that you want. Choose By Pen if you want the Brush color to match the Pen color. 
Choose By Layer or By Block if you want the color to match the default color of the object's layer (set in 
the Layers property sheet) or any setting applied to a block containing the object.
Note: You can create new colors using the Color Palette property sheet (Options|Color Palette).
Hatch. Use the Hatch controls to control the scale and angle of the fill pattern. The default scale of the 
pattern is 1(inch or mm, depending on your setup), so increasing it to 2 doubles the size of the pattern 
elements, and decreasing the scale to .5 halves the size of the components. Use the Angle spin button to 
change the angle of the hatch pattern, rotating it inside the filled entity (or type a custom value directly into
the text box). If you check the Cross Hatch check box, the pattern will be drawn across the entity a 
second time, in a direction perpendicular to the first pattern. This gives you many more choices of hatch 
patterns.
Origin. New to TurboCAD Learning Edition is the ability to modify the hatch origin. By default, hatch 
patterns use the drawing’s origin point (0,0 on the coordinate grid) as a point of reference. If you want to 
modify the placement of hatches without changing their angle, you can modify the point of origin used to 
place the hatch. World refers to the drawing’s origin point, Entity refers to the object being hatched. A 0,0 
Entity origin refers to the lower left corner of the object. You can offset an origin point for the hatch to 
either the    X (horizontal) or Y (vertical), or both. 
Draw Mode. Choose an option button in this group to specify how hatch patterns are drawn over 
overlapping objects. Choose the Winding option if you want the hatch pattern to cover areas where filled 
entities overlap. Choose Alternate if you want the hatch pattern to be drawn on every other overlapping 
layer, creating an alternating pattern.
See Also: Color Palette Property Sheet, Property Toolbar



Curve Property Sheet
The Curve property sheet is visible when a Bezier, Spline, or Sketch (freehand) curve entity is selected, or
when a curve tool is active and no entities are selected. 
The Curve property sheet contains the following controls:
The number of segments between adjacent control points. Curves are composed of a number of 
minuscule line segments drawn between control points. Bezier curves intersect the control points; Spline 
curves gravitate toward the control points but do not intersect them. Use this spin control to set the 
number of line segments drawn between each control points. Large numbers will round the contours of 
the curve; small numbers will flatten out the contours.
Show Frame. Check the Show Frame check box to display a multiline frame connecting the curve’s 
control points. This provides visual feedback about how the curve is drawn.
Curve Type. Use the Curve type option buttons to set whether the curve is drawn as a Bezier or Spline 
curve.
See Also: Curve Tools



Double Line Property Sheet
The Double Line property sheet is visible only when a double line entity is selected, or when a double line 
tool is active and no entities are selected. 
The Double Line property sheet contains the following controls:
Separation. To set the distance between the two lines of the double line, specify the distance in the 
Separation text box.
Reference. Use the Reference option buttons to determine the alignment of the double line nodes. These
points determine how the double line will align itself to coordinate positions when you draw or position the 
line. You can set the double line nodes to align to its left line, its right line, or to a center point exactly 
between the two lines. (You can edit these nodes directly in Node Edit mode).
End Caps. Click in the Start and End check boxes to determine whether the start point and end point of 
double lines are open or closed.
See Also: Double Line Tools



Dimension Property Sheets
Dimensions consist of three basic components: 

The dimension lines, with arrows pointing to either end of the dimension.
Extension lines, which connect the dimension line to the object being dimensioned.
Dimension text, normally displaying the distance being dimensioned in World units.

Subtopics
Parts of a Dimension



Parts of a Dimension
Extension lines have optional line segments that continue the extension outward beyond the dimension 
line (extensions to the extension).
A dimension can have interior dimension lines, or two exterior dimension lines. Exterior dimension lines 
can be supplemented with an optional interior line.
The three dimension property sheets contain options that let you precisely format dimension lines, 
extension lines, and text:
Format. Lets you format the shape of dimension arrows and set the position of dimension text relative to 
the dimension line and extension lines.
Advanced Format. Gives you precise control over the drawing of dimension lines and extension lines.
Advanced Text. Gives you precise control over the appearance of dimension text.
See Also: Dimension Tools



Format Property Sheet
The Format property sheet gives you control over the shape of dimension arrows and the position of text 
relative to the dimension line.
The Arrowhead group contains the following controls:
1st and 2nd. Click in these drop-down boxes to choose dimension arrow shapes. The arrowheads can 
have angles of either 30 or 45 degrees; they can be filled, open, or closed. If you like, you can choose 
None (no arrow at all), Tick (a simple angled line), Solid Dot, or Hollow Dot. 
Size. Click in this control to choose a size for the length of the arrowhead, (or diameter of the dot) or type 
in a custom size.
Tick Extension. If you set the arrowhead to Tick in the 1st and 2nd boxes, you can specify the length of 
the tick's extension line in the Tick Extension control
The Text group contains the following controls:
Font. Click in this box to choose a TrueType font for the dimension text. All TrueType fonts installed on 
your system will be available.
Height. Click in this text box to choose a text height, or type in a custom height. You can set the height in 
either World or Paper units, depending on the current mode. (Setting height to paper units will allow the 
option of using points for text measurement units.)
Position. Choose Outside if you want the text placed outside of the dimension line, Above if you want the 
text "above" the dimension line ("above" is relative to the orientation of the text, not relative to your 
screen), or On Line if you want to place the text directly on the dimension line. This position can be 
manually adjusted.
On Line Adjustment. Type a number into this text box to specify the distance of the text above or below 
the dimension line. A value of zero (the default value) will place the text on the same level as the 
dimension line. Higher values move the text above the line ("above" is relative to the orientation of the 
text); lower (negative) values move the text below the line.
Force Text Horizontal. Check this box if you want the dimension text to be horizontal no matter how the 
dimension is rotated.
Force Dimension Text Inside Extension Lines. Click this box if you want to keep dimension text 
between the extension lines, regardless of the distance between the extension lines. If you leave this box 
unchecked, TurboCAD will decide whether to place dimension text inside or outside the extension lines.



Advanced Format Property Sheet
The Advanced Format property sheet includes options for drawing the dimension and extension lines, as 
well as an option for scaling the size of dimensions relative to your drawing. If you're not sure what any of 
the terms mean in this section, read the section Parts of a Dimension .
The Dimension Line group includes the following controls:
Force Interior Line. Check this box if you want the dimension to have an interior dimension line even if 
the text is outside the extension lines. If you leave this box unchecked, TurboCAD will draw the interior 
dimension line only if the dimension text is inside the extension lines.
Do Not Draw. Click First Line if you don't want TurboCAD to draw the first dimension line; click Second 
Line if you don't want TurboCAD to draw the second dimension line. Click Outside Extension if you don't 
want TurboCAD to draw the outside extension line.
Baseline Increment. Type a number in this box to set the distance between each dimension in a series 
of baseline dimensions.
Color. Click in this box and choose a color if you want the dimension lines to have a different color to 
distinguish them from the other parts of the dimension.
The Extension Line group includes the following controls:
Extension. The number in this box determines the length of the extension line segments that extend 
outward beyond the dimension lines. You can enter a value in the box to specify the length of these 
segments.
Offset. Type a value in this box if you want to specify the distance between the extension lines and the 
object that is being dimensioned. 
Do Not Draw. Click First Line if you don't want TurboCAD to draw the first extension line; click Second 
Line if you don't want TurboCAD to draw the second extension line.
Color. Click in this box and choose a color if you want the extension lines to have a different color to 
distinguish them from the other parts of the dimension.
At the bottom of the property sheet you will find a Dimension Size Scale text box. This box controls the 
size of the dimension text and arrows relative to the rest of your drawing. If you use the default setting of 
1, the dimension text will be printed at the size specified in the Height box on the Format property sheet. 
Tip: Choose a smaller scale if you want to dimension details in the interior of your drawing.
See Also: Parts of a Dimension



Advanced Text Property Sheet
The Advanced Text property sheet contains controls for precisely formatting the appearance of dimension 
text, and for controlling the display of tolerances. (Tolerances are a number indicating the amount of 
allowable deviation from the distance shown in the dimension.)
The Appearance group contains the following controls:
Text Gap. Type a number in this box if you want to specify the distance between the dimension text and 
the dimension line.
Round Off. Type a number in this box to indicate the decimal place to which the dimension text will round
off. If you type a value of 0.1, for example, the text will be rounded off to tenths of a unit. A value of 0.001 
will generate a round off at thousandths of a unit. Round Off and Trailing Zeros, in this property sheet, and
Units and Scale|Precision (in the Options menu) are closely linked. 
Linear Measurement Scale. The default value for linear measurement scale is 1, which means, for 
example, that a dimension will display 1 inch if it is dimensioning a distance of 1 inch in World units. The 
Linear Measurement Scale control allows you to change the scale of the value displayed by the 
dimension text relative to World units: If you enter a value of .1, for example, the dimension will display a 
value of .1 inch when dimensioning a distance of 1 inch in World units. 
Tip: You will probably want to leave Linear Measurement Scale unchanged, unless you have an inset in 
your drawing that uses a different scale than the rest of your drawing.
Color. Click in this box to choose a color for the dimension text.
Append Units. Check this box if you want the dimension text to display its unit of measure.
Trailing Zeros. Check this box if you want trailing zeros to appear in the dimension text. For example, if a
dimensioned line is exactly 2.34 units long, Precision (Options|Units and Scale|Precision) is set to 4, and 
Round Off is set to 4, the dimension text will read 2.3400. 
Trailing Zeros, Round Off and Precision are interrelated, and need to be considered as a group when 
establishing dimension settings. If Round Off is less than Precision, dimension text may not accurately 
reflect the exact measurement. If Round Off is greater than Precision, then Trailing Zeros will show the 
additional available precision if Trailing Zeros is set to a value equal to Precision. For most applications, 
Precision and Round Off should be set to the same level (a Precision of 4 is the same as a Round Off of 
0.0001). Trailing Zeros should then be used if necessary to display the level of precision in use. Trailing 
Zeros is not applicable when fractions (Options|Units and Scale|Format:Fractional) are in use. 
Tolerance is a notation showing the allowable difference from the design. The Tolerance group contains 
the following controls:
Append. Check this box if you want the dimension text to include a tolerance. The other controls in the 
group are available only if this box is checked.
Relative Height. Type a value in this box to set the height of the tolerance relative to the rest of the 
dimension text. If you type a value of .5, for example, the tolerance will be half the height of the rest of the
dimension text.
+ve. Type a value in this box to set the amount of positive tolerance.
-ve. Type a value in this box to set the amount of negative tolerance.



Point Property Sheet
The Point property sheet is included in the properties dialog only when a point entity is selected, or when 
a point tool is active. It includes settings for changing the size of a point, its shape, and its color.
The Point property sheet contains the following controls:
Size. Type a value in this box to set the width and height of the point. This value affects all types of points 
except the dot, which is always displayed at a minimal size. You can set the size in either World or Paper 
units, depending on the current mode. (Check the icon at the upper-left corner of the ruler to see whether 
TurboCAD is showing World or Paper units.)
Point Type. Click in an option button to select the type of point (dot, star, square, cross, or circle).
Color. Click in this box and scroll to choose a color for the point from the color palette.



Text Property Sheet
The Text property sheet is included in the Properties dialog only when a text entity is selected, or when 
the text tool is active. It includes options for setting font, style, height, color, text effects, and text 
justification.
The Text property sheet contains the following controls:
Font. Click on this box and scroll to select a TrueType font for the text. All the TrueType fonts that are 
installed in your system will be available. 
Height. Click in this box and scroll to choose a text height, or type a custom text height directly into the 
box. You can set the height in either World or Paper units, depending on the current mode. (Note that text 
can be measured in points only if you are using Paper units.)
Style. Click in this box to choose a text style (Normal, Italic, Bold, or Bold Italic). These four styles are 
defined within the font, and are not available for every TrueType font.
Color. Click in this box and scroll to select a color for the text from the color palette.
Mode. Three text placement modes are available in TurboCAD Learning Edition: Standard (always 
proportional even if resized), Scalable (can be re-sized non-proportionally), and Flexible (pen, brush and 
slant options available.) 
Obliquity. The Obliquity option is active if Flexible is the current text placement mode. Think of Obliquity 
as slant. The numbers are for degrees of slant, i.e., 1 is one degree of slant to the left, -1 is one degree of
slant to the right. 
Effects. Check the options in this box to turn on any of these text effects: Underline, Strikethrough, Text 
Box (a simple border around the text), Hidden (used for notes that you don't wish to display), and All 
Caps.
Justification. Click an option button to choose whether the text is left-, center-, or right-justified. When 
you are creating text, left-justified text is typed to the right of the insertion point; right-justified text is typed 
to the left of the insertion point, and center-justified text is centered on the insertion point.
Note: If you change the justification of existing text, the change will have an effect only if the existing text 
has multiple lines.
Tip: You can get more precise control of the placement of text relative to the insertion point by using the 
Align feature. You can access this feature by right-clicking in the drawing area while the Text tool is active,
and then choosing the Align... command from the local menu. The Align feature can only be applied to 
text as it is being drawn; you can't use it to format existing text.



Block Insertion Property Sheet
This property sheet will be available if you are formatting the properties of a block insertion. It is not used 
for formatting the default properties of any tool. This property sheet has settings in three dimensions, 
specifically for dealing with blocks imported from TurboCAD 3D.
The Block Insertion property sheet contains the following controls:
Position. Shows the location of the selected block’s insertion point on the X, Y and Z (for 3D) axes. 
Changing any of these values will move the block to a new location.
Rotation. Specify values in these fields to rotate the 3D block insertion around its X (vertical), Y 
(horizontal), and Z (depth) axes.
Scaling. Specify values in these fields to scale the 3D block insertion on its X, Y, and Z axes.



Block Attribute Definition
Menu: Insert|Block Attribute Definition 

TurboCAD Learning Edition includes AutoCAD style Block Attributes.    A block attribute is an informational
text associated with a block that you can enter whenever you insert a block reference, or when the block 
is first created. TurboCAD reads and displays block attributes from AutoCAD drawings (DWG) and DXF 
files.
To create a block attribute definition in TurboCAD:
1. Choose Insert|Block Attribute Definition.    
2. Define a start point for the block attribute text as you would with a normal text.    
3. Choose a point on or near the graphics to be included in the block.    
4. Type a text of the block attribute.
5. Right-click to change the alignment, height or angle of the text. 
6. Enter a "Tag" name (for example, "COST") for the block attribute.    This name is used to uniquely 

identify the attribute within the block. Use no spaces in the name if you will be sending the drawing to 
AutoCAD. Don't hit Enter yet.

7. If necessary you can enter the prompt and default value in the edit bar, or edit these properties later. 
(For our example, use the tab key to enter the prompt "What does it cost?" in the edit bar Prompt field
and value of $0.00 in the Default field.)

8. Press Enter to finish the definition.    

Note: Once the block attribute is selected, you can double-click it and choose the Block Attribute 
Definition tab to change the Tag, Prompt, default Value and Mode. 
Blocks can contain more than one block attribute definition, so you might create a number of tags (for 
instance, asking for the Part Number, Owner, etc.).
When you are satisfied with the definitions, simply include them in the selection of objects that will make 
up the new block. When you insert the block, a dialogue will appear that gives the prompt and offer the 
default value. (For the given example,    you get the prompt "What does it cost?" and offer $0.00 as the 
default value.)
The behavior of the dialogue depends on the following optional modes: Invisible, Constant, Verify, and 
Preset. 
The Invisible mode
The text of the block attribute is not displayed in the drawing.    You can see the information in the 
Selection 
Info palette or edit it by displaying the block's properties.
Warning: When you explode a block containing invisible block attributes the information is lost.
The Constant mode
The attribute value is fixed and unchangeable.    It is shown to you during block insertion.    Exploding the 
block will turn the block attribute into text that can then be edited.
The Verify mode
In AutoCAD, the attribute value is shown for your verification during block insertion if the AutoCAD    
variable ATTDIA is set to 0.    This flag has no effect in TurboCAD as it takes place in AutoCAD when the 
variable ATTDIA is set to 1.
The Preset mode
In AutoCAD, you are not prompted for a value if the AutoCAD variable ATTDIA is set to 0. This flag has no
effect in TurboCAD as it takes place in AutoCAD when the variable ATTDIA is set to 1.
If necessary, you can set any of modes through the Block Attribute Definition tab of the Properties dialog. 



To access this tab, TuboCAD provides you with the Block Attribute button    (a picture of a tag) in the 
standard toolbar. If the button is out of view, click and hold the text tool (capital 'A') to see the fly-out menu
containing this tool. Right-click on the tool and select the Block Attribute Definition tab to customize the 
mode and default information. 



Group Property Settings
Items saved as a group have two adjustable properties, Attribute (the name of the group), and Layer. To 
rename a group or to change its layer, double-click on a group, or select Properties from the local menu 
when the group is already selected. 
The default property settings of the line tool used to create the group will be the default properties for the 
group when created. 



Viewport Property Sheet
Property settings are available for any viewport inserted into a drawing. To access the property sheet, 
double-click on the viewport boundary, then click on the Viewport Tab when the Property dialog appears. 
You may select a new view for the viewport from this property sheet. 



Create Hatch
Menu: Format|Create Hatch Toolbar: Standard, Hatch Fly-out

The Create Hatch command applies a hatch pattern to selected entities.
1. To set the hatch pattern you want to use, right-click on the Hatch tool to bring up the Properties 

dialog, then click the Brush tab to bring the Brush property sheet to the front. Or, follow these steps 
using the Properties toolbar prior to selecting the objects to hatch.

 

2. Formatting a hatch pattern is essentially the same as formatting a fill pattern, so you can refer to 
Brush Property Sheet for a description of the property sheet options. Choose the pattern and other 
options you need (to change Hatch, Origin, or Draw Mode options, you need to access the property 
sheet.)

3. Use the Select tools to select the object or objects that you want to hatch.
4. Click the Hatch tool (or choose Format|Hatch) to apply the hatch pattern to the selection.

Note: A hatch pattern, unlike a fill pattern, is an object independent of the objects to which it has been 
applied. You can select the hatch and manipulate it independently.
Note: It is important to select the objects to be hatched after setting the properties, so that you do not 
change the properties of those objects. The hatch obtains its properties from the default settings, not the 
settings of the selected objects.
See Also: Brush Property Sheet



Create Block
Menu: Format|Create Block Toolbar: Standard

Use the Create Block command to combine any currently selected objects into a block. Objects can 
include drawing entities, pictures, OLE objects, groups, and blocks.
1. Use any selection method to select a set of objects. You may draw a selection rectangle with the 

Select tool, or <Shift>+<Click> on items to add them to a selection set. 
2. Click the Create Block tool or choose Format|Create Block from the menu. If Options|Auto-Naming|

Blocks|Prompt For Name is checked, the Create Block dialog appears.
3. Type a name for the new block in the Block Name text box. If you wish to leave a copy of the block at 

the current location in the drawing, check the Insert at Current Location check box. If you do not 
check Insert at Current Location, the selected objects will be removed from the drawing and will only 
be available in the Block palette.

4. Press <Enter> or click OK to store the block.

The next time you open the Block palette using View|Blocks, the new block will be on the palette.
Note: The block will take on the default layer of the Line properties. To select the layer on which the block
will appear, right-click the Create Block tool (Standard toolbar) to bring up the Line properties.
See Also: Create Group, Groups and Blocks, Explode, View Blocks



Create Group
Menu: Format|Create Group Toolbar: Standard

Use the Create Group command to combine any currently selected drawing objects into a group.
1. Use any selection method to select a set of drawing objects. You can select drawing entities, groups, 

or blocks.
2. Click the Create Group tool or choose Format|Create Group from the menu.

Note: The group will take on the default layer of the Line properties. To select the layer on which the 
group will appear, right-click the Create Group tool (Standard toolbar) to bring up the Line properties.
See Also: Create Block, Groups and Blocks, Explode



Explode
Menu: Format|Explode Toolbar: Standard 

Use the Explode command to break up any object into its constituent parts. You can explode an object or 
group of objects by selecting them, then choosing Format|Explode.
When you explode an object, you break it down to the next level of constituents. For example, you might 
explode a block that contains a block, a group, a line segment, and some text. After exploding the block, 
you could then explode its constituents: the group into its parts, the block into its parts, and the text into 
polylines.
TurboCAD Learning Edition allows you to explode all selected objects. The explosion is still one level 
deep, to allow control over objects with multiple levels of association.
Tip: You can use Explode to break hatch patterns into constituent entities, to break text into polylines, and
curves into lines. You can also explode double-line entities into groups of single-line entities. This is useful
if you would like to scale the width of double lines along with an object that contains the double lines.
See Also: Create Block, Create Group, Groups and Blocks, View Blocks



Bring to Front and Send to Back
In a TurboCAD drawing, objects on each layer are stacked in the order that you create them, from back to
front. The object at the front of the stack is visible on top of all other objects on its layer. The object 
furthest to the back of the stack is overlapped by all other objects on its layer.
TurboCAD provides two commands, Bring to Front and Send to Back, that will change the order of the 
entities in the stack, bringing the selection to the front, or sending it to the back.
Warning: The Bring to Front and Send to Back commands will not function as you expect if the objects 
are on different layers and the layers have different redraw order values. The redraw order value of each 
layer is set in the Layers property sheet. Layers with higher redraw order values will always be in front of 
layers with lower redraw order values. If the objects are on different layers and the layers have equal 
redraw order values, then Bring to Front and Send to Back will work across layers.
Tip: If you want to systematically place some categories of objects in front of others, use the redraw order
property of layers.
See Also: Layers Property Sheet

Subtopics
Bring to Front
Send to Back



Bring to Front
Menu: Format|Bring to Front Toolbars: Modify, Standard

Use the Bring to Front command to bring any currently selected entities to the front of the entity stack. 
This command is especially useful when you are dealing with overlapping filled entities, or bitmaps.
1. Select the object or objects, using any selection method, that you want to bring to the front of the 

entity stack.
2. Choose the Bring to Front command.



Send to Back
Menu: Format|Send to Back Toolbars: Modify, Standard

Use the Send to Back command to send any currently selected entities to the back of the entity stack. 
This command is especially useful when you are dealing with overlapping filled entities, or bitmaps.
1. Select the object or objects, using any selection method, that you want to send to the back of the 

entity stack.
2. Choose the Send to Back command.

Note: Sending an object to back has no effect on its layer, and changing its layer has no effect on its 
position in the entity stack. 



Align Commands
Use the Align commands to line up any currently selected objects. With all the Align commands except 
Along Line, the objects are lined up relative to the bounding box of the selection. The bounding box is a 
virtual rectangle that completely contains all of the selected objects. (Because TurboCAD draws a frame 
around the objects you have selected, you can see the extents of the bounding box.)
The following table summarizes the Align commands:

This Command… Aligns Objects…
Align Bottom Along the bottom of the bounding box.
Align Middle Along a virtual horizontal line passing throughout the vertical 

center of the bounding box.
Align Top Along the top of the bounding box.
Align Left Along the left edge of the bounding box.
Align Center Along a virtual vertical line passing throughout the horizontal 

center of the bounding box.
Align Right Along the right edge of the bounding box.
Align Along Line Along a construction line at a position and angle that you 

specify.

Align Bottom
Menu: Format|Align|Bottom Toolbars: Align, Standard

Use Align Bottom command to align the bottom edges of the currently selected objects along the bottom 
of the selection’s bounding box.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Bottom command from the menu or toolbar.



Align Middle
Menu: Format|Align|Middle Toolbars: Align, Standard

Use the Align Middle command to center the selected objects vertically in the selection’s bounding box.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Middle command from the menu or toolbar.



Align Top
Menu: Format|Align|Top Toolbars: Align, Standard

Use the Align Top command to align the top edges of the currently selected objects along the top of the 
selection’s bounding box.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Top command from the menu or toolbar.



Align Left
Menu: Format|Align|Left Toolbars: Align, Standard

Use the Align Left command to align the left edges of the currently selected objects along the left edge of 
the selection’s bounding box.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Left command from the menu or toolbar.



Align Center
Menu: Format|Align|Center Toolbars: Align, Standard

Use the Align Center command to center the currently selected objects at the horizontal center of the 
selection’s bounding box.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Center command from the menu or toolbar.



Align Right
Menu: Format|Align|Right Toolbars: Align, Standard

Use the Align Right command to align the right edges of the currently selected objects along the right 
edge of the selection’s bounding box.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Right command from the menu or toolbar.



Align Along Line
Menu: Format|Align|Along Line Toolbars: Align, Standard

The Align Along Line tool differs from the other Align tools, in that it aligns the selected objects relative to 
a line that you place at any position an angle in the drawing space.
1. Select all the objects that you want to align, using any selection method. TurboCAD will create a 

rectangular frame around the selection.
2. Choose the Align Along Line tool from the menu or toolbar.
3. Click the mouse at the point where you want to place the virtual line. TurboCAD will draw a line 

through the point of the mouse click. (This line behaves like an angular construction line.)
4. Define a second point for the line to pass through: The two defined points determine the angle of the 

line.

The virtual line disappears as the selected objects are aligned along it.



Customization and Data Management
The Tools Menu provides four features for TurboCAD Learning Edition: Customize, Database, Run Scripts
and Measurement. The Tools Menu has three features for TurboCAD Learning Edition: Customize, Run 
Scripts and Measurement. Run Scripts and Measurement have the same functionality in both products.
Customize for TurboCAD Learning Edition allows you to change all elements of the user interface to meet
your specifications. You can create new toolbars, change the TurboCAD menu, or change/add keyboard 
shortcuts. Customize for TurboCAD Learning Edition will only allow you to load different predefined user 
interfaces.
The Database tools on TurboCAD Learning Edition can be used to create reports using drawing data and 
other information that you provide.
Use the Run Scripts dialog to run scripts written for TurboCAD. There are several very useful scripts 
located in the scripts folder.
Use the Measurement dialog to gather information about objects in your drawing. You can measure 
distance, area, angles, or coordinates in any drawing unit.
Customize, Database and Measurement are new features in TurboCAD Learning Edition. Experienced 
TurboCAD users will especially appreciate the additional power and versatility these commands offer.
Note: Database and complete Customize features are only available in TurboCAD Learning Edition. 
The Customize dialog in TurboCAD Learning Edition has four tabs: Toolbars, Menus, Keyboard, and 
Setup. Unless you separately save the user interface changes you make, they become a permanent part 
of the TurboCAD default user interface. If two or more users share access to one copy of TurboCAD, you 
can save a set of interface settings for each user by name.
Tip: If you use TurboCAD at more than one screen resolution, you may create a separate custom desktop
for each resolution. TurboCAD has different default interfaces for different resolutions. You will need to 
restart TurboCAD once the screen resolution has been changed in order to load the default for that 
resolution. 
Note: The commands in the Customize dialog do not affect program and drawing settings (the various 
defaults such as the type of coordinate system in use, grid size, color settings, etc.) 
See Also: Options Menu and Dialogs

Subtopics
Customization Options
Measuring Objects
Run TurboCAD Scripts
Database Management in TurboCAD
Tools Menu Commands



Customization Options
Almost every aspect of the TurboCAD Learning Edition user interface can be modified by the user. The 
Customize dialogs provide a variety of commands and tools for this purpose. Specifically, you can:

Create new toolbars with varying operational styles
Create new menus
Create keyboard shortcuts for TurboCAD commands
Load and save the alternative configuration files used to store your customizations.

No two experienced TurboCAD users approach the program in the same way. These features make it 
possible to reorganize the desktop to match individual work styles. 
Note: TurboCAD Learning Edition users can only load predefined interface configurations.

Subtopics
Why Change the Desktop?
Creating New Toolbars
Create new menus
Create keyboard shortcuts for TurboCAD commands
Manage configuration files



Why Change the Desktop?
When the topic of customization comes up, some people say "Why bother? Just learn to use the program 
the way it comes out of the box." Consider the following three scenarios, each offering a valid reason to 
customize the TurboCAD desktop.
Limited need. A set designer uses TurboCAD to create diagrams for outdoor stage shows. The tools and 
commands she needs most are a relatively small subset of the program’s features. She only uses three 
line tools and one circle tool, and generally ignores the other entity tools. After a while, the designer 
realizes she can remove all the existing toolbars on the desktop, replacing them with one toolbar along 
the top, making more room available for viewing the drawing. The three line tools and one circle tool she 
uses can be combined into one fly-out toolbar; three important tools now occupy one icon width on her 
new toolbar. 
Preference for the keyboard. In this era of Windows icons and toolbars, a facilities manager who misses
DOS still prefers to use keyboard shortcuts as much as possible. He uses [Alt]-[F4] to close the program, 
and knows that the [Alt]-I, L, S keystroke sequence will select the Single Line command. To him, to 
remove your hand from the keyboard and not draw a line is a waste of time. The ability to link TurboCAD 
commands to keystrokes will not only save this user time, but decrease interruptions in the creative 
process. 
Training new users. A network support manager for a Fortune 500 company manages a group of 25 
network technicians. Each technician must maintain accurate diagrams for their areas of responsibility. 
The manager creates custom menus and toolbars for each technician’s copy of TurboCAD, increasing 
staff productivity and shortening learning time. 



Creating New Toolbars 
You may create new toolbars using almost every command and tool in TurboCAD. You start a new toolbar
by selecting Customize from the Tools menu. Select which style of toolbar you will create (Standard, 
Tabbed, or Fly-out). Drag the New button out of the Customize dialog and onto the desktop. After 
providing a name for the new toolbar, use the Categories list to find the specific tools or commands you 
wish to assemble into a toolbar. The toolbar icons for each command will appear in the Buttons field. 
Select a category, then click on a button to see its description at the bottom of the dialog. If you want to 
add the button to your new toolbar, drag it into the toolbar.
Three operation styles are available for new toolbars. Standard arranges buttons in a single row along the
length of the toolbar. Tabbed allows two or more sets of tool icons to share a single toolbar; a tab is 
attached to each set. Fly-out can be used to link a set of related tools; only the first tool in the set is visible
until you place the cursor on the tool then press and hold the first mouse button to display the rest of the 
tools in the set.
One or more Fly-out toolbars may reside in a Standard or Tabbed toolbar. If you create a toolbar with 
Tabbed tools, all the tool icons must belong to one of the tab groups. If you want to mix toolbar styles (a 
fly-out inside a tabbed toolbar, for example), each style of toolbar needs to be created separately first. 
Then you can merge one style into another as desired. See Creating a Mixed Toolbar for detailed 
instructions
Note: Most of the drawing tools in TurboCAD use fly-out toolbars. The first item in a fly-out group always 
has a small yellow triangle in the lower right corner of the icon. 
The existing pieces of the TurboCAD desktop are saved as a unit in a configuration file. As you create 
new toolbars, they should be saved into a different configuration file, to keep them separate from the 
existing desktop configuration. Save new toolbars, menus, and keyboard shortcuts using the Save In 
button. To create a new configuration, click the list box arrow beneath the Save In button, type a name for 
the new configuration, then press the Save In button. The toolbars or other customizations will be saved 
to the new configuration file.
Tools Menu Commands    contains detailed procedures for creating each type of toolbar.



Create new menus
Custom menus may be created using the Tools|Customize|Menus dialog. To create a new menu, the 
steps are: 
1. Open the Customize Menus dialog.
2. Select the top-level item [Menu Bar] in the Change What Menu list.
3. Click on the Add Submenu button. 
4. Name the new menu and Click OK. 

Once you have created a new menu category, you may add commands to it, as follows:
1. Choose the command to be added, by selecting its original menu location from the Category list, then 

by selecting the actual command. 
2. In the Change What Menu list, select the menu which will receive the new command. Usually this is 

the new menu category defined above, but you could add a command to an existing menu. 
3. Select a location in the new menu list from the Position On Menu list box.
4. Optionally, rename the command using the Name On Menu text box. 
5. If you want to create a keyboard shortcut to the new menu item, place an & symbol before the 

character you select as the shortcut. This character will be identified by an underline when you finish 
the menu.

6. The Position on Menu command is used to set the position of each new command.
7. Click the Add button to accept the change. 

New menus, and changes to existing menus, should be saved in a separate configuration file using the 
Save In command. This allows you to keep the existing TurboCAD desktop separate from custom 
desktops you establish.



Create keyboard shortcuts for TurboCAD commands
New in TurboCAD Learning Edition is the ability to create keyboard shortcuts for almost every command 
and tool. Keyboard shortcuts may be created from: 

Any single alphanumeric keystroke
The combination of CTRL, SHIFT, or ALT and an alphanumeric keystroke 
A Function Key
The combination of CTRL, SHIFT, or ALT and a Function Key. 

Many new keyboard shortcuts have already been configured in TurboCAD. If the shortcut you want to use
is already taken, it will appear in the "Currently Assigned To:" section of the Customize Keyboard dialog, 
just below the "Press New Shortcut Key" box. 
Tip: It is possible to reassign existing keyboard shortcut to new commands, and to give commands more 
than one keyboard shortcut. 
The basic steps to creating a new keyboard shortcut are: 
1. Select the command being linked to a shortcut, using the Categories and Commands list boxes. 
2. Click in the "Press New Shortcut Key" text box, and type the character or keystroke combination you 

want. 
3. Look in the "Currently Assigned To:" section of the dialog to see if the shortcut you have selected is 

available. 
4. If available, accept the new shortcut by clicking the Assign button.
5. Save all changes to a new configuration file with the Save In button. 



Manage configuration files
Each of the three customization options allows you to save the changes to a special configuration file. 
The fourth option in the Configuration dialog, Setup, allows you to manage the configuration files you 
create.
Before you start customizing, you should give thought to naming the configuration file or files. If you 
switch between two or more screen resolutions, for example, you could create customized toolbars and 
menus for each screen resolution (or use the configuration files already supplied for each resolution). In 
this example, you could name a configuration file for each resolution. 
Setup allows you to save all customizations in one file, or to separate them by function (only the toolbar 
customizations, for example). Generally speaking, it is best to keep Load All Sections and Save All 
Sections options checked, instead of segmenting the various customizations. 



Measuring Objects
The Measurement options make it easy to gather information about objects in the drawing. Tools are 
available to find: 

Coordinates of the point
Distance
Angle
Area 

To use any of the measurement commands, start by displaying the Measurement palette. Select View|
Selection Info or click the Measurement Info button on the View toolbar. Then select the measurement 
command you need from the Standard toolbar or Tools|Measurement. 
Use snap tools as necessary to trace the boundaries of the objects you are measuring, or select the By 
Entity or Single Entity options from the local menu to select boundaries based on entities. A purple 
tracking line will follow as you identify coordinates or entities. Select Finish from the Local Menu; the 
results will be displayed in the Measurement palette, in both World and Paper coordinates.
To copy the contents of the Measurement palette to the Windows Clipboard, press the Copy button near 
the top of the palette. You may then paste the information into any word processor, text editor or other 
program that will accept text.
When using any measure command, the local menu (available with a right-click of the mouse) lists 
alternative units of measurement, as well as the usual options of Cancel, Close, One Step Back, and 
Local Snap. 



Run TurboCAD Scripts
TurboCAD Learning Edition is a fully programmable CAD system. Scripts are programs a TurboCAD user 
or an entrepreneur can write to automate specific tasks or to create custom features for specific 
applications. Its built-in BASIC interpreter allows programmers to create scripts that can access most of 
TurboCAD’s functionality via TCAPI40.DLL. 
You can create scripts using any text editor, word processor, or the new on-line debugger, then run the 
script directly from TurboCAD using the Tools|Run Script command. You can attach scripts to your 
drawing using the Scripts property sheet in the Options menu. Once scripts are attached to your drawing 
they appear in a submenu off of the Run Scripts menu item on the Tools menu, and as buttons on the 
Script toolbar. 
Advanced programmers can create their own DLL’s in any language capable of calling TurboCAD’s 
exported functions.
For detailed information on scripting, TurboCAD’s Enable BASIC language or TCAPI40 functions, see the
"Programming TurboCAD with Enable Basic" manual included in the box with TurboCAD Learning Edition,
or on the CD with TurboCAD Learning Edition.
See Also: Run Scripts, Scripts Property Sheet



Database Management in TurboCAD 
As you draw, you see entities and objects on the screen. But within the program, these items are 
elements of a database. For example, to record a line as part of a drawing, TurboCAD must save 
information about line width, color, coordinate locations of each endpoint, line type and associated 
settings, and other information. If this information were stored as a list of items in a table, the categories 
would be field names; the items of information for each line would be data entries in a field.
The database management features in TurboCAD Learning Edition allow the user to add information to 
objects and to create reports using this information. A drawing of a bolt, for example, can have information
about that bolt attached to it. If you are familiar with any of the popular database management programs 
in the Windows environment, you will quickly recognize the structure and possibilities in the TurboCAD 
database.
Consider the following two scenarios if the idea of using database management techniques with a CAD 
program is not clear to you. 
Facilities Management. A facilities manager uses TurboCAD to plan office layouts and to track 
furnishings. She keeps a current drawing for each section of the building, showing every item assigned to 
each office. Every item in the drawing has additional data added, such as Name of Item, Manufacturer, 
Price, and Assigned To. As necessary, the facilities manager can generate reports from the information in 
the drawing, such as total number of chairs assigned, or a list of items by manufacturer.
General Construction. An independent home builder draws plans for every new home he builds in 
TurboCAD. Over time he had build up a variety of symbols for the common items he uses as he builds 
homes: sheet rock, plumbing fixtures, etc. Each symbol carries with it field names such as Item Name, 
Cost, and Supplier. As he draws using symbols, he enters specific data for each item. If he draws new 
items not already represented by a symbol, he adds fields names and data as he draws. When finished 
with the drawing, he uses the TurboCAD Database|Report command to create a Bill of Materials, item 
counts, and other reports.
Additional information can be associated with any object or entity at any time, but it is most productive to 
plan in advance how to take advantage of the database management capabilities in TurboCAD. Such 
planning would include determining what pieces of information should be tracked and what to call the 
various pieces of information. Additional pieces of information can be added to individual entities or 
objects, as well as to groups, blocks and symbols. You can add descriptive information, such as Part 
Number or Item Name, or information which can be summarized, such as Cost.

Subtopics
Database Field Setup
Edit Object Data
Adding values for drawing entities and objects
Creating Reports



Database Field Setup
The first step in using TurboCAD’s database is to define fields. Fields are the basic building blocks of any 
data base. Consider the most common database in existence, the telephone book. The fields are Name, 
Address, Phone Number. The telephone company builds a database for each exchange by filling in these 
three fields for each customer. 
In TurboCAD you define the fields for each item you wish to include in the database. There is one 
database for the drawing; all fields will belong to this master database field list. Enter the field names 
using the Define Fields dialog (Tools|Database|Define Fields). 

Subtopics
Automatic Field Names
Field Properties



Automatic Field Names
When you first define fields, TurboCAD displays six field names. These automatic fields match the basic 
characteristics of the items in the drawing, and cannot be edited within the database. 
Object ID. Every object created in TurboCAD is assigned a unique Object ID number by the program. 
This is similar to how a database management program will assign a unique sequence number to every 
record created.
Layer. This field will display the layer name of each item in the database.
Type. This field will display the entity or object type, such as line, multiline, arc, etc. 
Attribute. Any information which appears in an object’s Attribute property sheet will appear here.
Pen Color. The name of an object’s selected pen color will appear here.
Brush Color. The name of an object’s selected brush color will appear here. 



Field Properties
The six automatic fields, as well as any new field you create, have the following properties:
Field Name. For the automatic fields, these names are assigned. For new fields, you may assign any 
descriptive name you choose. TurboCAD requires unique field names, and will not let you use a field 
name twice in any one drawing’s database.
Data Type. TurboCAD will place the name of the object or entity type (line, arc, group, etc.) in this field.
Visible. If a field is checked as visible, it will appear as an item in other Database dialogs, and can be 
sorted or added to a report. If Visible is not checked for any item, the field will not appear in other 
Database dialogs. 
Tip: If you know you will not be using the values in any automatic fields when you prepare reports using 
the database, deselect Visible for those fields. The fields will not appear when you edit or prepare reports.
Editable. If this box is checked, then data can be entered or edited at any time in the Edit Object Data 
dialog. If this box is not checked, then any data in the field cannot be changed. 
Note: The six automatic fields are not editable; they represent data elements that must be changed as 
properties. Object ID cannot be changed. 
Description. This field is for comments or other brief description. Generally you use this field to expand 
the description in Field Name. It can also be used for other comments about items added to the database.



Edit Object Data
Once field names and data types have been established, the next step is to add information about each 
item into the database. Select one or more objects in the drawing, then select Menu: Tools|Database|Edit 
Object Data. 
The various pieces of information you enter in the database (for example, a part number) are called 
Values. The Edit Object Data dialog is used to enter and edit values. 
When first opened, the Edit Object Data dialog shows a summary view of field names and values for all 
objects and entities selected in the drawing. If more than one object or entity is selected, the summary 
view will show all the field names, but will display "Not Equal" under values unless all the selected items 
have the exact same value for a particular field. If you selected four matching office tables, for example, 
the summary view would show values for Part Number, Price, and Item. The Show All and Collapse 
buttons switch the dialog between the summary and detail views. 
From either view, it is possible to enter new values or edit existing values. If a value of "Not Equal" is 
edited in the summary view, the value for all selected objects will be changed. Values marked not editable
in the Define Fields dialog will be gray in the Edit Object Data dialogs. 
Field Info. Click on a field name or a value, and Field Info will appear, listing Field Type, Editable, and 
Description for the selected field. 



Adding values for drawing entities and objects
To add new information to the database about entities and objects, select the object then open the Edit 
Object Data dialog (Menu: Tools|Database|Edit Object Tools). If only one object is selected, it does not 
matter whether you use the summary view or the show all view. Click on a field, then type the required 
information. You may use <Tab> to move from field to field. Click OK when finished.



Creating Reports
The purpose of a drawing database is to generate reports based on available information. The Report 
Create dialog is used to generate reports. A report may be as simple as a request for all values on all 
objects, or as detailed as a list of items with a cost of between $0.49 and $2.97 drawn with Red Pen Color
on Layer 13.
The various Report dialogs are used to define a report, view the selected data, and to export the data to 
the printer or another program. Two report styles are available, Summary and Detail. The differences are 
subtle: 
Summary Report. All values in a Summary Report may be edited before printing, even if they come from 
a non-editable field. 
Detail Report. Only values from editable fields may be modified in a Detail Report. Field Info is shown for
any selected value. 
The data in either style of report can be sorted in Ascending (A-Z or lower to higher) or Descending (Z-A 
or higher to lower) order, using any field as the sorting criteria. A SUM function is available, to calculate a 
total or an item count in any column. 
A completed report can be saved to disk, printed, or copied to the Windows Clipboard (to be pasted into 
another program). Reports saved to disk are stored in a spreadsheet file, in the TCW40\Reports folder. 

Subtopics
Advanced Report Options



Advanced Report Options
A second dialog, Advanced Report, is available from the main Reports dialog. The dialog varies, 
depending on whether a Detail Report or a Summary Report is being created. 
Advanced Detail Report. Field Names (Report Header Name) may be edited. 
Advanced Summary Report. Report Header Name may be edited, and one of five math functions may 
be added to a field: 

SUM, which calculates the total of all values in the field;
AVG, which calculates an average for all values in the field; 
MIN, which displays the smallest amount among all values in the field; 
MAX, which displays the largest amount among all values in the field; 
COUNT, which totals the number of values in the field. 



Tools Menu Commands
The following table summarizes the commands accessible from the Tools menu. Only the major items are
shown. 

Command Function
Customize Modify or create new toolbars, menus and keyboard shortcuts.
Database Assign data to drawing objects and create reports from the data.
Run Scripts Run a TurboCAD script.
Measurement Measure distance, angle, area and location of coordinate points.

Customize tools
Menu: Tools|Customize

The Customize dialog contains four sections: 
Toolbars 
Menus 
Keyboard 
Setup 

The first three sections allow you to modify the various aspects of the user interface. The fourth section, 
Setup, is for managing the configuration files you create when you customize the program. 

Subtopics
Customize Toolbars
Customize Menus
Customize Keyboard
Customize Setup



Customize Toolbars 
Menu: Tools|Customize|Toolbars

The Toolbars dialog contains the following controls: 
Categories. This list box displays an expandable chart of all TurboCAD commands and tools, listed by 
menu location. As you build a new toolbar, you will select a category of tools, and the available tool 
buttons will appear to the right. At the bottom of the list is "All Commands." Select this item and every 
TurboCAD command will appear as text entries instead of as tool icons. This feature is useful if you need 
to create a toolbar from commands that don’t have tool icons, such as the Database tools or the text 
format tools.
Buttons. Click on any button displayed in this box; its description will appear in the Description box. To 
add a button to a toolbar, drag the button onto the toolbar. 
Style. New toolbars may be in one of three styles: 

Standard: Buttons are arranged in a straight line. 
Tabbed: Two or more sets of buttons share a single toolbar; each set is identified by a unique tab.
Fly-out: Related buttons are hidden behind the first button in the set; the entire group appears 

when you click and hold on the first button. Fly-out toolbars have a yellow triangle in the lower right corner
of the first button. 
Toolbar. Drag the New button onto the desktop to start a new toolbar. To delete or rename an existing 
toolbar, select the toolbar in the gray area, then click the Delete or Rename button. 
Load From. Retrieve a previously saved configuration file containing one or more customizations. Click 
the list arrow to see the names of previously saved configuration files. 
Save In. Save the current customization as a unique configuration. Click the list arrow to see the names 
of previously saved configuration files. Click in the text box to type a name for a new configuration. 
The Load From and Save In options make it possible to have several desktop configurations. You may 
want to create separate configurations for different users of the same program or for different tasks.
Description. Explains the purpose of a selected button. 
Close. Click this button to finish.
Tip: Make all your customization changes (Toolbars, Menus, Keyboard), then use the Save In command 
to name them. This will store all the changes in one configuration file. This tip assumes that Save All 
Sections boxes are checked in the Customize|Setup dialog.        

Subtopics
Creating a Standard toolbar
Creating a Tabbed toolbar
Creating a Fly-out toolbar
Creating a mixed toolbar



Creating a Standard toolbar
A standard toolbar is one that does not use tabbed or fly-out tools. Follow these steps to create a 
standard toolbar. 
1. From the menu, select Tools|Customize. Make sure Toolbar is the active tab.
2. Click the Standard radio button.
3. Drag the New button out of the Customize dialog and onto the desktop. 
4. The New Toolbar dialog will appear. Type a descriptive name for the new toolbar and click OK. The 

new toolbar will appear, floating on the desktop.
5. In the Categories list, find the first tool you wish to add to the toolbar. Expand or contract each portion 

of the list as necessary to find the tool you need. To identify any tool, click on it in the Buttons section 
of the dialog. To add the tool to the new toolbar, drag the tool from the Buttons area to the new 
toolbar. 

6. Repeat Step 5 for each additional tool.
7. Click the Close button when finished.



Creating a Tabbed toolbar
A tabbed toolbar is a group of tools that share a common tab. The use of tabs makes it possible to have a
larger number of tools in a smaller toolbar. 
Follow these steps to create a toolbar with two tabs.
1. From the menu, select Tools|Customize. Make sure Toolbar is the active tab.
2. Click the Tabbed Radio button.
3. Drag the New button out of the Customize dialog and onto the desktop.
4. The New Toolbar dialog will appear. Type a descriptive name for the first tab of your new tabbed 

toolbar, and click OK. A new toolbar will appear, floating on the desktop. 
5. In the Categories list, find the first tool you wish to add to the toolbar. Expand or contract each portion 

of the list as necessary to find the tool you need. To identify any tool, click on it in the Buttons section 
of the dialog. To add the tool to the new toolbar, drag the tool from the Buttons area to the new 
toolbar.

6. Repeat Step 5 for each additional tool. 
7. To start a second tab group, drag the New button out of the Customize dialog and onto the desktop.
8. The New Toolbar dialog will appear. Type a descriptive name for the second tab of your new tabbed 

toolbar, and click OK. A new toolbar will appear, floating on the desktop.
9. Repeat Steps 5 for each additional tool desired for the second tab. 
10. When the second tab contains all the desired tools, drag the second tab onto the first one. The 

second tab will merge into the first toolbar, and the toolbar frame for the second tab will disappear. 
11. Click the Close button when finished.



Creating a Fly-out toolbar
A fly-out toolbar is a group of tools that share the same space on a toolbar; the entire group of tools "fly 
out" of the toolbar when you press and hold on the first tool. The use of fly-out tools makes it possible to 
place a large number of tools in a small toolbar, and to combine related tools in a small space. A small 
yellow triangle in the lower right corner identifies the first tool in a fly-out toolbar.
Fly-out toolbars must be added to newly created or existing standard or tabbed toolbars; it is not possible 
to drag the New button onto the desktop when the Fly-out radio button is checked.
Any tool in an existing toolbar can become the first tool in a fly-out tool group, or a group of fly-out tools 
may be added to an existing toolbar without changing any existing tools in the toolbar. 
Follow these steps to add a group of fly-out tools to an existing toolbar.
1. Make sure the toolbar you will expand is floating on the desktop.
2. From the menu, select Tools|Customize. Make sure Toolbar is the active tab. 
3. Drag the dialog as necessary so you can see both the dialog and the toolbar.
4. Click the Fly-out Radio button.
5. In the Categories list, find the tool you wish to become the first tool of the fly-out group. Expand or 

contract each portion of the list as necessary to find the tool you need. To identify any tool, click on it 
in the Buttons section of the dialog. To select the tool, drag the tool from the Buttons area to the 
floating toolbar; place it on the toolbar but not on top of an existing tool.

6. Drag the second tool for the fly-out group to the new toolbar. Place it directly on top of the first tool. 
7. The New Toolbar dialog will appear. Type a descriptive name for the fly-out tool group, and click OK. 

The two tools will now appear as the start of a fly-out tool group. A small yellow triangle identifies the 
first tool in the group. 

8. Drag additional tools onto the fly-out group as desired.
9. Click the Close button when finished.

To create a fly-out tool group using a tool in an existing toolbar as the first tool in the fly-out group, follow 
the preceding steps, changing Step 5 by dragging the first tool on top of an existing tool. The existing tool 
will become the first tool in the fly-out group; the first new tool you add will become the second tool in the 
fly-out group. 



Creating a mixed toolbar
It is possible to create toolbars that mix Standard, Tabbed and Fly-out display styles. Start with either a 
Standard or Tabbed toolbar, then click the radio button for Tabbed or Fly-out. The new tools you drag onto
the toolbar will display in the selected style.



Customize Menus 
Menu: Tools|Customize|Menus

The Menus dialog contains the following controls: 
Categories: This list box displays an expandable chart of all TurboCAD menus. When you select a menu,
its contents appear to the right in the Commands list. 
Commands: As a menu is selected in the Categories list, the individual commands are listed here. 
Change What Menu: Select a menu to modify, or select [Menu Bar] to create a new menu.
Position On Menu: When you have selected a menu to modify, and have selected a command to add to 
it, click on the list box arrow and select a position within the menu for the new item. The choices are: 

Auto: TurboCAD will insert the items in the order selected.
At top: The new menu item will be the first item in the menu.
At bottom: The new menu item will be placed at the bottom of the menu. 
Separator: Select this option to separate menu items into groups. 

Name On Menu. You may use this command to rename any new menu item. Click on the text box and 
type the new name. To select a letter in the menu name as the accelerator key (also known as a keyboard
shortcut), place the & sign directly in front of the character. Finish by clicking the Add button. 
Description. Explains the purpose of a selected menu item.
Rename. This button appears when you have selected a menu item. The location of this button is shared 
by the Add button. Click Rename when you have typed a new name for a menu item in the Name On 
Menu field.
Add. Click this button to add a menu item to a selected menu. Be sure the correct Position On Menu 
choice is showing. 
Remove. Use this button to remove an item from a menu (new or existing). 
Reset All. Cancel any changes, revert to original menu status.
Add Submenu. When an existing menu is selected in Change What Menu:, a new submenu will be 
added. When [Menu Bar] is selected in Change What Menu:, a new primary menu will be added to the 
menu bar. 
Load From. Retrieve a previously saved configuration file containing one or more customizations. Click 
the list arrow to see the names of previously saved configuration files. Click the Load From button to 
accept the selected configuration file. 
Save In. Save the current customization as a unique configuration. Click the list arrow to see the names 
of previously saved configuration files. Click in the text box to type a name for a new configuration. Click 
the Save In button to save the new configuration.
The Load From and Save In options make it possible to have several desktop configurations. You may 
want to create separate configurations for different users of the same program or for different tasks.
Close. Click this button to finish.

Subtopics
Adding Accelerator Keys to Menu Items



Adding Accelerator Keys to Menu Items
Place the ampersand (&) in front of the letter you wish to designate as the accelerator key (also known as
a keyboard shortcut) for any new menu item. The letter will be underlined in the menu. To access the 
shortcut, press ALT plus the letter that opens the menu, then press the accelerator key for the item.



Customize Keyboard 
Menu: Tools|Customize|Keyboard

The Keyboard dialog contains the following controls: 
Categories. This list box displays an expandable chart of all TurboCAD menus. When you select a menu,
its contents appear to the right in the Commands list. 
Commands. As a menu is selected in the Categories list, the individual commands are listed here. 
Press New Shortcut Key. When you have identified a command, click in this text box and type the 
keystroke or key combination you wish. 
Current Keys. If the selected command already has a keyboard shortcut, it will appear in this text box. 
Description. Explains the purpose of a selected command. 
Assign. After typing the new shortcut in the Press New Shortcut Key box, click this button to link the 
shortcut to the command. 
Remove. Click this button to remove a shortcut from the selected command. 
Reset All. Cancel any changes, revert to original status.
Load From. Retrieve a previously saved configuration file containing one or more customizations. Click 
the list arrow to see the names of previously saved configuration files. 
Save In. Save the current customization as a unique configuration. Click the list arrow to see the names 
of previously saved configuration files. Click in the text box to type a name for a new configuration. 
The Load From and Save In options make it possible to have several desktop configurations. You may 
want to create separate configurations for different users of the same program or for different tasks.
Close. Click this button to finish.



Customize Setup
Menu: Tools|Customize|Setup

All three customization options may share a common set of configuration files. This dialog controls 
whether or not the file names are common. 
The key elements are the Load All Sections and Save All Sections check boxes. If these boxes are 
checked, then all three customization options will use the same configuration files. If one of these boxes is
not checked, then you will need to individually select which customization options are active when 
configuration files are loaded or saved. 
Load Configuration File Section. This list box displays the current types of customization configuration 
that can be loaded and modified. If Load All Sections is not checked, you must individually select 
customization options from this list. 
Save Section in the Configuration File. This list box displays the current types of customization 
configuration that can be saved when modified. If Save All Sections is not checked, you must individually 
select customization options from this list.
Load From. Retrieve a previously saved configuration file containing one or more customizations. Click 
the list arrow to see the names of previously saved configuration files. 
Save In. Save the current customization as a unique configuration. Click the list arrow to see the names 
of previously saved configuration files. Click in the text box to type a name for a new configuration. 
The Load From and Save In options make it possible to have several desktop configurations. You may 
want to create separate configurations for different users of the same program or for different tasks.
Reset All. Cancel any changes, revert to original status. 
Close. Click this button to finish.



Database tools
Menu: Tools|Database

The Database tools, in TurboCAD Learning Edition, are used to add information to objects and entities, 
and to create database reports from that information. Four command subjects are listed beneath 
Database in the Tools menu: Define Fields, Edit Object Data, Report, and Regenerate. One database can
be created for each drawing. As many custom reports as necessary can then be generated from the 
database.

Subtopics
Define Fields
Automatic Fields
Edit Object Data Command
Report
Regenerate



Define Fields
Menu: Tools|Database|Define Fields

The first step in creating a database is to define the types of information to be recorded. Field Name 
describes the type of information, Value is the specific piece of information recorded under a field name. 
Other field types are recorded for each piece of information. A related set of values entered into the data 
base for the set of fields is known as a Record.
Six Automatic Fields are predefined for each drawing’s database. These six fields contain object and 
entity information that cannot be edited or changed from within the database; these are properties that 
must be changed in a property sheet.
To start a new database, select Define Fields from the menu. Click on the first blank under Field Name, 
and type the new field name. Then continue to fill in the blanks for the other fields.
Field Name. This is the name of the piece of information to be recorded. To add a field name to the 
database, click on the first blank item in the Field Name column, and type the new name.
Data Type. Click on the blank under Data Type. A list box arrow will appear. One of four data types may 
be selected: 

Text, for alphanumeric information which does not have to be calculated.
Integer, for whole numbers.
Double, for decimal numbers.
Currency, for dollar amounts.

Visible. An on-off option. If checked, the field will be visible and available for use in the Edit Object Data 
and Report dialogs. If not checked, the field will not be visible in the other dialogs and will not appear in 
reports.
Editable. An on-off option. If checked, the field can be edited in the other database dialogs. If not 
checked, the field is locked and cannot be edited in the other dialogs. Auto fields are always non-editable.
Description. An optional field, for notes or other comments about the field.
To delete a field name or other information, click on the text box, then click the Delete button.



Automatic Fields
Six Automatic Fields (called Auto Field in the dialogs) are automatically generated for each drawing’s 
database. These automatic fields represent object or entity information, and cannot be edited from within 
the database; it must be changed in a property sheet. The six fields are: 
Object ID. Every object created in TurboCAD is assigned a unique Object ID number. It cannot be 
changed.
Layer. This field will display the layer name of each item in the database.
Type. This field will display the entity or object type, such as line, multiline, arc, etc. 
Attribute. Any information which appears in an object’s Attribute property sheet will appear here.
Pen Color. The name of an object’s selected pen color will appear here.
Brush Color. The name of an object’s selected brush color will appear here. 



Edit Object Data Command
Menu: Tools|Database|Edit Object Data

Once fields have been defined, the next step is to enter data. If you draw a wing nut, for example, and 
want to record data about it in the database, you would select the wing nut (most likely existing as a 
group, symbol or block in the drawing), then access the Edit Object Data dialog to enter information about
the item.
There are two versions of the Edit Object Data dialog: 
Summary View. This dialog shows the fields and values for one selected record. This is the default dialog
if only one item is selected in the drawing. Click any white text box to enter information. If more than one 
item is selected in the drawing, editing any field will set the values for all selected items. 
Show All View. This dialog displays all fields for all items in the drawing. Values may be entered for any 
editable field.
Click the Show All/Collapse button to switch between the Summary and Show All views.
The Field Info dialog lists Field Type, Editable status, and the Description of the selected value.



Report
Menu: Tools|Database|Report

After fields have been created, and data entered, the database can be used to generate reports. Four 
dialogs control the various phases of the report process. 

Subtopics
Report dialog
Report Edit dialogs
Summary Report / Detail Report dialog
Summary and Detail Report tools



Report dialog
The Report dialog appears when the Report option is selected from the menu. From this dialog, you can 
start the process of creating a new report, edit an existing report, or generate a report. The buttons that 
select these options are:
Report. Click this button to generate a previously designed report. A report name must be selected from 
the list of Available Reports for this button to be available. 
Edit. Click this button to modify an existing report. 
Create. Click this button to create a new report. A "Create New Report" dialog will appear; type in a name 
for the report. The Report Edit dialog will then appear.
Delete. Click this button to delete a report selected in the Available Reports list.



Report Edit dialogs
The Report Edit dialog has two tabs, Report and Advanced Report. The following categories are found in 
the Report tab: 
Report Title. The report name assigned by the Create Report dialog appears here, and may be edited if 
desired. 
Report Type. There are two options, Detail and Summary: 

Detail. Only values from editable fields may be modified in a Detail Report. Field Info is shown for
any selected value.

Summary. All values in a Summary Report may be edited before printing, even if they come from 
a non-editable field.
Comments. A line describing the purpose of the report may be entered in this text box.
Available Fields. All fields previously marked as visible will appear in this list. Select a field name, then 
use one of the buttons to the right of the list to add a field to the Report Fields list.
Report Fields. Any fields selected using the Add or (Add) All buttons will appear in this list. To remove an 
item from this list, use the Remove or (Remove) All buttons.
Query Criteria. This field shows any query created to sort data. To create a query, click the Edit button 
below the Query Criteria field to activate the Create Query dialog.
Note: The Create Query dialog is the exact same dialog used by the Select By Query tool. For a 
complete description of this tool, refer to Select By Query.
Apply. Click this button to accept the settings in the dialog. 
Two possible Advanced Report dialogs are available, depending on the status of the Report Type in the 
Report field. If Detail is checked, the Advanced Report allows Field Names (called Report Header Name) 
to be edited. If Summary is checked, Report Header Names may be edited, and one of five math 
functions may be added to a field: 

SUM, which calculates the total of all values in the field.
AVG, which calculates an average for all values in the field.
MIN, which displays the smallest amount among all values in the field.
MAX, which displays the largest amount among all values in the field.
COUNT, which totals the number of values in the field.



Summary Report / Detail Report dialog
When the Report button is clicked in the opening Report dialog, one of two reports will be generated, 
Summary or Detail. (Which report is run depends on the Report Type setting in the Report Edit field.) All 
values in a Summary Report may be edited before printing, even if they come from a non-editable field. 
Only values from editable fields may be modified in a Detail Report. Field Info is shown for any selected 
value.



Summary and Detail Report tools
Seven tool icons appear in both the Summary Report and Detail Report dialogs. From left to right, the 
seven tools are: 
Export. Click this button to save a report to disk. The file may be saved as a Microsoft Excel Spreadsheet
(XLS), Microsoft Access Database (MDB), a Comma Separated Value (CSV), or a Tabbed Text File (TXT).
The default folder is to the \TCW40\Reports. The file is a text file readable by other database programs, 
word processors, etc.
Page Setup. Click this button to set the format for a printed version of the report, using a standard 
Windows Print Setup dialog.
Print. Click this button to print the report using current Print Setup options.
Copy. Places all report data on the Windows Clipboard, so it can be pasted into another Windows 
application.
Sort Ascending. Click a Field Name, then click this button to sort from A to Z or from smallest to largest, 
using the selected field as the sort criteria.
Sort Descending. Click a Field Name, then click this button to sort from Z to A or from largest to smallest,
using the selected field as the sort criteria.
Grand Total. Click a blank field at the bottom of any column, then click this button. If the field contains 
Currency, Integer or Double as the data type, the Grand Total button will calculate a total for the column. If
the field contains Text information, the Grand Total button will display the total number of items in the 
column.
If new data has been added to the database since the last time the report was used, click the Update 
button to regenerate the report, adding the new data. This is the same as using the Regenerate tool from 
the menu (Tools|Database|Regenerate).



Regenerate
Menu: Tools|Database|Regenerate

If new drawing elements have been created, and new data entered into the database, select the 
Regenerate command from the menu. This will force an update of the database to account for all new 
entities, objects, and data elements.



Run Scripts
Menu: Tools|Run Scripts Toolbar: Script

The Run Scripts tool lets you run scripts placed in a drawing, or browse for scripts located anywhere on 
your computer (using Options|Script). Scripts are created in TurboCAD's built-in BASIC language using 
Notepad or any text editor or word processor. You can place scripts in your drawing using the Scripts 
property sheet (Options|Script). You can also debug your script using the new Basic debugger.
Scripts you have placed in your drawing will appear in a submenu off the Run Script menu, followed by a 
More Scripts menu item. The scripts will also appear as buttons on the Script toolbar. You can run one of 
these scripts by choosing it from the submenu or clicking its tool button.
If you want to run a script that is not placed in your drawing, just choose Run Script (if no scripts are 
placed in your drawing), or More Scripts from the submenu (if there are scripts placed in your drawing). 
You can also click the Run Scripts tool shown in the heading of this topic. The Run Script dialog will 
appear.
Use this standard Windows dialog to browse to the script that you want to run, then press <Enter> to run 
the script. For additional information on creating scripts, see the "Programming TurboCAD with Enable 
BASIC" manual.
Note: TurboCAD's Scripts folder contains some sample scripts that you can run and explore.
See Also: Scripts Property Sheet 



Measurement
The measurement tools are used to find the area, distance, angle, or location of objects in the drawing. 
The results will appear in the Measurement palette, which automatically appears when any Measurement 
tool is activated.

Subtopics
Measurement Tools and the Local Menu
Measure Coordinates of the Point
Measure Distance
Measure Angle
Measure Area



Measurement Tools and the Local Menu
When using measurement tools, the local menu contains available units of measurement, as well as 
selection aids that vary with the measurement tool. Right-click to summon the local menu, and click on a 
unit of measurement or a selection aid.



Measure Coordinates of the Point
Menu: Tools|Measurement|Coordinates of the Point Toolbar: 
Measurement

Click on any location in the drawing to see the coordinate locations. Snap commands may be used.
Local menu. All available units of measurement are listed, as well as local snaps. No other specific aids 
are available. 



Measure Distance
Menu: Tools|Measurement|Distance Toolbar: Measurement

Use this command to measure both the distance from one point to another, and to measure a perimeter. 
As you identify locations on-screen, a purple tracking line will show the measurement path.
Local menu. All available units of measurement are listed, as well as local snaps. Selection aids for 
Measure Distance are Finish, Close, One Step Back, By Entity, and Single Entity. 



Measure Angle
Menu: Tools|Measurement|Angle Toolbar: Measurement

Use this command to measure the angle between two lines. As you identify locations on-screen to identify
the angle, a purple tracking line will show the measurement path. Identifying two locations or entities will 
generate an angle measurement; if you select a third location, you start a new measurement command.
Local menu. Selection aids for Measure Angle are Finish, One Step back, By Entity and all local menu 
snaps.



Measure Area
Menu: Tools|Measurement|Area Toolbar: Measurement

Use this command to measure the area in the drawing. The area does not have to be currently bounded 
by lines or other objects. As you identify locations on-screen to select the area, a purple tracking line will 
show the measurement path. Click on Close in the local menu to finish selecting and calculate the area.
Local menu. All available units of measurement are listed, as well as all local snaps. Selection aids for 
Measure Area are Close, One Step Back, and By Entity. 



Geometric Editing
The tools on the Modify menu are conventionally called CAD editing tools. These tools provide a variety 
of special editing functions for modifying the shape of entities. The following table summarizes the modify 
menu and its functions.

Command Function

Object Trim Defines entities as a cutting edge, then trims objects in 
and around the cutting edge.

Stretch Stretches an entity composed of line segments by 
moving a selected set of vertices.

Split Splits an entity into two entities.
Meet 2 Lines Shrinks or extends two lines or double lines so that two of

their endpoints form a clean intersection.
Chamfer Joins two line segments or double line segments with a 

flattened corner.
Line Length Changes the length of a line while retaining its 

connection with other lines in a polygon or multiline.
Shrink/Extend Line Changes the length of a line so that it precisely meets 

another entity.
Arc Complement Reverses the starting and ending angles of an arc.
Fillet Connects two lines, either single or double lines, with a 

smoothly fitted arc.
T-Meet 2 Double Lines Forms a clean T intersection of two double lines.
Intersect 2 Double Lines Forms a clean X intersection of two double lines.

Note: There is a practical distinction between the tools on the Modify menu and those on the Edit menu. 
When you use the Edit menu tools, you must first select the object or objects that you want to edit. The 
Modify menu tools are similar to the drawing tools, in that you first activate the tool, and then follow a 
series of steps to complete the edit. When you finish the edit, the tool remains active, so that you can 
either begin a second editing operation of the same type, or switch to another tool.



Object Trim
Menu: Modify|Object Trim Toolbars: Modify, Standard

Object Trim is a powerful editing tool that lets you define an entity or set of entities as a cutting edge. You 
can then cut out any parts of the drawing in or around the cutting edge tool, leaving only the parts of the 
drawing that you want to keep. You can trim any part of the drawing that touches the cutting edge. To use 
Object Trim:
1. Draw a new entity (or a set of entities) over an existing entity in such a way that the new entity defines

areas of the existing entity that you want to remove. You might, for example, want to use a circle to 
remove the ends of intersecting lines that fall outside of the circle.

2. Activate the Object Trim tool.
3. Click on the new entity to define it as a cutting edge. You can continue to add entities to the cutting 

edge by holding down the <Shift> key and clicking on additional entities.
4. Click on parts of the drawing in or around the cutting edge to remove it from the drawing. TurboCAD 

will not allow you to remove the last remaining part of the drawing touching the cutting edge.

Note: In previous versions of TurboCAD, a curve could not be a cutting edge for Object Trim. Curves are 
now acceptable as a cutting edge.
Warning: Object trim will not work with certain complex entities, specifically dimensions and text. To use 
the tool on these types of objects (as well as on groups and block inserts), you must first select the object 
that you want to trim, then use the Explode command to break the entity into simple sub-entities. In the 
case of text, you must explode the entity twice (first into groups of multilines, then into multilines).



Stretch
Menu: Modify|Stretch Toolbars: Modify, Standard

Use the Stretch tool to move groups of nodes on any object or set of objects. This has the effect of 
stretching (or shrinking) the object by relocating the selected set of nodes. To move the nodes you use a 
vector line, similar to the vector line used in the Vector Copy command.
1. Choose the Stretch tool.
2. Click to define the first corner of the selection rectangle. Drag the mouse over the drawing so that the 

rectangle encloses all of the nodes (vertices) that you want to move, then click to complete the 
selection rectangle. A small rectangle will appear at each of the nodes that you have selected.

3. Define the first point of a vector line, either by clicking the mouse (using any snap mode), or by 
entering the point’s coordinates in the status bar.

4. Specify the length and angle of the vector. You can do this either by directly entering the length and 
angle in the edit bar or by defining the vector line’s second point. You can define the second point 
using either the mouse (with any snap mode), with a SEKE (to access a snap) or by entering the 
point’s coordinates in the status bar.

All of the selected nodes will move, from their original locations, the length and angle defined by the 
vector line. The objects in which the nodes were selected will stretch, shrink, or move accordingly.
Note: If you select all of the nodes on any entity, the entire entity will simply be moved (as with the Vector 
Copy command). This is also the effect if you select any node on a circle or arc.
See Also: Node Edit



Split
Menu: Modify|Split Toolbars: Modify, Standard

Use the Split tool to divide an entity into two separate entities. This tool works on any single-line or 
double-line entity, as well as on circles, arcs and curves. 

Subtopics
Splitting Line and Double Line Entities
Splitting Arcs and Circles
Splitting Curves



Splitting Line and Double Line Entities
You can use the Split tool to split entities into two parts. 
1. Activate the Split tool.
2. Click on the line or double-line that you want to split: Let’s call this the target. TurboCAD draws a 

temporary perpendicular line intersecting the target.
3. Move the mouse cursor until the perpendicular line is at the point where you want to split the target.
4. Click to split the target.

Notice that TurboCAD leaves a temporary red cross to indicate where the split occurred on the object.



Splitting Arcs and Circles
To divide an arc into two arc segments:
1. Choose the Split tool.
2. Click on the arc you want to split. A dotted line appears, connecting the cursor to the center point of 

the arc.
3. Click to define the angle at which to split the arc.

Splitting a circle is the same as splitting an arc, except that at step 3 you need to define a starting and an 
ending angle (breaking the circle in two places).



Splitting Curves
It is helpful to display the a curve’s frames before splitting it. This is because the split actually takes place 
on the frame. To display a frame, double-click on the curve to summon the Property dialog, select the 
Curve property sheet, and click to activate Show Frame. 
To split a curve: 
1. Choose the Split tool.
2. Click on the curve you want to split. The frame for that portion of the curve will be highlighted.
3. Move the cursor to the exact location you desire, and click to split the curve.

Note: To split a closed curve, you will need to split in two locations, defining each end of the curve section
to be split away from the rest of the curve.



Meet 2 Lines
Menu: Modify|Meet 2 Lines Toolbars: Modify, Standard

Use the Meet 2 Lines function to shrink or extend two lines or double lines so that two of their endpoints 
meet. This function automatically cleans up the corner formed by two double lines. 
1. Activate the Meet 2 Lines tool.
2. Click on the first, then the second line or double line.

When the two lines are crossed, the two lines will be shrunk in the direction of the mouse clicks. In other 
words, the two parts of the line that you click on will be preserved; the parts of the lines on the opposite 
side of the intersection will be trimmed.



Chamfer Tools
Menu: Modify|Chamfer Toolbar: Modify, Standard

Use the Chamfer tools to join two line segments or double line segments with a flattened corner. 

Subtopics
Values for Calculating Chamfers
Distance and Distance Chamfer
Distance and Angle Chamfer
Length and Angle Chamfer



Values for Calculating Chamfers
When you activate a chamfer tool, the values you can use to calculate the chamfer appear in the edit bar.
The following table describes these values and their meaning. Note that "point of intersection" means the 
point where the two lines intersect, or the point where they would intersect if they were extended.

Value Meaning
Distance A The distance from the point of intersection to the chamfer on the 

first line clicked.
Distance B The distance from the point of intersection to the chamfer on the 

second line clicked.
Length The length of the chamfer line.
Angle The angle of the chamfer line from the first line clicked.

The TurboCAD chamfer tools use three combinations of these values:
Distance and Distance
Distance and Angle
Length and Angle

Note: You can use the Multiline option to chamfer all the corners of a multiline or polygon simultaneously.
Note: If the values for length are too large in relation to the existing lines, the chamfer will not be possible,
and TurboCAD will issue the warning "Chamfer is not possible in this case."



Distance and Distance Chamfer
Menu: Modify|Chamfer|Distance/Distance Toolbars: 
Modify, Standard

The Distance and Distance Chamfer tool draws a chamfer between points on each line calculated by their
distance from the point of intersection on the first (Distance A) and second (Distance B) lines clicked:
1. Activate the Distance and Distance chamfer tool. 
2. Enter values for distances in the Dist. A and Dist. B fields of the Edit Bar. Dist. A is the distance on the

first line clicked. Dist. B is the distance on the second line clicked. Return to the drawing area by 
clicking there or pressing <Ctrl>+<D>.

3. Do one of the following:
Click on the first, then the second line.
Click on a multiline or polygon, right-click to open the local menu, then choose Multiline. This will 

chamfer all the corners of the multiline or polygon that you selected.



Distance and Angle Chamfer
Menu: Modify|Chamfer|Distance/Angle Toolbars: Modify, Standard

The Distance and Angle Chamfer tool draws a chamfer from a point on the first line clicked calculated by 
its distance from the point of intersection, at a specific angle from the first line clicked:
1. Activate the Distance and Angle Chamfer tool.
2. Type values in the Distance and Angle fields on the Edit Bar. Return to the drawing area by clicking 

there or pressing <Ctrl>+<D>.
3. Do one of the following:

Click on the first, then the second line.
Click on a multiline or polygon, right-click to open the local menu, then choose Multiline. This will 

chamfer all the corners of the multiline or polygon that you selected.



Length and Angle Chamfer
Menu: Modify|Chamfer|Length/Angle Toolbars: Modify, Standard

This method joins two lines with a chamfer of the specified length, at a specified angle from the first line 
clicked:
1. Activate the Length and Angle Chamfer tool.
2. Type values into the Angle and Length fields of the Edit Bar. Return to the drawing area by clicking 

there or pressing <Ctrl>+<D>.
3. Do one of the following:

Click on the first, then the second line.
Click on a multiline or polygon, right-click to open the local menu, then choose Multiline. This will 

chamfer all the corners of the multiline or polygon that you selected.



Line Length
Menu: Modify|Line Length Toolbars: Modify, Standard

Use the Line Length tool to extend or shrink a line segment from either endpoint. If the line segment is 
part of a multiline or polygon, as you change the length of the line segment, it retains its relationship to 
other lines within a multiline or polygon. This means that lines connected to the line endpoint you are 
moving will also change angle and length so that they remain connected to the endpoint.
1. Activate the Line Length tool.
2. Click on a line segment at a position near the endpoint that you want to modify. The segment now 

extends from the endpoint furthest from the mouse to the mouse cursor.
3. You can now set the line length in one of three ways:

Enter an absolute length for the line in the Length field of the edit bar, then press <Enter>.
Enter the amount that you want to lengthen the line in the Delta L field of the edit bar (enter a 

negative value to shorten the line), and then press <Enter>.
Move the mouse to lengthen or shorten the line, then click when it is the length you want.



Shrink/Extend Line
Menu: Modify|Shrink/Extend Line Toolbars: Modify, Standard

Use the Shrink/Extend to Object editing tool to edit the length of a line so that it precisely meets another 
entity. You can either extend the line, increasing its length until it meets the other entity; or you can shrink 
the line, decreasing its length until it just meets the other entity. To use this tool:
1. Activate the Shrink/Extend to Object tool.
2. Click on the line or double line that you want to shrink or extend.
3. Click on the entity to which you want to shrink or extend the line. TurboCAD will adjust the length of 

the line or double line until it precisely meets the second entity.



Arc Complement
Menu: Modify|Arc Complement Toolbars: Modify, Standard

Use the Complement tool to reverse the starting and ending angles of an arc. If, for example, the arc is 
drawn from 0 degrees to 90 degrees, the complement of the arc will be drawn from 90 degrees to 0 
degrees.
To change an arc to its complement, first choose the Arc Complement tool, and then click on the arc that 
you want to modify.



Fillet
Menu: Modify|Fillet Toolbars: Modify, Standard

Use the Fillet tool to connect two lines, either single or double lines, with a smoothly fitted arc. The result 
is a rounded corner. 
TurboCAD inserts an arc of a specified radius between two intersecting lines, making the arc tangent to 
both lines. The start and end angles for the arc are determined by the points at which the arc is tangent to
the two lines. TurboCAD then trims or extends the lines to form the smooth corner.
Note: You can use the Multiline option to fillet all the corners of a multiline or polygon simultaneously.
1. Activate the Modify|Fillet tool.
2. Enter the radius for the filleted arc in the Radius text box on the Edit Bar and press <Enter>. (If the 

edit bar is not visible, display it using View|Toolbars.)
3. Do one of the following:

Click on the first, then the second line.
Click on a multiline or polygon, right-click to open the local menu, then choose Multiline. This will 

fillet all the corners of the multiline or polygon that you selected.
Note: If the radius specified is too large for the arc to fit between the two lines, TurboCAD will be unable 
to perform the fillet and will display an error message. 



T-Meet 2 Double Lines
Menu: Modify|TMeet DoubleLines Toolbars: Modify, Standard

Use the T-Meet 2 Double Lines tool to form a T intersection of two double lines. The first line clicked will 
extend or shrink to form the stem of the T.
1. Activate the T-Meet 2 Double Lines tool.
2. Click on the line that will form the stem of the T.
3. Click on the line that will form the top of the T.

Note: You can choose whether or not to make a clean intersection of the two double lines. To do this, 
activate the T-Meet 2 Double Lines tool, right-click in the drawing area, then select or deselect the 
Cleanup option in the local menu.
Tip: Use Node Edit to close the ends of double lines. Select the Node Edit tool and click on the double 
line to close. Move the cursor over the node in the gap, right-click to summon the local menu, and select 
Close Double End. 



Intersect 2 Double Lines
Menu: Modify|IntersectDoubleLines Toolbars: Modify, Standard

Use the Intersect 2 Double Lines tool to clean up the intersection of two double lines. 
1. Activate the Intersect 2 Double Lines function.
2. Click on the first, then the second of two intersecting double lines.

 Note: You can choose whether or not to make a clean intersection of both double lines. To do this, 
activate the Intersect 2 Double Lines tool, right-click in the drawing area, then select or deselect the 
Cleanup option in the local menu. If you choose not to make a clean intersection, there will be a gap in 
the first line clicked, but not in the second line clicked.



Snaps and Coordinates
Modes enable you to control how TurboCAD responds to your actions when you are drawing or editing. 
Some modes are mutually exclusive; others can be used in combination. This provides you with an 
enormous number of possible techniques, but the fundamental principles underlying all the modes are 
consistent and relatively simple. Once you understand these principles, you will be able to exploit them to 
find efficient and precise methods of drawing and editing.
There are two major categories of modes:

Snap modes, which determine where exactly TurboCAD defines a point when you click the 
mouse in the drawing area.

Coordinate system modes, which determine how you can use mathematical coordinates to 
specify the location of any point on the drawing.

Subtopics
Snap Modes
Modes Menu Commands



Snap Modes
Snap modes let you define points relative to objects in the drawing area when you are drawing or editing 
with the mouse. You can define points relative to drawing entities, construction entities, and the grid. All 
snap mode functions are similar: You first set the snap mode, then click on or near the object that you 
want to snap to. Rather than defining the point exactly where you clicked the mouse, TurboCAD will 
define the point precisely on the object. The point that TurboCAD chooses depends on the snap mode. 
You can, for example, snap to the end of a line, the midpoint of a line, the center of a circle, or a point on 
the grid.

Subtopics
Snap Aperture
Local Snaps and SEKEs
Coordinate Systems
Cartesian Coordinates
Polar Coordinates
Drawing with Coordinate Systems



Snap Aperture
The critical distance between the point of the mouse click and an object or grid point is the snap aperture. 
You can think of the snap aperture as a circular area centered on the point of the mouse click. If an object
containing a qualifying snap point is located within the snap aperture at the time of the mouse click, your 
point will be defined at the nearest qualifying snap point. If more than one object is located within the snap
aperture, your point will still be defined at the closest qualifying snap point.
Note that in most cases the snap point itself does not need to be located within the snap aperture.
Tips: To see the snap aperture while you are working, choose View|Aperture. 
To get additional visual feedback when using snap modes, turn on Magnetic Point mode. When Magnetic 
Point is activated, the rubber band line that provides you feedback about the entity you are creating is 
attracted to the snap point. This lets you see exactly where the point will be defined after you click the 
mouse.
Notes: You can set the radius of the snap aperture in the General property sheet of the Options|Program 
Setup dialog.
Defining points with the status bar overrides the current snap mode and defines the point at precise 
coordinates that you specify.
See Also: Program Setup Dialog



Local Snaps and SEKEs
You can change snap modes in four ways. You can use the menu, the Snap toolbar, the local menu, or a 
Single Entry Keyboard Equivalent (SEKE). When you choose a mode from the menu or the Snap toolbar, 
the effect is the same: The snap mode changes until you reset it. The local menu and SEKEs are 
different. Use them for "one shot" mode changes. This means that when you change snap modes in the 
local menu or by pressing a SEKE, the mode remains in effect until you define the next point. TurboCAD 
then switches back to the last mode you set in the main menu or toolbar, or defaults to No Snap mode.
One-shot snaps are useful because they let you set the snap mode you use most frequently in the main 
menu or toolbar, then switch modes "on the fly" when you are working in your drawing. Many users, for 
example, like to work with Snap to Grid as their default snap mode, so they set the mode to Snap to Grid 
in the main menu. While working in a drawing they may need to snap, for example, to the corner of a 
polygon. To do this, they can press V (for Vertex) or change the snap mode temporarily to Vertex in the 
local menu and define a point on the polygon corner. TurboCAD then automatically switches back to Snap
to Grid, the mode they most commonly use.
Most SEKEs are snap commands. But a few perform other functions. Here is a list of SEKEs, in 
alphabetical order. For a complete list see Help|Keyboard.

A Set Absolute Coordinates. All coordinate references will be in Absolute Distances.
C Snap Arc Center. Connect to the center of an arc or circle. 
D Relocate reference point of a selected object.
G Snap Grid. Connect to the nearest grid point or intersection. 
H Snap Opposite. Continue line same distance from object as from first point to object. 
I Snap Intersection. Connect to the intersection of two entities.
J Snap Single Projection. Connect to an entity and project a perpendicular line.
M Snap Middle Point. Connect to the midpoint of an entity. 
N Snap Nearest on Graphic. Connect to the location on a object the cursor touches.
P Set Polar Coordinates. All coordinate references will be Polar (distance and angle).
Q Snap Quadrant Point. Connect to the nearest quadrant point on a circle or arc (0, 90, 180, 

270). 
R Set Relative Coordinates. All coordinate references will be in Relative Distances.
S No Snap. Enter the location of the point.
V Snap Vertex. Connect to the end of the line or other object. 
X Lock X. Lock the current X position as displayed in the Edit Bar. 
Y Lock Y. Lock the current Y position as displayed in the Edit Bar.
<F7> Select the last object drawn (no other objects must be selected).
<F6> Select the first object drawn (no other objects must be selected).



Coordinate Systems
Coordinate systems provide different methods of specifying the location of any point in the drawing using 
coordinates. TurboCAD has three coordinate system modes: absolute, relative, and polar. Both the 
absolute and the relative coordinate modes are in the Cartesian coordinate system.
The current coordinates of the cursor are displayed in the Coordinate Display, on the same line as the 
Status Bar at the bottom of the desktop. You can access these fields by clicking in them, or by pressing 
<Shift>+<Tab>. 



Cartesian Coordinates
A Cartesian coordinate specifies the distance of a point from the X or Y axis along a line that is parallel to 
the other axis. (When the drawing area is labeled with Cartesian coordinates it is a Cartesian plane.) You 
can specify the location of any point on the drawing using two coordinates, the first being the distance 
from the Y axis on a line parallel to the X axis, the second being the distance from the X axis on a line 
parallel to the Y axis. The intersection of the X and Y axes is the origin of the coordinate system; its 
coordinates are (0,0).
For example, to specify the location of a point that is 2 units measured horizontally from the Y axis and 3 
units measured vertically from the X axis, you would use the coordinates (2,3). For locations to the left of 
the Y axis or below the X axis you need to use negative values. To specify a location 2 units to the left of 
the Y axis and 2 units below the X axis, you would use the coordinates (-2,-2).Take a moment now to 
move the cursor around the screen, and notice how the Coordinate Display changes.

Subtopics
Absolute Coordinates
Relative Coordinates



Absolute Coordinates
When using absolute coordinates in TurboCAD, you specify the location of points relative to a location 
called the Absolute Origin, point (0,0) in the drawing plane. The Absolute Origin never changes location. 
By default, this point is in the lower-left corner of the page (although you can change the position of the 
page using the Page Setup dialog).
See Also: Page Setup Dialog
The menu command Modes|Coord System|Relocate Origin allows you to reset the origin point used by 
the Relative and Polar coordinate reference systems, not the Absolute reference system. 



Relative Coordinates
When you are working in relative coordinates in TurboCAD, you specify points on the drawing relative to a
point that we’ll call the Relative Origin. This point moves in the drawing space as you work. Suppose, for 
example, that you are drawing a multiline. As you define each point of the multiline, the point you just 
defined becomes (0,0). This enables you to draw each segment of the multiline relative to the last 
segment.
TurboCAD also has a feature that lets you fix the Relative Origin in one place, then move it manually. If 
you check the Fixed Relative Origin box in the Program Setup dialog, the Relative Origin will stay in one 
place until you explicitly move it, using the Relocate Origin command.
See Also: Program Setup Dialog, Relocate Origin



Polar Coordinates
In the polar coordinate system, you define the location of a point by its absolute distance and angle from 
the Relative Origin. As in the relative coordinate system, the Relative Origin follows you as you work. 
Note: The Edit Bar uses polar coordinates to define the length and angle of lines.
See Also: Relative Coordinates, Relocate Origin



Drawing with Coordinate Systems
TurboCAD lets you change coordinate systems at any time while you are working. If you are drawing the 
outer wall of a house, for example, you may want to start the first wall at an absolute location in the 
drawing space, so you would use absolute coordinates for the first point. Each successive wall, however, 
would be defined by its length and angle relative to the first wall, so you might use polar coordinates for 
the remaining points.
Tip: Advanced users can "force" TurboCAD to use a coordinate system other than the current system 
while working in the Coordinate Fields. If you precede a coordinate with a $ sign, it will be interpreted as 
an absolute coordinate; if you precede it with an @ sign it will be interpreted as a relative coordinate; if 
you precede it with a > sign it will be interpreted as a polar coordinate.



Modes Menu Commands
The following table summarizes the menu commands accessible from the Modes menu:

Command Function

Snaps Set the current snap mode.
Coord Set the current coordinate system.
Lock X Position Locks the X (horizontal) value as you draw
Lock Y Position Locks the Y (vertical) value as you draw

Snap Tools
Menu: Modes|Snaps Toolbar: Snap

The following table summarizes TurboCAD's snap modes:

Command Function
No Snap Turn off all snap modes; point is defined at the location of the 

mouse click.
Vertex Snap to the nearest end of a line segment, endpoint of an arc, 

or corner of a polygon or multiline.
Nearest on Graphic Snap to the nearest point on any entity.
Midpoint Snap to the midpoint of a line segment.
Arc Center Snap to the center of an arc or circle.
Quadrant Point Snap to the nearest quadrant point (at 0, 90, 180, or 270 

degrees) on the circumference of a circle or arc.
Intersection Snap to the nearest intersection of two entities.
Grid Snap to the nearest grid point or intersection of grid lines.
Ortho Constrain the angles of lines; the default settings constrain 

them to 0, 90, 180, or 270 degrees. (You can change these 
settings in the Angle property sheet.)

Perpendicular Snap Use Perpendicular Snap Opposite to connect a line to an entity 
so that the line is perpendicular to the entity.

Show Magnetic Point Increase visual feedback; the rubber band line you are currently
drawing will gravitate toward the snap point.

Subtopics
Combining Snap Modes



Combining Snap Modes
Some snap modes can be combined, and some are mutually exclusive. The No Snap tool turns off all 
other snap modes. Nearest on Graphic snap (which snaps to the nearest point on any object) also turns 
off all other snap modes. (Ortho and Magnetic point can stay on no matter which of the other snap modes
are active.)
The remaining snap modes all snap to a particular node (nodes are key points that define the object 
geometrically), and they are not mutually exclusive. You can, for example, have Snap to Grid and Snap to
Vertex on simultaneously. If you then click the mouse while a grid point and a line segment are both within
the snap aperture, your point will snap to either an endpoint of the line segment, or to the grid point, 
whichever is closest to the mouse cursor.
Note: The snap modes that can be used at the same time are all in the same section of the Modes|Snaps
submenu.



No Snap
Menu: Modes|Snaps|No Snap          SEKE: S Toolbar: Snap

Activating No Snap will turn off all snap modes except Ortho. With snap modes turned off, you define 
points by simply clicking at the point that you want to define in the drawing area, or by entering the point’s
coordinates on the status bar.
No Snap is the least accurate of all snap modes. It relies on cursor position, which is dependent on 
screen resolution and the zoom factor.
The SEKE version of No Snap will not turn off other snap modes. You may find it useful to have all other 
snap modes on, and use No Snap as a SEKE when you need to place a point freehand.
Note: If Ortho mode is on, the second point of a line will snap to a point to constrain the angle of the line, 
even if No Snap mode is active.
See Also: Ortho



Snap to Vertex
Menu: Modes|Snaps|Vertex SEKE: V Toolbar: Snap

When Snap to Vertex mode is active, the point you are defining will snap to the nearest vertex on an 
entity within the snap aperture. A vertex in TurboCAD can be:

The endpoint of any line segment (either a simple line or a segment of a multiline).
A corner of a polygon.
The endpoint of an arc or curve.

Note: When snapping to a double line, your point will be defined at the endpoint of either of the single line
segments that comprise the double line, or the double line's reference point, depending on which point is 
closer to the cursor.



Snap to Nearest on Graphic
Menu: Modes|Snaps|Nearest On GraphicSEKE: N Toolbar: Snap

When Snap to Nearest on Graphic mode is active, a point will be defined at the nearest point to the cursor
on an object within the snap aperture.
Nearest on Graphic is similar to No Snap in that it relies on cursor position, which is dependent on screen 
resolution and the zoom factor. The difference is that Nearest on Graphic will find the nearest vertex, 
center point, etc. 



Snap to Midpoint
Menu: Modes|Snaps|Middle Point SEKE: M Toolbar: Snap

When Snap to Midpoint mode is active, the point you are defining will snap to the midpoint of a line 
segment. A line segment can be any part of an entity, such as one of the lines in a double line, or a 
segment of a multiline or polygon.



Snap to Arc Center
Menu: Modes|Snaps|Arc Center SEKE: C Toolbar: Snap

When Snap to Arc Center is active, the point you are defining will snap to the center of an arc or circle 
that you indicate. To indicate the arc or circle, click on or near its perimeter.



Snap to Quadrant Point
Menu: Modes|Snaps|Quadrant Point SEKE: Q Toolbar: Snap

When Snap to Quadrant Point is active, the point you are defining will snap to the nearest quadrant point. 
Quadrant points are at 0 degrees, 90 degrees, 180 degrees, and 270 degrees on the circumference of an 
arc or circle.



Snap to Intersection
Menu: Modes|Snaps|Intersection SEKE: I Toolbar: Snap

When Snap to Intersection is active, the point you are defining snaps to the intersection of two lines. Both 
lines must be located within the snap aperture; but the intersection need not be located within the snap 
aperture.



Snap to Grid
Menu: Modes|Snaps|Grid SEKE: G Toolbar: Snap

When Snap to Grid is active, the point you are defining snaps to the nearest grid point, or to the nearest 
intersection of grid lines, if the grid is being displayed in lines rather than points or crosses.
If Advanced Grid options frequency is set to a figure of more than one, invisible grid lines will also respond
to this snap mode. 
See Also: Grid Property Sheet



Perpendicular Snap 
SEKE: J

Use Perpendicular Snap Opposite to connect a line to an entity so that the line is perpendicular to the 
entity. Start by defining the first point of the line (using any snap as needed). Then move the cursor onto 
the target line, and press <J>. The line will snap to the entity so that the line is perpendicular. 



Ortho
Menu: Modes|Snaps|Ortho SEKE: Shift Toolbar: Snap

Ortho mode constrains the angle of the entity you are drawing. By default, Ortho mode will constrain the 
angle of the entity so that it will be parallel to either the X or Y axis of the drawing. You can change these 
default settings in the Angle property sheet.
See Also: Angle Property Sheet
Note: Pressing the <Shift> key while using any drawing tool provides a temporary ortho mode.



Show Magnetic Point
Menu: Modes|Snaps|Show Magnetic Point Toolbar: Snap

Magnetic Point provides visual feedback about the location of snap points. When this mode is active, as 
you move the mouse cursor within a critical distance from the snap point, the rubber-band line will be 
attracted to the snap point, showing you its exact location. Unless speed is a consideration on your 
computer, or unless you are working on a very large drawing, it is useful to have this mode on all the time.
See Also: Snap Aperture



Coordinate System
Menu: Modes|Coord System Toolbar: Snaps

The coordinate system menu commands enable you to change between absolute, relative, and polar 
coordinates, and to relocate the origin of the relative and polar coordinate systems. The following table 
summarizes the coordinate system commands:

Command Function

Absolute Change to absolute Cartesian coordinates, in which you define points by 
their distance from a fixed (absolute) point of origin.

Relative Change to the relative coordinate system, in which you define points by 
their X and Y distance from the Relative Origin point.

Polar Change to the polar coordinate system, in which you define points by their 
distance and angle from the Relative Origin point.

Relocate Origin Change the position of the Relative Origin point.

See Also: Coordinate Systems



Absolute Coordinates Command
Menu: Modes|Coord System|Absolute Coords SEKE: A Toolbar: Snap

Use the absolute coordinate system to work in Absolute Cartesian coordinates. When working in absolute
coordinates, you define points by their X and Y distances from the Absolute Origin. This fixed point, (0,0) 
is located by default at the lower-left corner of the drawing page (although the page can be moved using 
the Page Setup dialog).
For example, to draw a horizontal line two units long starting at (2,2), you would define the line’s second 
point at (4,2).
See Also: Coordinate Systems



Relative Coordinates Command
Menu: Modes|Coord System|Relative Coords SEKE: R Toolbar: Snap

Use the relative coordinate system to work in relative Cartesian coordinates. When you work in relative 
coordinates, you define the location of points relative to the Relative Origin (relative (0,0)). To define a 
point relative to the current position, you can enter X and Y displacement values in the Coordinate Fields. 
You can enter either positive or negative values. The displacement values specify the distance of the new 
point from the Relative Origin.
Note: The Relative Origin moves whenever you define a new point. In most cases, the Relative Origin will
be the last point you defined. If you are drawing a circle or arc, however, the Relative Origin will be at the 
center of the circle or arc. The Relative origin is displayed as a small red square when Relative 
Coordinates is the active mode.
Tip: You can fix the Relative Origin so that it does not move by checking the Fixed Relative Origin box in 
the Program Setup dialog (General property sheet). You can then move the Relative Origin manually 
using the Relocate Origin command.
See Also: Coordinate Systems, Relocate Origin, Program Setup Dialog



Polar Coordinates Command
Menu: Modes|Coord System|Polar Coords SEKE: P Toolbar: Snap

Use the polar coordinate system when you want to define points by their distance and angle from the 
Relative Origin Point. When you start a new drawing, this point is located at the same position as the 
Absolute Origin Point, at absolute (0,0). You can move the Relative Origin Point using the Relocate Origin
command. Since Polar Coordinate mode is a variation of Relative Coordinates, the origin point is 
displayed as a small red square when Polar Coordinates is the active mode.
Let’s say, for example, that you have defined the first point of a line in any coordinate system, and you 
want to draw a line exactly 3.5 units long at a 45 degree angle from the first point. You can accomplish 
this by following these steps:
1. If you are in another coordinate system, switch to polar coordinates.
2. Press <Shift>+<Tab> to access the Coordinate Display.
3. Type 3.5 into the length text box on the status bar.
4. Type 45 into the angle text box on the status bar, then press <Enter>.

See Also: Coordinate Systems



Relocate Origin
Menu: Modes|Coord System|Relocate Origin Toolbar: Snap

Use the Relocate Origin command to manually relocate the Relative Origin point. When you start a new 
drawing, this point is located at the lower-left corner of the page, and appears as a red dot if Relative or 
Polar Coordinates is the active mode. You can relocate the point using any coordinate system; that is, you
can specify its position in absolute, polar, or relative coordinates. To relocate the point of origin:
1. Choose Relocate Origin from the menu.
2. Define a point for the new origin by clicking the mouse in the drawing space or entering values in the 

status bar (the type of values you enter in the status bar depend on the currently active coordinate 
system).

See Also: Coordinate Systems



Lock X Position / Lock Y Position
Menu: Modes|Lock X Position, Modes|Lock Y Position SEKE: X, 
SEKE: Y

These two commands are menu alternatives for clicking the lockbox corresponding to the X and Y 
coordinates in the Status Bar. They function as toggles: When one is selected from the menu, the 
command is active. To deselect, click the menu item again or click the appropriate lockbox in the Status 
Bar. 
When either Lock X or Lock Y is selected, the values in the Status Bar for the selected field doesn’t 
change when you move the mouse over the drawing area. This makes it possible to lock down one of the 
values and manipulate the second value with the mouse. 
See Also: Using the Edit Bar Lockdown Boxes 



Options Menu and Dialogs 
The Options menu gives you access to dialog boxes that control TurboCAD program and drawing 
settings. These features let you: 

Set program options that are saved with the application. 
Set drawing options that are saved with a drawing or a template.

Subtopics
Program and Drawing Setup
Units and Scale
Setting Up the Grid
Setting Up Layers
Options Menu Commands



Program and Drawing Setup
The Options menu contains two large sections, Program Setup and Drawing Setup. Changes that you 
make in the Program Setup are saved whenever you exit TurboCAD. The next time you start TurboCAD, 
the settings will be exactly the ones you selected. Changes that you make in the Drawing Setup dialog 
are saved with your drawing, and they will come back exactly as you left them the next time you open the 
drawing in which they were saved. 
If you have a standard way of setting up a drawing and you want to use the settings to create other 
drawings, you can save the Drawing Setup options in a template using the File|Save As dialog. You can 
make the template that you use most frequently the default template (the template that TurboCAD 
chooses if you don’t specify a template) in the Create from Template dialog. You can also create multiple 
templates for different types of CAD tasks. 
Tip: To save the setup of your Desktop controls (that is, the display and position of toolbars and other 
interface controls), you must check the Save Desktop on Exit box in the General property sheet of the 
Program Setup dialog. 
See Also: Drawing Setup Dialog, Program Setup Dialog, Save As Dialog



Units and Scale
TurboCAD has two distinct "spaces": world space and paper space. The units in world space apply to the 
real-world object that your drawing illustrates. The units in paper space apply to the paper on which your 
drawing will be printed. Scale is the ratio of Paper units to World units. A scale of 
3/16" = 1’, for example, means that an object 3/16" long in your drawing is modeling a real-world object 
that is one foot long. 
Normally the coordinate system, the ruler, and the grid all show units in world space. You can switch to 
paper space by clicking the icon in the upper-left corner of the Ruler. 
Note: Dimensions always show World units, unless you manually override the dimension text. 
The Units and Scale property sheet and the Advanced Units property sheet give you control over: 

The type of units used in both paper space and world space. 
The scale of your drawing. 
The format and precision of the numbers in your drawing. 

You can set these options either by choosing from one of TurboCAD’s standard settings, which 
correspond to settings common to specific CAD disciplines, or you can specify custom settings. 
See Also: Advanced Units Property Sheet, Units and Scale Property Sheet



Setting Up the Grid
The grid is a matrix, displayed as a pattern of dots, crosses, or lines that divides your drawing 
geometrically into Cartesian, isometric or polar coordinate locations. You can make the grid visible or 
invisible using the Grid Display tool on the Grid toolbar, or the View|Grid menu command. You make the 
grid active or inactive by switching the Snap to Grid option on and off (using the Modes|Snaps|Grid menu 
option, the Snap toolbar, or the local menu). Note that you can snap to an invisible grid, and you can view 
an inactive grid: Whether or not the grid is visible has nothing to do with whether it is active. 
TurboCAD has a major grid and a minor grid. The major grid shows larger divisions of your drawing 
space; the minor grid shows finer divisions of the drawing space between the major divisions. If you want 
to customize the grid setup, you can specify how many minor grid points there are between major grid 
points; and you can specify how frequently the grid points are visible, so that only larger grid divisions are 
visible, but you can still snap to the finer divisions. 
You can also rotate the grid at an angle, offset the grid so that it aligns with an object in the drawing, or 
change the magnification of the grid. 
See Also: Advanced Grid Property Sheet, Grid Property Sheet, Snap to Grid, View Grid Options



Setting Up Layers
One of the most powerful ways you can organize a complex drawing is to create layers on which to place 
different categories of objects. Layers are like acetate sheets used in traditional drafting. 
Layers in TurboCAD can be visible or invisible, editable or not editable. These properties allow you to 
view only the drawing objects that are relevant to the current task, and to protect objects on the drawing 
from inadvertent change. You can also distinguish layers of the drawing by giving them distinct colors and 
line styles. You can assign colors and styles to layers in the Layers property sheet. Objects on the layer 
will then have the color and line style assigned to the layer, provided the relevant properties of the object 
are set to By Layer. For example, if you want an object’s pen color to have the default color of the 
object’s layer: 
1. Double-click on the object with the Select tool to go to the object’s property sheets. 
2. Bring the Pen property sheet to the front. 
3. Set the Color property to By Layer. 
4. Click <OK> to close the dialog. 

See Also: Layers Property Sheet



Options Menu Commands
The following table summarizes the commands accessible from the Options menu. Only the major menu 
items are shown. The indented items on the menu are shortcuts that go directly to individual property 
sheets in the Program Setup and Drawing Setup dialogs. 

Command Function 

Program Setup Display the Program Setup dialog, in which you can set options 
that are saved when you exit TurboCAD. 

Drawing Setup Display the Drawing Setup dialog, in which you can set options 
that are saved with your drawing. 

Program Setup Dialog
Menu: Options|Program Setup Toolbars: Setup, Standard

The Program Setup dialog contains property sheets for controlling TurboCAD program settings, 
summarized in the following table:

Property Sheet Functions 

General Specify template, how to create a new drawing, read-only 
file access, user information, snap aperture, zoom factor, 
save, and advanced settings. 

Desktop Display and hide user-interface controls,    control desktop 
colors and paper display. 

Toolbars and Menu Set options for use and appearance of toolbars and 
menus. Access to Customization options for toolbars, 
menus, and keyboard shortcuts .

Auto-Naming Set options for naming groups, blocks and symbols. 
File Locations Specify directories for autosave, backup, template, symbol

library, script, raster, and drawing files.
Symbol Libraries Specify libraries to be available in the symbol library 

palette. 
Color Palette Add new colors to the palette, modify existing colors, and 

delete colors from the palette.

You can access each of these property sheets directly from the Options menu, which gives you the 
convenience of opening the Program Setup dialog with the correct property sheet in front using a single 
command. The options that you set in this dialog are saved when you exit TurboCAD, and will remain in 
effect the next time you start the program.



General Property Sheet of Program Setup Dialog
Menu: Options|Program Setup 

In the General property sheet, you can set general program options and user information. The controls on
this property sheet enable you to: 

Specify the default method of creating a new document.
Set the default template used when you start a new drawing, and specify whether TurboCAD will 

prompt you for a template when you start a new drawing. 
Specify whether drawings are opened as read-only files. 
Read and update user information. 
Set the zoom factor and snap aperture. 
Specify options for saving drawings, including backup copies.
Choose Geometric Selection or Fixed Relative Origin.

The General property sheet contains the following controls: 
New Document From. Select the preferred default behavior of the File|New menu option.
Default Template for New Files. If you do not specify a template when you start a new drawing, 
TurboCAD will use a default template. To change the default template, click the arrow on the right side of 
the drop-down list and choose a template (or type a template name directly into the box). 
Prompt for Template Name. Check this box if you want TurboCAD to prompt you for a template 
whenever you start a new drawing. If you want to use the default template without being prompted, clear 
this check box. 
See Also: Save As Dialog, Open, New 
Open All Files as Read-Only. There may be times when you want to look at drawing files without 
changing them, or prevent them from being inadvertently changed by someone else. Check this box to 
prevent anyone using TurboCAD from changing existing files. To restore the ability to change files, clear 
the check box. 
User Information. The User Information text fields contain the user and company name.
Zoom Factor. The zoom factor setting controls how much you zoom in or out of the drawing when you 
use the Zoom In (Numeric Keypad <+>) or Zoom Out (Numeric Keypad <->) command. The default zoom 
step setting is 2, which is a factor, meaning that if you zoom in one step, objects will be twice as big; if you
zoom out one step, objects will be half as big, and the area of the drawing shown in the view will double. 
You can set the zoom step to any number between 1.01 and 2000.
Snap Aperture. The snap aperture is a circular area around the mouse cursor. TurboCAD will detect and 
snap to a potential snap point only if it is within the snap aperture. (Which points qualify as potential snap 
points depends on the current snap mode.) You can set the radius of the snap aperture using the snap 
aperture control.
Tip: You can view the Snap Aperture as you work by choosing View|Cursor|Aperture.
See Also: Snap Aperture, Snap Modes, Snap Tools, View Crosshairs, Zoom In, Zoom Out, Zooming

Subtopics
Save Options
Advanced Settings



Save Options
The General property sheet includes several ways to control how TurboCAD saves drawing files. 
Prompt for summary information. If this box is checked, TurboCAD will display the Summary 
Information dialog, in which you can record information about your drawing, the first time that you save 
any drawing to disk, and whenever you use Save As to save a new copy of the file. 
Make backup copies. If this box is checked, TurboCAD will automatically make backup copies of your 
drawings whenever you save them. You can choose either the On First Save or On Every Save option 
button to determine how often TurboCAD saves your backup files. Backup files share the same file name 
as the drawing file, but have the file extension .BAK instead of .TCW. By default, backup files are saved in
the same directory as your primary drawing files. You can specify another directory in the File Location 
property sheet of this dialog. 
Save drawings every. If this box is checked, TurboCAD will make autosave copies (.ASV files) of your 
document automatically at regular intervals. You can set the duration of the intervals in minutes using the 
Minutes control just below the check box. If there is a system crash while TurboCAD is in use, TurboCAD 
will open the autosave version of your drawing as soon as you launch TurboCAD. Autosave files are 
stored in the \AutoSave folder. 
Save desktop on exit. If this box is checked, TurboCAD will save the desktop settings when you exit the 
program. This means that TurboCAD will "remember" which toolbars and other controls you have 
displayed, as well as their positions on the desktop, and will display them exactly the same way the next 
time you start the program.
See Also: Save, Save All, Save As Dialog, Desktop Property Sheet



Advanced Settings
Fixed Relative Origin. Check this box if you want to fix the Relative Origin in place while you are in 
relative or polar coordinates. You will have to relocate the Relative Origin manually using the Modes|
Coord System|Relocate Origin command. 
Geometric Select Edit. Check this box if you want to select objects by their geometric extents, rather 
than their cosmetic extents. This permits geometrically accurate scaling of objects like double lines and 
lines that have width, because the geometric and cosmetic extents differ. 
See Also: Geometric and Cosmetic Select Modes, Advantages of Geometric Select Edit



Desktop Property Sheet
Menu: Options|Desktop Toolbars: Setup, Standard

The Desktop property sheet contains controls that let you: 
Display and hide docking palettes and tabbed toolbars. 
Display and hide the paper margins and background.
Set the color of the paper, background, and floating palettes.
Set the status of Workspace controls.

See Also: View Toolbars, View Rulers, View Edit Bar, View Symbol Library, View Measurement Info

Subtopics
Palettes
Workspace Controls
Desktop Colors and Paper Display



Palettes
Palettes. This expandable list displays the names of dockable palettes and tabbed toolbars. Click the plus
symbol before each name to expand the list; click the minus symbol to contract the list again. When the 
list is expanded, you can click the selection box to choose which palette will be active. You may see one 
or more docking palettes depending on whether or not the palettes are sharing the same window. Palettes
can be given their own window (and allowed to float) by dragging the palette’s name tab into the drawing 
area.    



Workspace Controls
The Workspace section of the Desktop Property Sheet contains four check boxes that control the display 
of: 

Edit Bar 
Status Bar 
Scroll Bars 
Rulers 

Checking a box displays the corresponding control; clearing the box hides the control.
Tip: It is a good idea to switch off controls that you do not regularly use, to increase the size of your 
drawing area.



Desktop Colors and Paper Display
The Desktop Color control group contains buttons for customizing the color of the paper, background, and
floating palettes. Click the arrow in the drop down box and Select Paper, Background, or Floater. Click the
Modify button to change the color using the Color Wheel.
Tip: You can also click the different elements in the preview to bring up the color wheel for that element
See Also: Using the Color Wheel
The Paper Display control group lets you display or hide the paper margins, and set whether the 
background behind the paper is colored or white: 
Show Margins. Check this box to display page (printer) margins; clear the box to hide them. 
Show Background. Check this box to display a background behind the paper; clear the Background 
check box to display a white background.
Tip: You can switch off the paper until you’re ready to print, then use the Fit feature of the Page Setup 
Dialog to place your drawing on the page.



Toolbars and Menu Property Sheet
Menu: Options|Toolbars and Menus Toolbars: Setup, Standard

The Toolbars and Menu property sheet contains controls that let you select toolbars for display, and 
modify the appearance of toolbar buttons. Links are also available, in TurboCAD Learning Edition, from 
this sheet to the customization commands for creating keyboard shortcuts and modifying menus. 

Subtopics
Toolbar controls
Menu and Keyboard Controls



Toolbar controls
Toolbars. The Toolbars scrolling list displays the names of all the toolbars available in TurboCAD. 
Currently displayed toolbars are checked. To display a hidden toolbar, scroll through the list and click on 
the check box next to the name of the toolbar, displaying the check. To hide a currently displayed toolbar, 
click on the box, removing the check. 
Color Buttons. Check this box for color buttons, clear it for gray-scale buttons. 
Large Buttons. Check this box for large buttons, clear it for standard size buttons. 
Show Tooltips. Check this box to display tooltips (the yellow boxes that appear under the button if you 
hold the mouse cursor over them); clear the box to suppress display of tooltips.
Properties|Update All Styles. Check this box to allow the Properties Toolbar to change all styles for all 
tools. This function is also available in the View|Toolbars dialog.
The next five buttons, available in TurboCAD Learning Edition offer commands for creating, modifying and
deleting toolbars. 
New. Click the new button to create a new toolbar.
Rename. Click this option to rename the selected toolbar.
Delete. Click this box to delete the selected toolbar. 
Reset All. Click this box to reset all the toolbars appearing on-screen to the original style. 
Customize. Click this box to customize the contents of new or existing toolbars. 



Menu and Keyboard Controls
The Menus and Keyboard control group, at the bottom of the Toolbars and Menu property sheet, offers to 
modify existing menus and keyboard shortcuts, and to return to established defaults for menus and 
keyboard shortcuts. 
Menus Reset. Click this button to reset all menus to program defaults. 
Menus Customize.Click this button to customize the contents of new or existing menus. 
Keyboard Reset. Click this button to reset all keyboard shortcuts to program defaults. 
Keyboard Customize. Click this button to create new keyboard shortcuts, or to edit existing keyboard 
shortcuts. 



Auto-Naming Property Sheet
Menu: Options|Auto-Naming Toolbars: Setup, Standard 

The Auto-Naming property sheet lets you control whether and how TurboCAD generates names for 
groups, blocks and symbols, and set whether TurboCAD prompts for group and block names.
Tip: The name of a group, block, or symbol is displayed on the General property sheet of the Properties 
dialog. To view this dialog, you can simply double-click on the object in the drawing.
See Also: Create Group, Create Block , Properties Dialog
The following controls let you determine how TurboCAD handles the naming of groups: 
Generate group names. If this option is checked, TurboCAD automatically generates a name whenever 
you create a group. 
Group name prefix. If the Generate Group Names option is on, you can type a string (a series of 
characters) into the Group Name Prefix text box, and TurboCAD will use this string to automatically 
generate group names. All the characters you type into the box are used literally, except the ‘@’ 
character, which is a placeholder for a group number that TurboCAD generates automatically. You can 
type the ‘@’ character in the name at the place where you want the automatic number to appear. For an 
explanation of how this works, see Automatic Group, Block and Symbol Numbering . 
Prompt for name. Check this option if you want TurboCAD to prompt you for a name every time you 
create a new group.
Note: If you turn off both the Prompt    for Name and Generate Group Names options, TurboCAD will not 
name groups.
Tip: You can subsequently name or rename a group by editing its properties. To do this:
1. Select the group that you want to rename. 
2. Double-click on the group to bring up the Properties dialog. 
3. Type a name for the group into the Attribute text field, then click OK to close the dialog. 

See Also: Create Group, Explode, Properties Dialog

Subtopics
Block Options
Automatic Group, Block and Symbol Numbering
Symbol Options



Block Options
The following controls let you determine how TurboCAD handles the naming and initial insertion of blocks:
Generate block names. If this option is checked, TurboCAD automatically generates a name whenever 
you create a block. 
Block name prefix. If the Generate Block Names option is on, you can type a string (a series of 
characters) into the Block Name Prefix text box, and TurboCAD will use this string to automatically 
generate block names. All the characters that you type into the box are used literally, except the ‘@’ 
character, which is a placeholder for a block number that TurboCAD generates automatically. You can 
type the ‘@’ character in the name at the place where you want the automatic number to appear. For an 
explanation of how this works, see Automatic Group, Block and Symbol Numbering . 
Prompt for name. Check this option if you want TurboCAD to prompt you for a name every time you 
create a new block. 
Insert blocks when creating. If this option is checked, TurboCAD will place an insertion of the block in 
your drawing at the time that you create it. If this option is cleared, then TurboCAD will create the block, 
which will appear in the Blocks palette, but will not leave an insertion of the block in your drawing.
Tip: If you clear the Generate Block Names option, TurboCAD will automatically prompt you for block 
names, since every block must have a unique name.
See Also: Automatic Group, Block and Symbol Numbering, Create Block



Automatic Group, Block and Symbol Numbering
When TurboCAD generates a group, block or symbol name, it automatically gives the group or block a 
number, which increases by 1 whenever you add a new group or block to the drawing. This ensures that 
all groups, blocks and symbols have unique names. By default, the names that TurboCAD generates are 
"Group 1", "Group 2", "Block 1", "Block 2", "Symbol 1," "Symbol 2," and so forth. 
You can change the default that TurboCAD uses for automatically naming groups, blocks and symbols in 
the Group Name Prefix, Block Name Prefix and Symbol Name Prefix text boxes. The names that you type
in these text boxes have two parts: the name itself (any series of characters), and the ‘@’ character, 
which is a placeholder for the automatic number. You can place the ‘@’ character anywhere in the name, 
to specify where TurboCAD will place the automatic number. 
For example, if you type "Part @" in the Group Name Prefix text box, then create the first group in a 
drawing, the group will automatically be named "Part 1", and the next group you create will be named 
"Part 2". If you type "#@ gear" into the Group Name Prefix text box, then create the first group in a 
drawing, the group will be named "#1 gear," and the next group you create will be named "#2 gear."
Note: The first ‘@’ that you include in the name is a placeholder for the automatic number. Any ‘@’ 
characters that occur after the first one will be part of the literal name.
See Also: Create Group, Create Block



Symbol Options
The following controls let you determine how TurboCAD handles the naming of symbols:
Generate Symbol Name. If this option is checked, TurboCAD will automatically assign a name to each 
new symbol you create. (Symbols are created by dragging a selection into the symbol palette.) The 
information in Symbol Name Prefix will be used to assign this name. If the option is not checked, 
TurboCAD will prompt you to supply a name for each new symbol.
Symbol Name Prefix. If Generate Symbol Name is checked, TurboCAD will use the information in this 
text box to name new symbols. All the characters that you type into the box are used literally, except the 
‘@’ character, which is a placeholder for a sequence number that TurboCAD generates automatically. 
You can type the ‘@’ character in the name at the place where you want the sequence number to appear.



File Locations Property Sheet
Menu: Options|File Locations Toolbars: Setup, Standard

The File Location property sheet allows you to specify the directories where TurboCAD places these 
different types of program files: 
Templates (.TCT). Files in which you save settings, as well as block libraries, symbol libraries, and 
scripts, that you can start with as the basis of a new drawing. 
Scripts (.BAS). Files containing Enable BASIC scripts. This setting specifies the default directory when 
you choose Tools|Run Script. 
Backups (.BAK). These are copies of drawing files that TurboCAD saves, if you check the Make Backup 
Copies option in the General property sheet. 
AutoSave Files (.ASV). These are program files that TurboCAD saves automatically, if this option is 
turned on in the General property sheet. These will allow you to restore work that would otherwise be lost 
due to a system crash. 
Symbol Library Files (.SLW). These are sets of related symbols, saved to one common file.
Raster Files. These are bit-image files, possibly created by a scanner. The Trace raster-to-vector 
conversion utility can generate vector images from bit-image (raster) files. 
Drawings (.TCW). These are the drawings you create as you use TurboCAD. 
To specify a directory in which to place a type of file: 
1. In the list box, select the file type for which you want to specify a directory. 
2. Click the modify button. TurboCAD will display a standard Windows Open dialog. 
3. Use the standard Windows dialog to navigate to the drive and directory where you want to place the 

files. Click Open to accept the directory.

Tip: If you have two disk drives (or access to a network drive), it is wise to have your backup files 
automatically saved to a second drive. If the drive that contains your drawing files is damaged, you can 
recover your backup files from the second drive.



Symbol Libraries Property Sheet
Menu: Options|Symbol Libraries Toolbars: Setup, Standard

The Symbol Libraries Property Sheet displays the names of all folders which contain symbols, as well as 
all .SLW files. Use this palette to select the active symbol library, to modify the name of a library folder or 
file, and to delete or modify symbol library files and/or folders.
New. Click this button to add a folder to the list of folders available for symbol placement.You may specify 
any folder on any available drive as a symbol library folder. 
Modify. Click this button to modify the definition of a selected folder.
Remove. Remove the selected folder from the list of available symbol libraries. This action does not 
remove a folder from the hard drive, it only removes mention of it from the list of available symbol 
libraries. 
Remove All. Remove all listed folders from the list of available symbol libraries.This action does not 
remove these folders from the hard drive, it only removes mention of them from the list of available 
symbol libraries. 



Color Palette Property Sheet
Menu: Options|Color Palette 

The Color Palette dialog displays all colors currently available in TurboCAD. These colors and their 
names are displayed in a scrolling list, and also in a palette to the right of the scrolling list. The Color 
Palette dialog lets you add new colors, modify existing colors, and delete colors from the list.

Subtopics
Adding a New Color
Modifying an Existing Color
Deleting a Color
Using the Color Wheel
Picking Colors with the Mouse
Setting RGB Values
Setting Hue, Saturation, and Value



Adding a New Color
By blending color values (explained in Using The Color Wheel), it is possible to create new colors. To add 
a new color: 
1. Type a name for the color in the Color text box. 
2. Click the New button, which displays the Pick a Color dialog.
3. Use the Color Wheel to define a new color, then click the OK button. 

The new color that you defined will appear in the scrolling list and palette controls. This color will now be 
available for formatting the pen and brush colors of objects.
See Also: Using the Color Wheel



Modifying an Existing Color
To modify an existing color: 
1. Select the color that you want to modify in the scrolling list or in the palette control.
2. Click the Modify button, which displays the Color Wheel. 
3. Use the Color Wheel to redefine the color, then click the OK button. 

Notice that the color is now changed in the scrolling list and palette controls. The modified color will now 
be available for formatting the pen and brush colors of objects.
See Also: Using the Color Wheel



Deleting a Color
To delete a color that you no longer need to use in your drawing work: 
1. Select the color in the scrolling list or in the palette control. 
2. Click the Delete button.

Note: Objects that have already been colored in a color that you delete will still have the deleted color.



Using the Color Wheel 
The Color Wheel dialog lets you specify colors that you can add to your drawing’s color palette, or use to 
replace an existing color in the palette. The dialog contains a color wheel, which displays a spectrum of 
available colors, and a scroll bar with which you can control the overall brightness of the colors on the 
wheel. It also contains controls that let you define a color by directly entering its RGB (Red, Green, Blue) 
values, or by specifying its Hue, Saturation, and Value, which correspond to positions on the color wheel 
and scroll bar. 
A lower color display box to the left of the color wheel gives you visual feedback about the color you have 
chosen. If you are modifying an existing color, the original color will be displayed in the upper color display
box.



Picking Colors with the Mouse
To pick a color with the mouse: 
1. Set the overall brightness of the color wheel using the scroll bar to the right of the wheel. 
2. Click the wheel on the color and shade you want. An example of the color you have picked will appear

in the color display box to the left of the color wheel.



Setting RGB Values
Screen colors can be defined by a combination of Red, Green, and Blue (RGB) values. Each of these 
values can be set to an integer from 0 to 255. For example, an RGB setting of (0,0,0) is black; an RGB 
setting of (255,255,255) is white. A setting of (255,0,0) is "pure" red, and a setting of (0,255,255) is Cyan. 
To define a color by its RGB values, enter the values in the R, G, and B controls on the dialog. Notice that
the color in the lower color display box changes to correspond to the values you have entered, and the 
position of the color picker on the color wheel changes as well.



Setting Hue, Saturation, and Value
Hue and Saturation settings correspond to physical positions on the color wheel. Hue represents an 
angular position on the wheel measure in degrees (corresponding to the color spectrum), and can have a 
value from 0 to 360. Saturation represents a radial position on the wheel (corresponding to the amount of 
"grayness" in the color), and can have values from 0 to 255. Value controls the overall brightness on the 
color wheel, so changing the value in this control is the same as using the scroll bar to the right of the 
color wheel.



Drawing Setup Dialog
Menu: Options|Drawing Setup Toolbars: Setup, Standard

The Drawing Setup dialog includes eight property sheets containing settings that are saved in a drawing 
or template file. These property sheets are summarized in the following table:

Property Sheet Functions 

Display Set options for optimizing redraw speed. 
Grid Choose the grid type and other grid options. 
Units and Scale Set the unit of measure, the drawing scale, and related options.
Angle Choose direction, units, and base angle for angular 

measurements.
Scripts View and maintain scripts in current drawing or template. 
Layers Create new layers, modify existing layers, and delete layers.
Advanced Grid Control the major and minor grid origin and frequency. 
Advanced Units Set paper, text, and line width units.

Display Property Sheet
Menu: Options|Display 

The Display property sheet contain options for adjusting the quality and redraw speed of the screen 
display.
Quick text. Check this box to display all text as small boxes. 
Quick line styles. Check this box to simplify the display of line styles. 
Quick vector brush. Check this box to simplify the display of hatch patterns. 
Suppress display of objects smaller than. Type a value to set the size at which TurboCAD will draw a 
simplified representation of objects. This size is measured in device units (the "device" being your 
computer’s display), so that one inch will be equal to approximately one inch of space on your screen. At 
smaller sizes, TurboCAD will display entities using a simplified representation, decreasing the amount of 
time that TurboCAD needs to calculate and display the entity. As you zoom in, you get the detail required 
for precise editing; as you zoom out, you get faster redraw.
Device Pen Width. This setting controls the printed width of lines set to "zero" value in a drawing.
Tip: If you are working in a very large drawing or if you are using a relatively slow system, you may be 
able to increase your screen redraw speed by clicking one or more of the options in the Performance 
control group of this property sheet. The amount of speed that you gain depends on the amount of text, 
styled lines, and fill patterns that your drawing contains.



Grid Property Sheet
Menu: Options|Grid Toolbars: Setup, Standard

The grid is a matrix, displayed as a pattern of dots, crosses, or lines, that divides your drawing 
geometrically into Cartesian or polar coordinate locations. 
The Grid property sheet allows you to control grid type (Ortho, Isometric, or Polar), display style (Points, 
Crosses, and Lines), the distance between grid points (or intersections), and the grid color. 

Subtopics
Grid Type
Grid Color
Grid Style
Grid Spacing
Other Grid Controls



Grid Type
Click the appropriate option buttons in the Type area of the property sheet to set the grid to any one of the
following types: 
Ortho. Choose this option for an orthogonal grid. Points of the orthogonal grid are aligned parallel to the 
X and Y axes of the Cartesian plane. 
Isometric. Choose this option for an isometric grid. Points in the isometric grid are aligned along lines 
measured 30º, 90º, and 150º from the horizontal axis. This type of grid is used in isometric drawing, which
uses perspective drawing techniques to represent three-dimensional objects.
Polar. Points in the polar grid radiate from the origin, and are aligned by their radial distance from the 
origin and their angular distance from the horizontal axis.        
Tip: Advanced users can set the base angle of the grid to something other than horizontal, using the 
Base setting in the Advanced Grid property sheet.
See Also: Coordinate Systems



Grid Color
Click the buttons in the Color group to choose a new color for the major and minor grid. Click the Major or 
Minor button, then choose a color using the Color Wheel.
See Also: Using the Color Wheel



Grid Style
Choose from the following Grid Style options:
Points. Click this option to display the grid as a matrix of points.
Crosses. Click this option to display the grid as a matrix of crosses. 
Lines. Click this option to display the grid as intersecting lines, similar to graph paper. 



Grid Spacing
The spacing of the grid determines how far apart the grids or lines of the grid are spaced from one 
another. For example, if spacing is set to one foot, points on the grid will be spaced a foot apart. Grid 
spacing is set in either World or Paper units, whichever is currently being used. 
If you have chosen an orthogonal or polar grid in the Grid Type control:
1. Type the amount of horizontal space between each grid point in the X box.
2. Type the amount of vertical space between each grid point in the Y box. 

If you have chosen a polar grid: 
1. Type the angular distance (the distance between the points along a circle around the center of the 

grid) in the Angular box. 
2. Type the radial distance (the distance measured along a line radiating from the center of the grid) in 

the Radial box.

Note: Grid spacing applies to every grid point, regardless of whether it is a minor or major grid point, and 
without regard to the frequency of the grid.



Other Grid Controls
The Grid property sheet also contains these controls: 
Hide grid when finer than... Type a value in this box to control how fine a grid can be drawn on the 
screen. When the grid becomes finer than this value, it will not be drawn. Note that this value applies to 
distances on your computer screen, which are not related to World or Paper units. 
Show grid. Check this box to display the grid. This is the same as choosing View|Grid|Display from the 
menu.



Advanced Grid Property Sheet
The Advanced Grid property sheet is not listed in the menu; you must select it from the Drawing Setup 
dialog. This property sheet gives you precise control of:

Grid frequency, which determines how visible grid lines alternate with invisible grid lines. 
The minor grid, or the finer grid points that appear between points on the major grid.
The grid origin, which lets you control how the grid aligns itself to the coordinate system and to 

drawing objects. 

Subtopics
Grid Frequency
Minor Grid Settings
Grid Origin



Grid Frequency
The Frequency settings lets you alternate visible grid lines with invisible grid lines. For example, if you set 
the frequency 2, then every other grid line will be displayed. If you set frequency to 4, then every fourth 
grid line will be displayed. You will still be able to snap to the invisible grid lines.
Warning: Don’t confuse this with whether the grid itself is visible. If you make the grid invisible using 
View|Grid|Display to deselect grid display, then the whole grid will be invisible. 
If you are customizing an orthogonal or isometric grid: 
1. Type a value in the X box to set the frequency of horizontal grid points. 
2. Type a value in the Y box to set the frequency of vertical grid points. 

If you are customizing a polar grid:
1. Type a value in the Angular box to set the angular frequency of grid points (the frequency of points 

arranged in a circle around the center of the grid). 
2. Type a value in the Radius box to set the radial frequency of grid points (the frequency of points 

arranged along a line radiating from the center of the grid).



Minor Grid Settings
There are two control groups for minor grid settings: Minor Grid X, for setting horizontal minor grid points, 
and Minor Grid Y, for setting vertical minor grid points. You change the settings in these two control 
groups independently, using identical procedures. Each group contains three option buttons: 
None. Select this option to turn the minor grid off. This means that all of the grid points or lines will be 
displayed as major grid points. 
Division. Select this option to turn the minor grid on. You can set the number of divisions between each 
major grid point using the spin button control near the option button. 
Offset. Select this option to create minor grid points at a fixed distance (offset) from each major grid point.
You can use positive or negative numbers.



Grid Origin
The grid origin is located by default at the origin of the absolute or polar coordinate system, which is at 
coordinate (0,0). You can reset the origin point of the grid, causing the grid to be offset from the 
coordinate system locations. You can also change the base angle of the grid, aligning it to an object that 
is not oriented orthogonally in the drawing space (for example, a house that is oriented at an angle in its 
lot). 
To reset the grid origin, type absolute coordinate values into the X and Y text boxes. To change the base 
angle of the grid, enter the angle in the Base text box.
Note: Grid Origin is also accessible from a tool in the Grid toolbar.
Tip: This feature allows you to use a "local" grid. If you are working in an area of your drawing you can 
relocate the grid origin so that it aligns to the set of objects you are working on, rather than to the drawing 
space as a whole.



Units and Scale Property Sheet
Menu: Options|Units and Scale Toolbars: Setup, Standard

The Units and Size property sheet contains options for setting the drawing scale and for controlling the 
display of linear units. 
Tip: TurboCAD’s built-in templates and wizards can help you set up your drawing space when you start a
new drawing. This property sheet is for cases when you want to set up your units and scale manually.

Subtopics
Measuring System
Scale
Units in Work Space
Use Paper Space Coordinates



Measuring System
The Measuring System control group contains two general settings, English and Metric. Choosing either 
of these settings will select different sets of options to choose from in the other controls of this property 
sheet. 



Scale
Scale is the ratio of measurements on the page (Paper units) to measurements in the object being 
modeled (World units). TurboCAD lets you set the drawing scale using one of three standard systems: 
Architectural, Metric, and Absolute. If Metric is selected in the Measuring System group, then Absolute will
be the only choice available. The following table shows some sample drawing scales expressed in each 
of these systems:

System Example 
Architectural 3/16" = 1'-0" 
Engineering 1"= 200' 
Absolute 1:500

Use the Type drop down box to choose a system, then use the Scale box to choose a scale, or type in a 
custom scale.



Units in Work Space
Use the controls in this group to specify a unit of measure for your drawing: 
World Units. Click in this drop-down list to choose a unit of measure. The choices that appear in the list 
will depend on whether English or Metric is selected in the Measuring System group. 
Show All Units. Check this box if you want the World Units drop-down list to display all available units, 
regardless of whether English or Metric is selected in the Measuring System group. 
Format. Click in this box to choose a format for the display of numbers. The choices available in this box 
will be limited to Decimal and Scientific if Metric is chosen in the Measuring System group. The following 
table shows examples of the available number formats:

Format Example 
Decimal  3.25 
Scientific 1E+01 mm 
Fractional 3 3/16 
Architectural (Feet in Fractional) 1'-5 11/16" 
Engineering (Feet in Decimal) 1"= 200'

Precision. Use this spin control to specify the precision of decimal numbers (the number of places to the 
right of the decimal point that TurboCAD displays). You can either click on the arrows or type a number 
directly into the box.



Use Paper Space Coordinates
Check the Use Paper Space Coordinates box if you want the Ruler, Grid, and the coordinate system to be
in Paper, rather than World, units. This is useful if you want to precisely arrange your drawing on a page, 
or if you want to precisely place or scale an element of your drawing, such as text, in Paper space.
Tip: Checking and unchecking this box is exactly the same as clicking the Paper/World button in the 
upper-left corner of the Ruler.



Advanced Units Property Sheet
The Advanced Units property is not listed in the menu, nor is there a toolbar button for it. You must select 
it when the Drawing Setup dialog is active. This property sheet contains controls for setting units in Paper 
space. 
The property sheet contains the following controls: 
Paper Units. Click in this drop-down list and scroll to choose a unit for setting and displaying Paper 
measurements on the Ruler, in the coordinate system, on the grid, and in the Edit Bar. 
Text Units. Click in this drop-down list and scroll to choose a unit for setting and displaying the size of 
text. 
Line Width Units. Click in this drop-down list and scroll to choose a unit for setting and displaying the 
width of lines in the Pen property sheet of the Properties dialog.



Angle Property Sheet
Menu: Options|Angle Toolbars: Setup, Standard

The Angle property sheet gives you precise control over the measurement and display of angles, as well 
as control over the Ortho angle. You can change the system and direction of measurement, the base 
angle, and the precision of measurement. 

Subtopics
Angular System
Direction
Ortho Angle



Angular System
Use the list box to choose a system appropriate to your drawing. You can choose to display angular 
measurements in degrees, degrees minutes and seconds, grads, radians, or the surveyor system. In 
addition, you have the following two options: 
Base Angle. Type a value into this text box to set the position of the base angle. Setting the base angle 
to 90 degrees, for example, would cause TurboCAD to start measuring angles from the top quadrant point
of a circle or arc, rather than from the right quadrant point. 
Precision. Use this control to set the precision of the display of decimal numbers. If you set Precision to 
2, for example, measurements will be displayed to an accuracy of two digits to the right of the decimal 
point.



Direction
Use these option buttons to choose whether to measure angular distances in a clockwise or 
counterclockwise direction.



Ortho Angle
Use these controls to customize the Ortho angle. Ortho constrains the angles of lines during drawing and 
editing operations. 
Base Angle. Type a value into this text box to set the position of the ortho base angle, which is the angle 
from which the ortho angle is measured. Changing this angle can be helpful if you want the ortho angle to 
be measured in relation to an object that is not oriented orthogonally relative to the drawing space. 
Step Angle. The step angle determines the angle to which Ortho constrains lines. If you set the step 
angle to 15, for example, the line will be constrained to angles 15 degrees apart. TurboCAD’s default sets
the step angle to 90 degrees.



Scripts Property Sheet
Menu: Options|Scripts Toolbars: Setup, Standard

The Scripts property sheet associates descriptive names with BASIC script files, and allows users to 
browse descriptions embedded within script files. For specific information about the Enable Basic 
language, or about how to access TurboCAD’s    internal functions, use Help, or use the manual entitled 
"Programming TurboCAD with Enable Basic" shipped in the box with TurboCAD Learning Edition and on 
the CD with TurboCAD Learning Edition. 

Subtopics
Adding a New Script
Deleting a Script
Debugging a Script



Adding a New Script
The Add button lets you associate a descriptive name with a script file and run the script using the 
descriptive name from the Script toolbar or menu. 
1. Type a name for the script in the Name text box. 
2. Click the Add button. TurboCAD will display the standard Open dialog. Use the dialog to choose the 

script’s .BAS file, then click OK to return to the Drawing Setup dialog. 

When you select a script, the name of the script, as well as its file name and path, appear in the scripts 
list box. If descriptive information is available in the script’s file, this information will appear in the 
Description area of the property sheet. Once the script is added to your drawing, it will appear in a 
submenu to the right of the Tools|Run Scripts menu. You can run the script immediately by choosing it 
from the submenu.



Deleting a Script
To delete a script’s descriptive name from the list, select its name in the scripts list box, then click the 
Delete button.
Note: Deleting a script removes the script’s association with the drawing, but leaves the script’s .BAS file 
intact, so you can add it to your drawing or template again at any time.



Debugging a Script
To debug a script, select its name in the scripts list box, then click the Debug button.



Layers Property Sheet
Menu: Options|Layers Toolbars: Setup, Standard

The Layers property sheet allows you to create new layers, set the current drawing layer, set the 
properties of layers, and delete layers. Each layer property you can modify has its own column in the 
property sheet.
Layers are virtual levels in a drawing, analogous to acetate sheets (overlays) in traditional drafting. Layers
give you the advantage of sorting objects in your drawing by the type of object they are modeling, by 
order of creation, or by any principal that suits the way you work. You can then place each category of 
object on a separate layer of the drawing, so that you can work on one layer of objects at a time. 
Use the Layers property sheet to establish new layers for your drawing, and to set their characteristics. 
Use the Layers dialog box in the Properties toolbar to change the active layer as you draw. 
Note: In the previous version of TurboCAD, it was possible to set the active layer in the Layers Property 
Sheet. In this version you do so only from the Properties toolbar.
Layers can be visible or not visible, editable or not editable. If you want to view only a subset of the 
objects in your drawing, set the layers you want to see as visible, and set all other layers to invisible. 
Setting layers to non-editable makes it possible to protect objects on those layers from unintended 
change while someone is working on another layer of the drawing. 
Layers can have their own default color and line styles. If the color and line-style properties of objects on 
a layer are set to By Layer, they will have the color and line style assigned to the layer.
See Also: Format Property Sheet
Note: If you create a group composed of objects on different layers of the drawing, the group will reside 
on the current layer (the layer that is current at the time the group is created). If you subsequently explode
the group, each of the constituent objects will be on its original layer.

Subtopics
Creating a New Layer
Setting the Current Drawing Layer
Setting Layer Properties
Deleting a Layer



Creating a New Layer
To create a new layer, click the New button, then type a name for the layer in the Name text box. If you 
want the layer to be automatically assigned a sequential layer number, Click OK without changing the 
name. The @ symbol represents the sequential layer number that TurboCAD will assign. When you click 
OK, the new layer name will appear in the Layers dialog list box. You may then adjust the various layer 
settings.



Setting the Current Drawing Layer
The current drawing layer is the layer on which any new objects that you create or insert will reside. To set
the current drawing letter, select the name of the layer from the Layers list box in the Properties toolbar. 
(To add the Properties toolbar to the desktop, select View|Toolbars from the menu,    and select Properties
from the list of available toolbars.)



Setting Layer Properties
You can set the properties of a layer using the controls in the Properties area of the Layers dialog. Notice 
that the dialog box scrolls horizontally -- not all the columns of layer properties are visible at one time. 
Visible. The "eyes" icon at the top of the first column represents setting the visibility status of a layer. 
Check this box to make the layer visible and uncheck it to make the layer invisible. The All Visible button, 
below the Layers dialog screen, can set all layers to visible or not visible at one time. 
Read Only. The yellow padlock icon at the top of the second column represents setting the edit status of 
a layer. If the box for a particular layer it is not checked,    you can draw, insert, and edit objects on the 
layer. If the box is checked, then you can only view the layer, but you can not change it.
Note: The Bring to Front and Send to Back commands (on the Format menu) affect the redraw order of 
objects within a single layer, or across layers if the layers have the same order number. An object on a 
layer with a higher order number will always overlap an object at the front of a layer with a lower order 
number.
See Also: Bring to Front, Format Property Sheet, Send to Back
Layer. Use this item to rename existing layers, by clicking on the layer name and typing a new name. 
Click on the OK button directly below the list to accept the change. 
Color. Use this item to select a color for the layer. Black is the default color for new layers. To change the 
color, click on the color bar for the layer you wish to change. Select the new color from the list box that 
appears. If objects on the layer have their pen or brush color property set to By Layer, then the pen or 
brush of the objects will have the color specified here. 
Style. You may need to scroll horizontally to see this item. Use this item to select a line style for the layer. 
Click on the line for the layer you wish to change. Select a new line style from the list box that appears. If 
objects on the layer have their line style property set to By Layer, then the objects will have the line style 
specified here. 
Order. Use this item to assign an order number to the layers. Order numbers determine the order in 
which layers are drawn. Objects drawn on layers with higher order numbers will overlap objects drawn on 
layers with lower order numbers. The order numbers of layers are all set to 0 initially. Layers that have the
same order number are sorted in alphanumeric order. To change the order number for a layer, click on the
number. A set of horizontal scroll arrows will appear. You may type in a number, or use the scroll arrows, 
to set the value. 
After you have made changes to the properties of the selected layer, click the OK button to apply the 
changes.



Deleting a Layer
To delete a layer, you must first clear any objects on the layer. You can select the objects on a layer using 
the Edit|Select By|Layer dialog, then clear the selected objects. Once the layer is cleared of objects, you 
can delete it in the Layers dialog by selecting its name from the list and clicking the Delete button.
See Also: Select by Layer Dialog



Working with Multiple Windows
TurboCAD uses a multiple document interface. This means that the TurboCAD application window can 
contain multiple document windows, each of which contains a TurboCAD drawing. Whenever you open a 
TurboCAD drawing or start a new TurboCAD drawing, the drawing will appear in its own window, within 
the TurboCAD application window. You may also use multiple windows to display varying views of the 
same drawing.
If you are familiar with other Microsoft Windows programs, you already know how to work with windows 
and minimized window icons. For instruction on basic techniques, such as moving, sizing, restoring, 
maximizing, and minimizing document windows, see your Microsoft Windows documentation. 
One big advantage of the multiple document interface is that it allows you to intuitively move and copy 
objects from one drawing to another. 

Subtopics
Moving and Copying Objects between Drawings
Window Menu Commands



Moving and Copying Objects between Drawings
There are two basic methods for copying and moving objects between drawings: copy and paste (or cut 
and paste), and OLE drag and drop.
Note: In describing how to use these techniques, we’ll refer to the drawing from which you’ll be copying 
or moving objects as the source document; we’ll refer to the drawing into which you’ll be moving or 
copying the objects as the target document.
Tip: Before dragging and dropping objects, it’s a good idea to choose the Tile command from the Window
menu. This will arrange the windows on the screen so that they are completely visible, without overlap.

Subtopics
Copying/Cutting and Pasting Objects between Drawings
Drag and Drop
Using Multiple Windows With One Drawing



Copying/Cutting and Pasting Objects between Drawings
You can use the Windows clipboard to transfer objects between drawings, regardless of whether both of 
the drawings are open at the same time. Cut and paste allows you to remove an object from the source 
document at the same time that you paste the object into the target document.
1. Select the object or objects in the source document that you want to copy. You can use any of the 

select tools (available from the Select toolbar), or any of the Select commands from the Edit menu.
2. Choose Edit|Copy (<Ctrl>+<C>), or Edit|Cut (<Ctrl>+<X>) from the menu. This places a copy of the 

objects on the Windows clipboard. (Edit|Cut will also remove the selected objects from the source 
document.)

3. Activate the target document by clicking in its window (or on its title bar), or by choosing it from the 
Window menu.

4. Choose Edit|Paste from the menu, or press <Ctrl>+<V>. The object will be pasted from the Windows 
clipboard into the target document.

The objects that you pasted from the clipboard will appear at the center of the target document window.



Drag and Drop
OLE drag and drop provides a simple and intuitive way to copy objects between drawings. You can drag 
objects from one drawing window into another, and you can drag objects stored in block and symbol 
libraries from their library palette into another drawing.

Subtopics
Dragging and Dropping between Drawings
Dragging and Dropping Blocks Between Drawings



Dragging and Dropping between Drawings
To drag a drawing object from one drawing into another:
1. Select the object or objects that you want to drag into another drawing.
2. Place the cursor over the reference point of the selection. This is a movable handle located by default

at the center of the selection. You will know that the cursor is in the right place when it turns into a 
four-directional pointer.

3. Press and hold down the mouse button while dragging the selected objects into the window of the 
target document. An outline of the selection will follow the mouse cursor as you drag.

4. Release the mouse button to drop the selected objects. A copy of the selected objects will appear at 
the point where you released the mouse button.

Warning: If you drag an object by any point other than the reference point, you will only be able to drag 
the object within the window of the source document. Make sure that the mouse cursor is placed over the 
reference point of the selection before attempting to drag the selection into another window.



Dragging and Dropping Blocks Between Drawings
You can also drag and drop blocks from a drawing’s libraries into another document. Moving a block to 
another drawing accomplishes two things: It inserts the block into the target drawing, and it places the 
block into the corresponding library of the target document.
1. Open the block palette using View|Block.
2. Place the mouse cursor over the block in the palette that you want to copy, then hold down the mouse

button while you drag the block into the target document window.
3. Release the mouse button. The block will appear in the target document at the place where you 

released the mouse button. The block will also appear in the target document’s block palette.

Note: After you have moved the object, the target document becomes the active window. Notice that the 
block palette will change, displaying the contents of the target document’s block library.
Tip: You can use this same drag-and-drop technique to place symbols, blocks or drawing elements in 
other Windows applications, such as Microsoft Word.



Using Multiple Windows With One Drawing
When working on a large and complicated drawing, it is often useful to have simultaneous close-up views 
of more than one part of the drawing. In TurboCAD Learning Edition, not only can you have multiple 
windows open on the same drawing, you can also start any drawing or editing command in one window 
and finish in another. For example, you may need to draw a line connecting two widely separated objects.
Open a second window on the drawing using Windows|New Window. Then tile the windows (Windows|
Tile). Adjust the zoom value in each window to get a close-up of each item. Then start the line in the first 
window, and finish it by clicking at the correct location in the second window. 
Note: When you use multiple windows with one drawing, you are still creating one drawing, not multiple 
copies. 



Window Menu Commands
The following table summarizes the commands accessible from the Window menu:

Command Function

New Window Opens a new window on the existing drawing.
Tile Arrange windows so that they are equal-size, side-by-side, 

with no overlap.
Cascade Arrange windows so that they overlap with title bars visible.
Arrange Icons Line up minimized windows along the bottom. 
Close All Close all open windows.
Changing the 
Active Window

Lower part of menu lists open drawings; choosing a drawing 
makes it the active window.

New Window
Menu: Window|New Window Toolbar: Standard, Window

Use the New Window command to open a new window on the currently active drawing. If the current 
window is maximized when you use New Window, the new view will also be maximized. If you tile the new
window, you will be able to set two different zoom views of the same drawing, and draw from one window 
to another. 



Tile
Menu: Window|Tile Toolbar: Standard, Window

Use the Tile command to arrange all the open drawing windows into a mosaic. The windows are resized 
so they all are the same size and fit entirely within the application window.
Tip: This is a convenient arrangement when you want to compare the contents of two documents or drag 
and drop objects between documents.
Tip: You may want to turn off rulers and scroll bars (in the View menu) to gain more screen space while 
working with multiple windows.



Cascade
Menu: Window|Cascade Toolbar: Standard, Window

Use the Cascade command to resize and arrange all the drawing windows so they overlap with their title 
bars showing. Because you can see a portion of each window, you can easily activate any window by 
clicking it. Only the topmost window is completely visible.



Arrange Icons
Menu: Window|Arrange Icons

When you minimize a drawing window, Windows shrinks it to an icon. Use Arrange Icons to line up these 
minimized windows along the bottom of the application window.



Close All
Menu: Window|Close All Toolbar: Standard, Window

Use Close All to close every open drawing window.
Note: TurboCAD will warn you if an open drawing has unsaved changes. Click the Yes button in the 
warning dialog to save the changes; click the No button to discard the changes. Click Cancel to return to 
TurboCAD without closing the drawing windows.



Changing the Active Window
TurboCAD lists all of the open drawings in the lower half of the Windows menu. The currently active 
drawing will have a check mark. When you choose a drawing from the menu, TurboCAD makes it the 
active window. This is the same as clicking in a window, or clicking a window’s title bar.
Tip: You may prefer to click the title bar if you are in the middle of a drawing or editing command, so you 
do not interrupt the command while changing windows.



Tips of the Day
TurboCAD´s Tips of the Day are a collection of advice, techniques, and tricks that could make your work 
with TurboCAD easier, point out features that are not so obvious, or show you how to do things that you 
perhaps didn´t know you could do. Some of the tips are directed toward novice users, and others are 
directed to more experienced users.
The first time you start TurboCAD, you will see a Tip of the Day. You can stop the tips from appearing at 
startup by clearing the Show Tips at Startup check box. If you subsequently want to turn the tips back on, 
choose Tip of the Day from the Help menu and click the Show Tips at Startup check box.






